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1

Welcome
Congratulations on the purchase of your Palm® Treo™ 700wx smartphone.

Benefits

• Make and receive phone calls

• Manage your contacts, calendar, 
and task list

• Receive and send corporate and 
personal email messages

• Browse the web

• Use a Bluetooth® headset 
(sold separately) for hands-free 
operation
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Your new Palm® Treo™ 
700wx smartphone

In one compact and indispensable device, 
you now have all of the following:

• An advanced wireless smartphone

• A Windows Mobile® organizer with 
portable expansion capability 
(MultiMediaCard/SD/SDIO expansion 
cards)

• High-speed data with NationalAccess 
(1xRTT) and BroadbandAccess (EVDO) 
support

• A 1.3 megapixel digital camera

• Mobile email

• Text and multimedia messaging

• Windows Media® Player Mobile

• Microsoft® Office Mobile suite

This guide helps you quickly set up and 
learn to use your smartphone.

NOTE Phone and text messaging services 
require a service contract with Verizon 
Wireless. Web, email, and messaging 
services require a service contract and 
high-speed data service from Verizon 
Wireless. Data speeds vary based on 
network availability.

What’s in the box?

All of the following items should be in the 
smartphone box:

Hardware

• Treo 700wx smartphone

• Rechargeable battery

• AC charger

• USB sync cable

• Stereo headset

• Screen protector

TIP LOOK HERE: Don’t miss the helpful tips 
and cross-references given in these boxes.

TIP Visit palm.com to purchase a replacement 
screen protector if the original one becomes 
scratched or worn.

http://palm.com
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Documentation and software

• Read This First setup poster

• Quick Reference (The original guide that 
came with your smartphone. A new 
Quick Reference, which reflects the 
changes provided when you upgraded 
your smartphone to Windows Mobile 6 
Professional, is available for download 
from palm.com/verizon700wxupdate.)

• Windows Mobile Getting Started CD, 
which includes the following:

• Link to Microsoft Office Outlook® 
software download

• Desktop synchronization software 
(ActiveSync® desktop software for 
Windows XP, Windows Mobile Device 
Center for Windows Vista)

NOTE When you upgrade your 
smartphone to Windows Mobile 6 
Professional, you need version 4.5 of 
ActiveSync desktop software for a 
Windows XP computer. This version is not 
included on the Windows Mobile Getting 
Started CD. Instead, go to 
palm.com/us/support/treo/treo700wxverizon/ 
and follow the link to install ActiveSync 4.5.

• Windows Media® Player 10

• Additional software for your 
smartphone

• User Guide (The original guide that 
came with your smartphone. The 
User Guide you are reading has been 
updated to reflect the changes 
provided when you upgraded your 
smartphone to Windows Mobile 6 
Professional.) 

• Palm warranty

• End User License Agreement

NOTE To install Windows Media Player 
and other software from the Getting 
Started CD, insert the CD into your 
computer’s CD drive, select Add new 

programs to my desktop PC, and follow 
the onscreen prompts.

http://www.palm.com/verizon700wxupdate
http://palm.com/us/support/treo/treo700wxverizon/
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What do I need to 
get started?

As you work through the instructions in this 
guide, you need all the items that came in 
the smartphone box (see What’s in the 
box?), as well as the following:

• An activated wireless account from 
Verizon Wireless; if you want to use 
email, web browsing, or multimedia 
messaging, your account must also 
include a data service plan

• A location with wireless coverage for 
your smartphone

• An electrical outlet for recharging the 
smartphone battery

• A computer on which you can install 
desktop synchronization software and 
synchronize your smartphone

For more information about 
synchronization, see Synchronizing 
information.

Where can I learn 
more?

For a quick introduction

Quick Tour: The Quick Tour introduces you 
to many of your Palm® Treo™ 700wx 
smartphone’s features. It is already 
installed on your smartphone, and you 
can open it anytime. Press Start , select 
Programs, and then select 
Quick Tour .

While using your smartphone

On-device Help: Your smartphone 
includes on-device help that is specially 
formatted for your smartphone screen. To 
view the on-device help, press Start  
and select Help.

Online support from Palm: For up-to-date 
downloads, troubleshooting, and support 
information, go to 
palm.com/us/support/treo/treo700wxverizon/.

http://palm.com/us/support/treo/treo700wxverizon/
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If you need more information

Books: Many books on Windows Mobile® 
devices are available in local or online book 
retailers (look in the computers section).

Verizon Wireless customer service: For 
questions about your mobile account or 
network features, contact Verizon Wireless 
customer service or visit 
verizonwireless.com for the latest 
information and help.

http://verizonwireless.com
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Setting up
You’re about to discover the many ways your Palm® Treo™ 
700wx smartphone can help you better manage your life and 
have fun too.

As you become more familiar with your smartphone, you can 
personalize the settings and add applications to make it 
uniquely yours. But first, follow these few easy steps to set up 
your smartphone and get it running.

Benefits

• Know where your smartphone 
controls are located

• Start using your smartphone right 
away

Benefits

• Know where your smartphone 
controls are located

• Start using your smartphone right 
away
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Palm Treo 700wx smartphone overview

Front view

Multi-connector

Microphone

Headset jack
Start 

Phone/Send 

Side button

Left softkey

Option

Volume button

Indicator light (phone 
and charge indicator)

5-way navigator and 
Center button

Earpiece

Power/End

OK

Right softkey

TIP Be careful not to scratch or crush your 
smartphone screen. Do not store it in a place 
where other items might damage it. For a 
variety of useful accessories, including 
carrying cases that protect the screen, visit 
palm.com/mytreo700wxVerizon.

DID YOU KNOW? By default, pressing and 
holding the Side button opens the Windows 
Media® Player Mobile application (see 
Windows Media Player Mobile). You can 
change the function of the Side button (see 
Reassigning buttons).

http://www.palm.com/mytreo700wxVerizon
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Back view

IMPORTANT The smartphone speaker 
includes a large magnet, so be sure not to 
store your smartphone near credit cards or 
other items that could be demagnetized.

Camera lens
Battery door 
release

Speaker

Self-portrait mirror
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Top view

Stylus

Ringer switch

Antenna

Infrared 
(IR) port

Expansion card slot

Sound On

Sound Off

DID YOU KNOW? The Ringer switch silences all 
sounds, including music, at once; you don’t 
need to hunt for “off” or “mute” settings in 
individual applications.
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Installing the battery

1 Press and hold the battery door 

release, while you slide the battery 

door off your smartphone.

2 Align the battery contacts with the 
smartphone contacts inside the battery 
compartment.

3 Insert the battery into the 
compartment at a 45-degree angle, and 
then press it into place.

4 Slide the battery door back onto the 
smartphone until it clicks into place. 

5 Your smartphone screen turns on. Wait 
a moment for the progress bar to fill and 
the Windows Mobile® screen to appear.

6 Follow the onscreen instructions to 
finish the installation.

TIP If you ever need to remove the battery, it is 
easier to do so if you first remove the stylus.

Battery door 
release

TIP If your smartphone does not turn on after 
you insert the battery, charge the battery (see 
Charging the battery). If the smartphone still 
doesn’t start, perform a soft reset (see 
Performing a soft reset).

TIP You can buy an extra battery as a spare for 
long plane trips or periods of heavy data use. 
Be sure to use batteries from Palm only. For 
more information on battery usage, see CTIA 
Battery Handling Guidelines.

Battery 
contacts
Smartphone 
contacts
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Charging the battery

Before using your smartphone, you need to 
charge the battery. For tips on maximizing 
the life of your smartphone battery, see 
Maximizing battery life.

IMPORTANT Charge the battery for 
3.5 hours, or until the indicator light is solid 
green.

1 Plug the AC charger into a wall outlet. If 
necessary, connect an adapter.

2 With the arrow on the connector facing 
up (toward your smartphone screen), 
connect the AC charger cable to the 
bottom of your smartphone.

3 Check the indicator light to confirm that 
your smartphone is being charged.

• Solid red indicates that your 
smartphone is charging.

• Solid green indicates that your 
smartphone is fully charged.

When your smartphone is on (see Turning 
your smartphone on/off), the onscreen 
battery icon displays the charging status:

Indicator light

TIP If the indicator light does not turn on when 
you connect your smartphone to the AC 
charger, double-check the cable connection 
and the electrical outlet to which it is 
connected.

DID YOU KNOW? If the battery is low, the 
indicator light flashes red.

A solid lightning bolt indicates that 
the battery is connected to a wall 
outlet and is being charged.

A shaded lightning bolt indicates 
that the battery is connected to a 
wall outlet and is fully charged.
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Maximizing battery life

Battery life depends on how you use your 
smartphone. You can maximize battery life 
by following some easy guidelines:

• Charge your smartphone whenever 
you’re at your desk, or charge 
it overnight each day. The battery in your 
smartphone has a much longer useful 
life if you charge it frequently instead of 
waiting until it’s fully drained.

• If you spend a lot of time using the 
camera, games, media players 
(including listening to music with 
wireless headphones using the built-in 
Bluetooth® wireless technology), or 
other applications, keep an eye on the 
battery icon and charge when 
necessary.

• Wireless features (phone, email, 
messaging, and web) generally 
consume more power than the 
organizer features. If you don’t plan to 
use the wireless features on your 

A partial battery without a lightning 
bolt indicates that the battery is not 
connected to a wall outlet and that 
it has some power.

An exclamation point (!) indicates 
that the battery needs to be 
charged immediately.

DID YOU KNOW? Tapping the battery icon opens 
a window showing a percentage level of 
charge left in the battery.

DID YOU KNOW? If your battery ever becomes 
fully drained, your info remains safely stored 
on your smartphone. Recharge the battery to 
access your info.

Battery 
icon

DID YOU KNOW? You can also charge your 
smartphone from your computer by 
connecting them with the sync cable.
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smartphone for a while, turn off your 
wireless services (see Turning wireless 
services on/off). You can forward calls 
to a different number or let all calls be 
picked up by voicemail (see Forwarding 
calls). To see if your wireless services 
are on, tap the phone-off  icon and 
select Wireless Manager.

• If you are synchronizing email and other 
information directly with your corporate 
Exchange server using Microsoft 
Exchange ActiveSync®, set the 
synchronization interval to a maximum 
of every 15 minutes during peak times 
and every hour (or turned off 
completely) during non-peak times (see 
Setting the synchronization schedule).

• Turn off the Bluetooth feature when you 
do not need to make a Bluetooth 
connection (see Entering basic 
Bluetooth settings).

• Turn the voice command feature off 
(see Setting up voice commands).

• As with any mobile phone, if you are in 
an area with no wireless coverage, your 
smartphone searches for a signal, which 
consumes power. If you cannot move to 
an area of better coverage, temporarily 
turn off your phone (see Turning your 
phone off).

• Turn down the screen brightness (see 
Adjusting the brightness).

• Set your screen to turn off automatically 
after a shorter period of inactivity (see 
Optimizing power settings). 

• Turn off the option to receive beamed 
information (see Beaming an entry or 
file).

• Keep your battery away from direct 
sunlight and other sources of heat. 
Temperatures over 120 degrees 
Fahrenheit (50 degrees Celsius) can 
permanently reduce the capacity and 
life span of any lithium-ion battery.

DID YOU KNOW? You can also see if your 
wireless services are on by pressing Menu 
(right softkey) and selecting Wireless 

Manager.
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Making your first call

1 Press Phone/Send  to display your 
Today screen.

2 If prompted, press Center  on the 
5-way navigator  to turn off 
Keyguard (see Locking your keyboard 
(Keyguard) for more info).

3 If you have not activated your phone, 
follow these steps to do so:

• Use the keyboard to enter *228 
(these numbers appear on the ZRRC 
letter keys).

• Press Phone/Send  to dial.

• Follow the voice prompts to activate 
your phone. A service provisioning 
message appears.

• Wait a few minutes until you see the 
Programming Successful! message, 
and then press Dismiss  
(left softkey).

4 Use the keyboard to enter the number 
you want to call.

5 Press Phone/Send  to dial.

TIP The Dial Lookup list might appear while 
you are dialing a number. Continue entering 
numbers to make the call. For more info on 
the Dial Lookup list, see Dialing by contact 
name. 
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6 When your call is complete, press 
Power/End  to end the call.

Adjusting call volume

While a call is in progress, press the 
Volume button on the side of your 
smartphone to adjust the call volume.

What’s my number?

1 Make sure your phone is on (see 
Turning your phone on).

2 If you do not see your Today screen, 
press Phone/Send .

3 Press Menu  (right softkey).

4 Select Preferences > Phone Settings.

5 On the Phone tab, look for your phone 
number below the title bar.

6 Press OK .Volume 
button

TIP If your phone number doesn’t appear on 
the Phone Settings screen, press OK, and 
then press and hold Power/End to turn your 
phone off. Press and hold Power/End again to 
turn your phone back on. Repeat steps 1–6. If 
your phone number still doesn’t appear, your 
phone has not been activated. Turn your 
phone off, wait a few hours, and then turn on 
your phone and repeat these steps. If your 
phone number still does not appear, contact 
Verizon Wireless for assistance.

Look here for your 
phone number
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Setting up 
synchronization

Once you’ve finished setting up your 
smartphone, we recommend that you set 
up a synchronization method to get the 
most out of your smartphone. When you 
synchronize your smartphone, information 
that has been entered or updated in one 
place—your smartphone, your computer, 
or your corporate server—is automatically 
updated in the other (see Synchronizing 
information).
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Moving around on your 
smartphone
Have you ever been to a new city and felt a bit lost until you 
figured out the streets? Learning to move around on your 
Palm® Treo™ 700wx smartphone is similar. Most applications 
that work on your smartphone use the same set of controls. So 
once you learn how to use these controls, you’ll be traveling all 
over town and you won’t even need a map.

Benefits

• Quickly move around and 
complete tasks in applications 
using one thumb on the 5-way 
navigator

• Access extra features with menus

• Find and open applications quickly
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Navigating around 
the screen

To move around the smartphone screen, 
you can use the 5-way navigator or you can 
tap items on the screen with the stylus. As 
you become familiar with your 
smartphone, you’ll find your own favorite 
way to scroll, highlight, and select items.

The 5-way  includes the Right , 
Left , Up , Down  and Center  
buttons.

TIP Some third-party applications may not 
work with the 5-way navigator, and you must 
use the stylus instead.

DID YOU KNOW? Custom navigation features 
are available when you browse the web using 
Internet Explorer (see Viewing a web page).

TIP The arrow icons that indicate directions on 
the 5-way are different from the onscreen 
scroll arrows and the arrows that indicate that 
a list is available (see Selecting options in a 
list). 

Center 
Up 

Right 

Down 

Left 
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Scrolling through screens

As on a computer, on your smartphone you 
scroll to move from field to field or page to 
page, or in some cases to highlight an item 
or option in a list. There are several 
methods of scrolling:

• On the 5-way , press Right , 
Left , Up , or Down  to move to 
the next field, button, or action in that 
direction.

• Press and hold Option  while 
pressing Up  or Down  to scroll 
one screen at a time. These keys work 
just like the Page Up and Page Down 
keys on your computer keyboard.

• Press and hold Option  while 
pressing Left  or Right  to jump to 
the top or bottom of the current 
document or entry.

• When viewing a screen with tabs, such 
as when adding a contact, press 
Down  to scroll to the tabs, and then 
press Left  or Right  to move 
between tabs.

• When inside a text field, press Right  
or Left  to move to the next character, 
and press Up  or Down  to move 
between lines.

• When inside a list, press and hold 
Up  or Down  to scroll rapidly 
through the list.

TIP Can’t find the Option key? See Using the 
keyboard.

TIP When you are using applications such as 
Messaging, Internet Explorer Mobile, and 
Word Mobile, press and hold Option while 
pressing Left or Right on the 5-way to 
automatically go to the top and bottom of a 
screen.
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• Tap an onscreen scroll arrow.

• Tap and drag the slider of an onscreen 
scroll bar.

Closing screens

To close the current screen and return to 
the previous screen, do either of the 
following:

• Press OK .

• Use the stylus to tap  or  in the 
upper-right corner of the screen.

Highlighting and selecting items

On most screens, one item—a button, a 
list entry, or a check box—is highlighted by 
default. The highlight identifies which item 
is affected by your next action. Use the 
5-way to move the highlight from one item 
to another before opening or selecting it.

The highlight can take one of two forms, 
depending on what is highlighted:

Border: This rectangular border highlights 
items such as an onscreen button (for 
example, OK, Dismiss, or Hide), a check 
box, an option, or a web link.

TIP These buttons are not accessible using the 
5-way.

Scroll arrows

Scroll arrows

Scroll bar
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Reverse type (light text on a dark 

background): This highlights items such as 
a phone number, an email address, text, or 
an item in a list.

After highlighting an item with the 5-way, 
you can select (activate) it by pressing 
Center  or by tapping the item with the 
stylus.

Highlighting text

You can use the stylus to highlight text on 
the screen. Tap and drag the stylus across 
the text you want to highlight. To highlight 
a word, double-tap it. To highlight a 
paragraph, triple-tap it.

Using the softkeys

Because the left and right softkeys give you 
quick access to tasks that you can do on 
the current screen, the softkey items vary 
from application to application and from 
screen to screen. Look on the screen 
directly above the softkey to see the action 
that it takes in the current context. In some 
contexts, these keys may do nothing at all. 
In most cases the right softkey  
opens the menu, and the left 
softkey  activates a specific 
command, such as New or Edit. 
Remember that softkey functions vary 
from screen to screen, so be sure to check 
the onscreen label before pressing the 
softkeys.

TIP The best way to learn to use the 5-way is 
to experiment. Press the 5-way buttons, and 
as you do, follow the movement of the border 
around the screen. The behavior of the 5-way 
varies slightly in each application.

TIP When text is highlighted, you can press 
Backspace to delete the highlighted text.
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Selecting menu items

In many applications, a menu provides 
access to additional features. The menu is 
hidden until you press Menu  (right 
softkey). To get the most out of your 
smartphone, it’s a good idea to familiarize 
yourself with the additional features 
available through the menu in various 
applications.

1 Press Menu  (right softkey) to 
display an application’s menu.

2 Press Up  or Down  to highlight a 
menu item.

Left softkey Right softkey

Left softkey 
activates this 
command

Right softkey 
activates this 
command
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3 If an arrow appears to the right of a 
menu item, press Center  or 
Right  to display additional options for 
that item, and then press Up  or 
Down  to highlight a menu item. To 
return to the main menu without 
making a selection, press Left .

4 Press Center  to select the menu 
item, or press Left  or Menu  
(right softkey) to close the menu and 
cancel your selection.

Selecting options in a shortcut menu

Most applications also provide access to 
context-sensitive shortcut menus—similar 
to the right-click menus on a computer. The 
shortcut menu options vary based on the 
highlighted selection.

1 Highlight the item whose shortcut 
menu you want to see.

2 Press and hold Center  to open the 
shortcut menu.

3 Press Up  or Down  to highlight a 
menu item.

4 Press Center  to select the menu 
item, or press Left  to cancel your 
selection.

DID YOU KNOW? You can select most menu 
items by pressing a key on the keyboard. To 
quickly access a menu item, press Menu 
(right softkey) followed by the underlined letter 
in the menu item’s name. 

TIP You can also tap and hold the stylus on an 
item to open the shortcut menu.
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Selecting options in a list

Lists let you select from a range of options. 
You can identify whether a list is available 
when you select the field. If a rectangle 
appears around the field along with a 
downward-pointing arrow, a list is available. 
Lists are different from the menus 
described earlier in this section.
 

 

To select from a list, do any of the 
following:

• Use the 5-way  to highlight the field, 
and then press Center  to display 
the items in the list. Press Up  or 
Down  to highlight the item you want, 
and then press Center  to make 
your selection.

• Use your stylus to tap the arrow, and 
then tap the item in the list.

• To exit the list and cancel your selection, 
press Left .

TIP When selecting fields you might not see 
the downward-pointing arrow until you press 
Center on the 5-way. 

DID YOU KNOW? In fields where you see a 
downward-pointing arrow but no rectangle, 
you must tap the arrow with the stylus to 
display the list. 
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Using the keyboard

Understanding the keyboard backlight

Your smartphone includes a keyboard 
backlight for low light conditions. The 
keyboard backlight turns on automatically 
when you turn on the screen. The backlight 
turns off automatically when the screen 
turns off or when you are on a call or 
playing music in the background for longer 
than the time specified in Backlight 
Settings. You can set different time 
intervals depending on whether the 

Left
softkey

Right
softkey

Phone/Send
Start

Power/End
OK

Backspace

Option

Shift

Space

Return

Shift

Alt

TIP When using the keyboard to type a 
message or a note, most people find it easiest 
to hold the smartphone with two hands and to 
use the tips of both thumbs to press the keys.

DID YOU KNOW? You can also use the onscreen 
keyboard to enter letters, numbers, and other 
characters in applications that support this 
feature. Tap the keyboard icon in the center at 
the bottom of any screen where it appears. 
After opening the keyboard, you can set 
various input options by tapping the arrow to 
the right of the keyboard icon.
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smartphone is operating on battery power 
or is connected to an external power 
source. The backlight also turns off when 
an application’s power-saving features turn 
it off.

Entering lowercase and uppercase letters

By default, the first letter of each sentence 
or field is capitalized and the remaining text 
you enter is lowercase. To enter other 
uppercase letters, do one of the following: 

• Press Shift (  or ), and then enter 
a letter. This symbol  appears at the 
bottom of the screen. You don’t need to 
press and hold Shift while entering a 
letter.

• Press Shift (  or ) twice to turn on 
Caps Lock, and then enter a series of 
letters. When Caps Lock is on, this 
symbol appears at the bottom of the 
screen: . To turn off Caps Lock, press 
Shift (  or ) again.

Entering numbers, punctuation, and 

symbols 

Numbers, punctuation, and symbols 
appear above the letters on the keys. To 
enter these characters, do one of the 
following: 

• Press Option  and then press the 
key of the desired character. This 
symbol  appears at the bottom of the 
screen. You don’t need to hold Option 
while pressing the key.

• Press Option  twice to turn on 
Option Lock, and then press the 
desired keys to enter a series of 
characters. When Option Lock is on, 
this symbol appears at the bottom of 
the screen: . To turn off Option Lock, 
press Option  again.

TIP You can change the backlight shut-off 
interval. Press Start and select Settings. 
Select the System tab, and then select 
Backlight. Set the time interval on the Battery 
Power tab and on the External Power tab.

TIP You can turn off the first-letter 
capitalization setting (see Setting input 
options).
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Entering passwords

You can’t see your password as you enter 
it, so be careful. Be sure Caps Lock and 
Option Lock are not on unless you need 
them. For information on how to enter 
characters, see Entering lowercase and 
uppercase letters and Entering numbers, 
punctuation, and symbols.

Entering other symbols and accented 

characters

You can enter symbols and accented 
characters that don’t appear on the keys by 
using the alternate characters list.

1 Press Alt  to display the alternate 
character list.

2 Narrow the list by pressing the key that 
corresponds to the character you want. 
See the following table for a list of 
corresponding characters.

3 Press Up  or Down  to highlight the 
desired character.

4 Press Center  to insert the 
character.

TIP The alternate characters are grouped 
according to their similarity to the 
corresponding key. For example, the alternate 
characters available for the e key are é, è, ë, 
and ê. If you press the wrong key, press 
Backspace to return to the full list of alternate 
characters. You can then press another key.

TIP Some symbols, such as an underscore, do 
not correspond to a letter key. To enter these 
symbols, press Alt by itself, and then select 
the symbol from the list.
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Symbols and accented characters 

Press Alt 
 and 

press… 

to select… Press Alt 
 and 

press… 

to select… Press Alt 
 and 

press… 

to select…

a á à ä â ã å æ n ñ x or X x ¤

A Á À Ä Â Ã Å Æ N Ñ y  ý ÿ 

b or B ß o ó ò ö ô œ õ Y  Ý Ÿ

c ç ¢ © O Ó Ò Ö Ô Œ Õ 0 °

C Ç ¢ © p or P ¶ 1 1 ¼ ½

e é è ë ê r or R ® 2 2

E É È Ë Ê s ß š 3 3 ¾

f or F ƒ S ß Š ! ¡

i í ì ï î t or T ™ $   £ ¥ ¢

I Í Ì Ï Î u ú ù ü û Option + 
K (;)

: :-) :-( ;-)

l or L £ U Ú Ù Ü Û Option + 
N (?)

¿

Press Alt  by itself to select these characters:

: _ • % = ÷ ^  £ ¥ ¢ $ [ ] { } < > « » © ® ° ~ \ Ø µ |



M O V I N G  A R O U N D  O N  Y O U R  S M A R T P H O N E

O P E N I N G  A N D  C L O S I N G  A P P L I C A T I O N S38

3
C

H
A

P
T

E
R

Opening and closing 
applications

Opening applications

You can access all the applications on your 
smartphone through the Start menu.

1 Press Start  to open the Start menu.

2 Use the 5-way  to highlight the 
application you want to use. To view 
additional applications, select 
Programs.

3 Press Center  to open the 
highlighted application.

4 (Optional) Press OK  to return to 
Programs and open another application. 

The current application continues to run 
in the background.

Closing applications

You don’t need to exit one application 
before you open another—you can have 
several applications open at once. In most 
cases, applications close automatically 
when available memory is low, but you can 
also close applications manually.

NOTE If you press OK  to leave an 
application, the current application 
continues running in the background. To 
conserve battery power and free up 
memory, you can manually close an 
application.

TIP With the Start menu open, press the letter 
underlined in the application’s name to open 
the app. For example, press H to open Help. 
Or, select the shortcut icons at the top of the 
Start menu to open recently used 
applications.

DID YOU KNOW? Another way to open apps is 
to press and hold Option and then press 
Phone/Send, Start, or OK. You can change 
which app a button combination opens (see 
Reassigning buttons).
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1 Press and hold OK  to open Memory 
Settings.

2 On the Running Programs tab, do one 
of the following:

• Select the application you want to 
close, and then select Stop to close 
it.

• Select Stop All to close all your open 
applications.

Using your Today 
screen

From your Today screen, you can quickly 
look up a contact, make a call, review your 
latest calendar appointments, see the 
number of unread email messages, and 
even search the web.

To access your Today screen, press 
Phone/Send .

TIP You can also open Memory Settings from 
the Start menu. Press Start, select Settings, 
select the System tab, and then Memory.

TIP If you press Phone/Send while a number 
is highlighted, your smartphone dials the 
number. If a number is highlighted, deselect 
the number, or use the Start menu to access 
the Today screen.
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Title bar and status info: See What are all 
those icons? to learn about the icons that 
appear in this area.

Dial Lookup field: Type the number you 
want to call and press Center  to dial, 
or begin typing a name to look up the 
associated number in Contacts. See 
Dialing by contact name for more info.

Web search field: Enter a web address or 
a keyword, and press Center  or 
Return  to view a list of search results 
based on the address or word (data 
services connection required).

Speed-dial entries: Select a speed-dial 
button—either a picture or text—to call the 
number assigned to it. See Defining 
speed-dial buttons to create your own.

Title bar and
status info

Dial Lookup field

Speed-dial
entries

Scroll down to view 
Web search field

TIP You can select a picture for your Today 
screen background and customize which 
items appear in the Today screen. See Today 
screen settings for details.
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Your phone
The phone, along with the Today screen, is your home base for 
making and receiving calls.

You can creatively manage multiple calls; for example, you can 
swap between calls, send text messages to ignored calls, and 
create conference calls.

And you can do more than manage your phone calls. You can 
send text messages, open applications, go to your favorite web 
pages, see your upcoming appointments, and even find out 
how many unread email messages you have.

Benefits

• Stay in touch—you choose how

• Work in other applications when 
on an active call

• Create speed-dial buttons with 
pictures of your friends
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Turning your 
smartphone on/off

The term smartphone refers to the device 
and its physical aspects. The term phone 
refers to the wireless feature of your 
smartphone that enables you to connect to 
the Verizon Wireless network so that you 
can make and receive calls and send and 
receive data.

The phone and the screen of your Palm® 
Treo™ 700wx smartphone can be turned off 
and on separately. This means you can 
wake up the screen to use just the 
organizer features—Contacts, Calendar, 
Tasks, and so on—of your device without 
turning on the phone. Also, when the 
screen is turned off, the phone can be on 
and ready for you to receive phone calls or 
messages.

Turning your phone on

Press and hold Power/End .

When your smartphone locates a signal, 
Verizon Wireless appears in the upper-left 

of the screen and the signal-strength  
icon appears at the top of the screen.

Turning your phone off

Press and hold Power/End .

When your phone is off, the phone-off  
icon appears at the top of the screen and 
Phone Off appears in the upper-left of the 
screen. Your phone is not connected to any 
mobile network. However, you can still use 
Microsoft Office apps and Contacts, 
Calendar, and the other organizer features 
of your smartphone.

DID YOU KNOW? When you turn on your phone 
and connect to a mobile network, you can 
make and receive phone calls and use the 
other wireless services supported by the 
network. When you are inside a coverage 
area, the indicator light flashes green and the 
signal-strength icon bars show the strength of 
the signal. If you’re outside a coverage area, 
the light flashes amber and no bars appear.

DID YOU KNOW? You turn your phone on and off 
using Wireless Manager. Tap the 
signal-strength icon and select Wireless 

Manager. Select Phone.
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Waking up the screen and turning it off

Wake up the screen and leave the phone 
turned off when you want to use only the 
Microsoft Office apps or Contacts, 
Calendar, and the other organizer features 
of your smartphone—for example, when 
you’re on a plane and want to look at your 
calendar. You can also turn off the screen 
without turning off the wireless features on 
your smartphone. 

Press Power/End  turn your screen on 
or off.

Making calls from the 
Today screen

Your smartphone offers several ways to 
make phone calls from the Today screen.

Dialing from the Today screen

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Using the numbered keys on the 
keyboard, enter a phone number in the 
Dial Lookup field.

TIP Your screen turns off automatically after a 
set period of inactivity. You can set how long 
the screen stays on. Press Start, select 
Settings, select the System tab, and then 
select Power. Select the Advanced tab. 
Adjust the number of minutes the phone 
stays on when idle using the On battery 

power setting.
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3 Press Phone/Send  to dial.

NOTE You do not need to press Option to 
access the numbers on the keyboard. 
However, when dialing short numbers, 
such as 411, the number may conflict with 
a contact name. If this occurs, press 
Option  to avoid starting a contact 
lookup. 

Dialing with a speed-dial button 

Your smartphone enables you to create 
both picture and text speed-dial buttons so 
that you can select a button on the Today 
screen to dial a number quickly.

DID YOU KNOW? When you’re dialing a phone 
number or are on a call, you can enter * and # 
without first pressing Option. This makes it 
easy to respond to further dialing instructions 
or to press options when responding to 
automated instructions.

TIP If you press Phone/Send while a number 
is highlighted, your smartphone dials the 
number. If a number is highlighted and you 
want to access the Today screen, first 
deselect the number, or use the Start menu.

TIP If you lock your smartphone and select 
Simple PIN as the password type, you can dial 
an emergency number by entering the 
number in the password field and pressing 
Phone/Send. You do not need to press 
Option before entering the number. However, 
if you select Strong alphanumeric as the 
password type, you must first press Option 
twice before entering the number in the 
password field. See Locking your smartphone.
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BEFORE YOU BEGIN

• Create some speed-dial buttons. See 
Defining speed-dial buttons. You can 
customize the default speed-dial 
buttons. See Editing a speed-dial 
button.

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

You can make a call using your speed-dial 
buttons by doing any of the following:

• Use the 5-way  to highlight a 
speed-dial button, and then press 
Center .

• Tap a speed-dial button with the stylus. 

• Press and hold the Quick Key that you 
assigned to the speed-dial button.

To see more speed-dial buttons, highlight 
the picture speed-dial area and press 
Right  or Left  repeatedly, or highlight 
the text speed-dial area and press Up , 
Down , Right , or Left .

Dialing by contact name

You can look up contacts quickly by 
entering just a few letters of a contact’s 
name directly from your Today screen.

BEFORE YOU BEGIN

• Before you can dial a number by contact 
name, you must create some contacts 
(see Adding a contact), or import them 

DID YOU KNOW? You can dial an alternate 
number for a contact with a speed-dial button. 
Highlight the speed-dial button, press and hold 
Center on the 5-way (or tap and hold the 
button), and then select a number from the 
shortcut menu.

TIP You can hide your speed-dial buttons on 
your Today screen and still use your Quick 
Keys to call a speed-dial number. For details 
see Selecting which items appear on your 
Today screen.
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by synchronizing (see Synchronizing 
information). 

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

1 Go to your Today screen. 

2 Using the keyboard, begin entering one 
or more letters of the contact’s first or 
last name. If you use both first- and 
last-name letters, insert a space 
between the first and last name.

For example, entering SM finds both 
Smilla Anderson and John Smith. 
Entering SM AN finds only Smilla 
Anderson.

To clear the Dial Lookup field and start 
another Contacts search, press OK . 

To delete letters when correcting a 
misspelled name, press Backspace.

3 Highlight the phone number you want 
to dial.

4 Press Phone/Send  or press 
Center  to dial.

Dialing using the onscreen Dial Pad

The onscreen Dial Pad is useful when you 
need to dial numbers that are expressed as 
letters, and when you need large numbers 
that you can tap with your finger or the 
stylus.

TIP To see a contact’s address, company, and 
other details, press Up on the 5-way to 
highlight the name, and then press Center.

DID YOU KNOW? After you look up a contact, 
you can select how you want to communicate 
with that person. When a contact’s name or 
phone number is highlighted on the search 
results list, press and hold Center on the 
5-way, or tap and hold with the stylus, and 
then select the communication method you 
want to use.
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BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen. 

2 Press Phone/Send  and select 
Dial Pad from the menu.

3 Use the keyboard keys or tap the 
onscreen Dial Pad to enter the number.

4 Press Phone/Send  to dial.

Redialing a recently called number

To dial the last number you called: Go to 
your Today screen, and then press and hold 
Phone/Send .

To select from your most recently dialed 

numbers: Go to your Today screen, press 
Phone/Send  highlight the number or 
contact name you want to call, and then 
press Phone/Send  to dial.

To select from a chronological list of 

calls: Go to your Today screen, press 
Phone/Send  and then select Call 

Log. Highlight the number you want to call, 
and then press either Call  (left 
softkey) or Phone/Send  to dial.

DID YOU KNOW? You can paste numbers 
directly into the Dial Pad. Copy a number from 
another application, switch to Dial Pad, and 
then press and hold Center on the 5-way to 
paste the number.
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Other ways of 
making calls

Your smartphone offers several ways to 
make phone calls other than from the 
Today screen. Try them all and you’ll 
discover which methods you prefer.

Dialing by company name

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Press Start  and select Contacts.

2 Press Menu  (right softkey) and 
select View By > Company.

3 Press Phone/Send  to go to your 
Today screen.

4 Using the keyboard, begin entering the 
first few letters of the company name.

5 Select the number you want to dial.

6 Press Phone/Send  to dial.

Dialing from a web page or message

Your smartphone recognizes most phone 
numbers that appear in web pages or in 
messages (text, email, or multimedia).

1 Use the 5-way  to highlight the 
phone number you want to dial in the 
web page or message.

2 Press Center  to open the Phone 
dialog box, and then select Yes to dial.

TIP You can also access the Call Log and Dial 
Pad from the Today screen by pressing Menu 
(right softkey).

TIP If you can’t dial a phone number directly 
from a web page or a message, highlight the 
number, select Edit (right softkey), and then 
select Copy. Open the Dial Pad, and then 
press and hold Center on the 5-way to paste. 
Press Phone/Send to dial.
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Receiving calls

To answer calls, your phone must be on. 
This is different from having only the 
screen turned on (see Turning your 
phone on). When your phone is off, your 
calls go to voicemail.

To answer a call, do one of the following:

• Press Phone/Send .

• Press Answer  (left softkey).

• If the headset is attached, press the 
headset button.

To ignore a call and send it to voicemail, 
press Menu  (right softkey) and 
select Ignore, or press Power/End .

To silence the ringer while your 
smartphone is ringing:

• Press the Volume button or any key on 
your smartphone except Phone/Send 

, Power/End , Alt , Start , 
OK , or the 5-way .

• To immediately silence all system 
sounds including the ringer, slide the 
Ringer switch to Sound Off . All 
sounds remain off until you slide the 
Ringer switch back to Sound On .

When you silence the ringer, you can either 
answer the call or let it ring through to 
voicemail.

TIP See a picture of the person calling you! 
Learn how to assign a caller ID picture in 
Adding a contact.

TIP If music is playing when a call arrives, the 
smartphone rings softly. You can answer the 
phone as you normally would. The audio 
pauses during your call.

DID YOU KNOW? You can also ignore a call and 
send a text message. Press Menu (right 
softkey) and select Ignore with text 

message.
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Using voicemail

Setting up voicemail

1 Go to your Today screen.

2 Press and hold 1 on the keyboard or 
select the Voicemail speed-dial button 
to dial the Verizon Wireless voicemail 
system.

3 Follow the voice prompts to set up your 
voicemail.

Retrieving voicemail messages from the 

Today screen

When you have unretrieved voicemail 
messages, a Voicemail  icon appears at 
the top of your screen.

1 Go to your Today screen.

2 Press and hold 1 on the keyboard to dial 
the Verizon Wireless voicemail system. 

3 Enter your voicemail password using 
the keyboard, or press Extra 

Digits  (left softkey) if you 
defined this option (see Creating a 
speed-dial button for details).

4 Follow the voice prompts to listen to 
your messages.

DID YOU KNOW? The 1 key is the Quick Key for 
the voicemail speed-dial button. For more info 
on Quick Keys see Creating a speed-dial 
button.

TIP If you have trouble accessing a voicemail 
system, try changing the Dial Pad tone 
setting. See Selecting your call settings.
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Retrieving messages from a voicemail 

notification

NOTE Not all service plans support 
voicemail notification. Check with Verizon 
Wireless for more information.

You can retrieve voicemail messages when 
you receive a notification, or you can 
dismiss the notification and retrieve the 
messages later.

• When you have a new voicemail 
message, a notification screen appears.

• To hear your message now, press 
Listen  (left softkey). 

• To retrieve your message later, press 
Dismiss  (right softkey). 

What can I do during 
a call?

Your smartphone offers many advanced 
telephone features, including call waiting, 
three-way calling, and call forwarding. 
These features depend on your service 
plan. Please contact Verizon Wireless for 
more information.

When you make or receive a call, the active 
call info appears on your Today screen.
 

DID YOU KNOW? When a Voicemail icon 
appears at the top of the screen, you can tap 
this icon to retrieve your voicemail.

TIP You can display onscreen voicemail 
playback controls; see Creating a speed-dial 
button

Current 
duration of call

Caller’s name 
and number
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During a call, you can do any of the 
following:

Navigate around the Today screen: Use 
Up  and Down  to move around or 
highlight items.

Put the call on hold: Press Hold  
(left softkey). To take the call off hold, press 
Off Hold  (left softkey).

Use the speakerphone: Select   
Speakerphone . To turn the 
speakerphone off, select 
Speakerphone  again.

Mute the microphone so you can’t be 

heard: Select Mute . To turn the 
microphone back on, select Mute  
again.

Switch to another application: Press 
Start  and select the application. To 
return to the active call screen, press 
Phone/Send  to display your Today 
screen, and then select the Call in 

Progress entry.

Ending a call

Do one of the following:

• Press Power/End .

• Press the headset button (if the headset 
is attached and has a button on it). 
Some headsets do not have a button.

DID YOU KNOW? The first time you press Up or 
Down, the active call info is minimized so you 
can view all of the items on your Today 
screen. Select the Call in Progress entry on 
the Today screen to maximize the active call 
info again.

DID YOU KNOW? When the Speakerphone and 
Mute icons are selected, they turn gray.

DID YOU KNOW? When a call lasts longer than 
one minute, the screen dims. After two 
minutes, it dims more. Press any key, except 
Power/End, to light up the screen.

DID YOU KNOW? You can send and receive text 
messages during a call. This is a great way to 
stay connected with colleagues during a long 
call.
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Switching applications during a call

You can use many other applications, 
including the organizer and text message 
features, on your smartphone while holding 
a phone conversation. You cannot, 
however, make some data connections 
during an active call while connected to a 
network. For example, on most networks 
you cannot browse the web or send and 
receive email while on a voice call. How 
can you tell which kind of network you’re 
connected to? See What are all those 
icons?

To open an application, see Opening and 
closing applications.

From any application, press 
Phone/Send  to return to your 
Today screen.

Saving phone numbers

After you hang up a call, you can add the 
number of the person you were talking 
with to Contacts if it’s not already in your 
list. If an incoming call uses caller ID 
blocking, you do not see the Add Contact 
prompt.

• To create a new contact for this number, 
select Create New Contact.

• To add this number to an existing 
contact, select Copy and Add, and 
then select a contact name.

• To decline adding the number, press 
Dismiss  (left softkey).

• To disable the Add Contact prompt, 
select Don’t show this again.

TIP If you disable the Add Contact prompt, you 
can turn it on again. From your Today screen, 
press Menu (right softkey) and select 
Preferences > Phone Settings. On the 
Phone tab, check the After calls from 

numbers that are not in Contacts, ask if I 

want to add them box.

TIP You can also save contact info from other 
applications, such as Messaging.
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If you don’t add a number right away, follow 
these steps to add it later: 

1 Go to the Call Log (see Redialing a 
recently called number). 

2 Highlight the number you want to save. 

3 Press and hold Center  to open the 
shortcut menu, and then select Save to 

Contacts.

4 Enter the information for the entry.

5 Press OK .

Making a second call 

You can make a second call while your first 
call is still active:

1 Place your first call on hold by pressing 
Hold  (left softkey).

2 Dial a second number using any of the 
methods described in Making calls from 
the Today screen. If you’re dialing by 
contact name or with the keyboard, you 
must first use the 5-way to select the 
Dial Lookup field.

When two calls are active, your Today 
screen includes two call status sections, 
each representing one of the calls. 

Answering a second call (call waiting)

When you’re on a call and you receive a 
second call, the call waiting notification 
appears. You can do any of the following:

Send the new call to voicemail: Press 
Menu  (right softkey) and select 
Ignore.

Send the new caller a text message: 

Press Menu  (right softkey) and 
select Ignore with text message. The 
second call is sent to voicemail. A new text 
message opens with the phone number of 
the caller entered in the To field.

Hang up the current call and answer the 

new call: Press Menu  (right 
softkey) and select Drop and Answer. You 
can also press Power/End  to hang up 
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the current call, and then choose to answer 
or ignore the new call.

Place the current call on hold and 

answer the new call: 

Press Answer  (left softkey) or 
Phone/Send . After you answer the 
call, press Swap  (left softkey) to 
move between callers by placing the 
current active call on hold and talking on 
the other line.

Making a conference call

IMPORTANT You can join two calls into a 
conference call. Additional charges may 
apply, and minutes in your mobile account 
may be deducted for each call. Please 

contact Verizon Wireless for more 
information.

1 Put the first call on hold and make a 
second call (see Making a second call).

2 Press Menu  (right softkey) and 
select Conference. This joins the two 
calls with you in a conference.

3 When you’re done, do one of the 
following:

• Press End Conference  (left 
softkey) to end the second call and 
return to the first call.

• Press Power/End  to hang up 
both calls.

Press to swap between calls
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Forwarding calls

You can forward calls to another phone 
number. Check with Verizon Wireless 
about availability and pricing of forwarded 
calls; additional charges may apply.

When all calls are forwarded, the call 
forwarding icon  appears in the title bar.

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Dial *72 followed by the number 
where you want to forward your calls. 
For example: *72 415-555-1234. 

3 Press Phone/Send  to dial.

4 When you’re ready to turn off call 
forwarding, dial *73, and then press 
Phone/Send .

Defining speed-dial 
buttons

Your smartphone lets you create both 
picture and text speed-dial buttons so that 
you can select a button on the Today 
screen to quickly dial a number.

Creating a speed-dial button

You can create up to 20 picture buttons and 
50 text buttons. 

1 Go to your Today screen.

2 Press Menu  (right softkey) and 
select New Speed Dial. 

3 Do one of the following:

• Select Link to contact, select the 
contact you want to link to this button, 
and then select the number you want 
to dial with this button.

• Select Label and enter a name for this 
button, and then select Number and 
enter the phone number you want to 
dial with this button.

TIP If *72 and *73 do not turn call 
forwarding on and off, contact Verizon 
Wireless to obtain the forwarding codes for 
your area.

After you turn on call forwarding, call your 
smartphone to confirm that call forwarding is 
active.
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4 (Optional) Enter a Quick Key. When the 
Today screen is showing, you can press 
and hold the Quick Key to instantly dial 
this number.

Quick Keys can be letters or numbers, 
but you can’t use both the letter and 
number on the same key. For example, 
the voicemail Quick Key is 1. The letter 
equivalent for that key is E, so you 
cannot assign E as a Quick Key to 
another speed-dial button.

5 If this button is linked to a contact entry 
with a picture, select either Text Speed 

Dial or Picture Speed Dial to indicate 
which type of button you want to 
create. If this button is not linked to a 
contact or the contact doesn’t have a 

picture, the Picture Speed Dial option is 
not available.

6 (Optional) Select the Advanced tab and 
set any of the following options:

Extra Digits: Defines additional 
numbers to dial, such as a password or 
extension. In addition to numbers, you 
can enter the following symbols: star 
(*) and pound (#). To enter a one- 
second pause, enter a comma (,). 

Dial extra digits automatically: Dials 
predefined Extra Digits immediately 
after dialing the phone number. If you 

TIP You can add a special ringtone to a contact 
associated with the speed-dial button. See 
Adding a contact.
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do not check this box, you must press 
Extra Digits  (left softkey) to dial 
these digits.

Show voice mail buttons: Displays the 
voicemail playback controls after you 
dial this speed-dial number. When this 
option is checked, you can enter 
numbers below each control to tailor 
the controls to your voicemail system.

 Plays the previous message.

 Saves the current message.

 Plays the current message.

 Deletes the current message.

 Repeats the current message.

 Plays the next message.

7 Press OK . 

Editing a speed-dial button

1 Go to your Today screen.

2 Highlight the speed-dial button you 
want to edit.

3 Press and hold Center  to open 
the shortcut menu, and then select 
Edit Speed Dial.

4 Make the desired changes.

5 Press OK .

Deleting a speed-dial button

1 Go to your Today screen.

2 Highlight the speed-dial button you 
want to delete.

3 Press and hold Center  to open 
the shortcut menu, and then select 
Edit Speed Dial.

4 Press Delete  (right softkey).

5 Select Yes to confirm the deletion.

Arranging your speed-dial buttons

1 Go to your Today screen.

2 Press Menu  (right softkey) and 
select Speed Dial Options.

3 Highlight the button you want to move.

4 Press Option  + Left  or Right  or 
Up  or Down  to move the button 
in that direction.

TIP You can also edit a speed-dial button by 
pressing Menu (right softkey), selecting 
Speed Dial Options, and then selecting the 
button you want to edit.
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Using a phone 
headset

You can connect a phone headset for 
hands-free operation. You can use either 
the headset that came with your 
smartphone or a compatible third-party 
headset.

IMPORTANT If driving while using a 
smartphone is permitted where you are 
and you need to make a call, we 
recommend using a phone headset or a 
hands-free car kit (sold separately). If you 
must use the wired headset while driving, 
place a speaker in only one ear. Leave the 
other ear free to hear outside noises. Make 
such a call only if it is legal to do so and you 
can do so safely.

Using a wired headset

Microphone

Speakers

Headset button
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The headset button is context-sensitive, 
and it performs various actions based on 
the situation. You can press the headset 
button to do any of the following tasks:

• Answer an incoming call

• Respond to call waiting

• Hang up all calls

• Swap between calls if the second call is 
an incoming call

• Create a conference call if the second 
call is an outgoing call

NOTE Your smartphone works with 
headsets that have a 2.5mm, 3-pin 
connector (look for two colored bands on 
the plug). When in doubt, ask the 
third-party headset manufacturer if the 
product is compatible with Palm Treo 
700wx smartphones. If you hear a headset 
buzz or poor microphone performance, 
your headset may be incompatible with 
your smartphone.

Using a THB wired car kit

Your smartphone includes software that 
enables you to choose settings for the THB 
wired car kit (car kit sold separately). To 

access these car kit settings, do the 
following:

1 Press Start  and select Settings.

2 On the Personal tab, select THB 

Kit .

Connecting to a Bluetooth® hands-free 

device

YourTreo 700wx smartphone is also 
compatible with many headsets and car 
kits (sold separately) enabled with 
Bluetooth® wireless technology 
version 1.1 or 1.2.

For a list of compatible hands-free devices 
with Bluetooth wireless technology, go to 
palm.com/us/support/bluetooth/
bluetooth compatibility.html.

NOTE You can use a stereo Bluetooth 
headset that is A2DP-enabled to listen to 
MP3 files on your smartphone. You cannot, 
however, use a mono Bluetooth headset to 
listen to MP3 files.

After you set up a connection with a 
Bluetooth headset or hands-free car kit, 
you can use that device with your 
smartphone whenever the two devices are 

http://www.palm.com/us/support/bluetooth/bluetooth_compatibility.html
http://www.palm.com/us/support/bluetooth/bluetooth_compatibility.html
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within range and the Bluetooth feature on 
each device is turned on. The range varies 
greatly, depending on environmental 
factors. The maximum is about 30 feet (10 
meters).

1 If necessary, prepare the device with 
which you want to connect to accept a 
new connection. Check the device’s 
documentation for details. Be sure to 
find out if the device has a predefined 
passkey that you need to enter on your 
smartphone in step 7.

2 Go to your Today screen and tap 
Bluetooth .

3 Select the Mode tab and check the Turn 

on Bluetooth box.

4 Select the Devices tab, and then select 
Add new device.

DID YOU KNOW? If you have both a compatible 
Bluetooth headset and a car kit, the one you 
connected to your smartphone last becomes 
the active device.

DID YOU KNOW? The Bluetooth icon on your 
Today screen indicates the status of the 
Bluetooth feature See The Bluetooth status 
icon for details.



Y O U R  P H O N E

U S I N G  A  P H O N E  H E A D S E T 63

4

C
H

A
P

T
E

R

5 Wait for your smartphone to search for 
devices and to display the device list.

6 Select the device you want to connect 
to, and then press Next  (right 
softkey).

7 Enter a passkey between 1 and 16 
digits long, and then press Next  
(right softkey).

IMPORTANT Some hands-free devices 
have a predefined passkey. If your 
hands-free device has a predefined 
passkey, you can find it in the 
documentation for that device. Other 
devices provide a screen where you enter 
a passkey that you make up. In either case, 

you must use the same passkey on both 
your smartphone and your hands-free 
device. We recommend that you use a 
passkey of 16 digits, where possible, to 
improve the security of your smartphone. 
The longer the passkey, the more difficult 
it is for the passkey to be deciphered.

8 If the passkey is not predefined, enter 
the same passkey on the other 
Bluetooth device, and then press Finish 

 (right softkey).

9 Check the Hands Free box, and then 
press Finish  (right softkey). 

10 Press OK .

You can now use that hands-free device 
with your smartphone whenever the two 
devices are within range and the Bluetooth 
feature on each device is turned on The 
range varies greatly, depending on 
environmental factors. The maximum is 
about 30 feet (10 meters).

Using a Bluetooth hands-free device

To learn how to set up and connect to 
Bluetooth devices, see Connecting to a 
Bluetooth® hands-free device.
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Here are tips for working with a Bluetooth 
hands-free device:

• To transfer a call from the handset to a 
Bluetooth hands-free device during a 
call, press Menu  (right softkey) 
and select Connect Bluetooth. To 
transfer the call back to the headset, 
press Menu  (right softkey) and 
select Cancel Bluetooth.

• To transfer a call from a wired headset 
to a Bluetooth headset or car kit that is 
within range and with which you’ve 
previously set up a partnership 
(Bluetooth headset or car kit required, 
sold separately), unplug the wired 
headset and press the button on the 
Bluetooth headset or car kit.

• To find out how to transfer your 
contacts from your smartphone to your 
car kit, go to palm.com/us/support/treo/
treo700wxverizon/.

Customizing phone 
settings

Selecting ringtones and display notices

You can set different tones for different 
types of incoming phone calls and 
notifications. You can download MP3, 
MIDI, AMR, WAV, and WMA ringtones 
directly to your smartphone 
(see Downloading files and images from a 
web page). You can also download 
ringtones to your computer and then email 
them to your phone.

DID YOU KNOW? If you’re using a Bluetooth 
hands-free device and it is within range, your 
smartphone routes all calls to the hands-free 
device instead of to the earpiece on your 
smartphone. Bluetooth range is up to 30 feet 
(10 meters) in optimum environmental 
conditions.

http://palm.com/us/support/treo/treo700wxverizon/
http://palm.com/us/support/treo/treo700wxverizon/
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1 Press Start  and select Settings.

2 On the Personal tab, select Sounds & 

Notifications .

3 Select the Notifications tab.

4 Select the Event list, and then select 
the type of call or notification for which 
you want to set the ringtone:

Phone: Known Caller: An incoming call 
from someone in your contacts list or 
speed-dial list.

Phone: Missed call: A call you did not 
answer.

Phone: Roaming: A call that comes in 
when you’re outside your home mobile 
network.

Phone: Unknown Caller: An incoming 
call from someone identified by caller 
ID who is not in your contacts list or 
speed-dial list.

Phone: Voice mail: A new voicemail.

5 If you selected Known Caller, Roaming, 
or Unknown Caller, select the ring type 
and the ringtone. Select the Play icon to 
preview the ringtone sound.
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6 If you selected Missed call or Voice 
mail, set the following options:

• Check the Play Sound box if you 
want to have a sound played when 
the event occurs.

• If you checked the Play Sound box, 
select the sound for the selected type 
of call. You can also check the Repeat 
box to have the sound repeat.

• (Optional) Select the Play icon to 
preview the sound.

• Check the Display message on 

screen box to have a message 
displayed when the event occurs.

7 Check the Vibrate when… boxes to 
turn the vibrate feature on/off based on 
the Ringer switch setting.

8 Repeat steps 4–7 to select ringtones for 
other types of calls.

9 Press OK .

Adjusting call and ringer volume

Call volume: While a call is in progress, 
press Volume (on the side of your 
smartphone) to adjust the call volume. 

Ringer volume: When a call is not in 
progress and you are not playing music or a 
video, press Volume to adjust ringer 
volume.

Assigning a caller ID picture and ringtone

1 Press Start  and select Contacts.

2 Highlight the contact that you want to 
give a picture and ringtone ID, then 
press Center .

3 Highlight the contact’s name, and press 
Edit  (left softkey).

4 Select Picture.

DID YOU KNOW? You can record, preview, 
delete, and send sounds on your smartphone. 
You can also set sounds for messaging 
notifications and calendar reminders. See 
Selecting Sounds & Notifications.

Volume 
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5 Select Camera to take a picture and add 
it to this contact entry (camera version 
only), or select an existing picture for 
this contact entry.

6 Select Ring tone.

7 Select a tone for this contact entry.

8 Press OK .

Selecting your call settings

BEFORE YOU BEGIN Turn on your phone 
to access your Phone Settings. See Turning 
your smartphone on/off.

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 On the Phone tab, set any of the 
following options:

Dialpad: Sets the style for the Dial Pad 
tones (DTMF) in the Phone application.

• Short tones: Tones sound briefly as 
you dial.

• Long tones: Tones continue to sound 
until you release the key.

TTY/TDD: Lets you configure your 
smartphone for use with a TTY/DTDD 
device for people who are deaf or hard 
of hearing (see Enabling TTY for more 
information).

After calls from numbers that are not 

in Contacts, ask if I want to add 

them: Indicates whether you are 
prompted to add contact entries for 
numbers that are not already in your 
contacts list.

4 Press OK .

TIP If you have trouble accessing a voicemail 
system, try changing the Dialpad tone setting.
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Setting your dialing preferences

Dialing preferences let you assign a prefix 
to your phone numbers. For example, you 
can automatically dial a 1 before all 10-digit 
phone numbers. You can add a different 
prefix based on the length of the phone 
number.

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 Select the Dialing tab and set any of 
the following options:

Dialing from North America: Formats 
phone numbers using North American 
conventions (XXX-XXX-XXXX) and sets 
the International Dialing Prefix to 011.

Always dial 1 in front of the area 

code: Adds a 1 in front of 10-digit phone 
numbers. This option is available only 
when North American Dialing is 
enabled.

International Dialing Prefix: Adds the 
specified number in front of 
international phone numbers when 
dialing from outside North America. 
When an international number 
beginning with + (plus sign) is dialed, 
the + is replaced with the number in 
this field.

4 Press OK .

Setting your abbreviated dialing 

preferences

Abbreviated dialing is a way to 
automatically dial a complete phone 
number when you enter a shortened 
version of that number. Shortened phone 
numbers are typically used in corporate 
phone systems to allow internal users to 
dial an extension number rather than the 
complete number.

For example, if your co-worker’s phone 
number is 1-555-222-1234, you may need 
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to dial only the last five digits of that 
number from an internal phone. In that 
case, you would dial 21234. If that 
shortened five-digit internal number 
appears in your contact list or in a 
corporate Global Address List (GAL), your 
smartphone cannot dial that number 
because it is not on the internal phone 
network. You can, however, use the 
abbreviated dialing settings to 
automatically complete shortened 
numbers.

For example, if all the phone numbers in 
your office begin with 1-555-22, followed 
by a five-digit extension, set your 
smartphone to automatically enter 
1-555-22 as the prefix before any five-digit 
number. When you enter your colleague’s 
five-digit extension, your smartphone 
automatically dials 1-555-22 plus the 
five-digit extension. The complete number 
is 1-555-222-1234.

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 Select the Dialing tab and select 
Abbreviated Dialing.

4 Check the box that corresponds to the 
number of digits in the shortened 
version of the phone numbers you 
commonly dial (3, 4, 5, 6, or 7). 
Selecting the option adds a prefix to 
numbers with the specified number of 
digits.

5 Enter the numbers that you want to be 
added to the shortened version of the 
phone number

6 Press OK .

Adding contact numbers from new callers

By default, you are prompted to add 
contact entries for numbers that are not 
already in your Contacts list. You can turn 
this feature on or off.
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1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 On the Phone tab, uncheck the After 

calls from numbers that are not in 

Contacts, ask if I want to add 

them box to turn this feature off, or 
check this box to turn this feature back 
on.

4 Press OK .

Manually selecting your network settings

IMPORTANT The network settings are 
preset for optimum performance. Do not 
change these settings unless instructed to 
do so by a representative from Verizon 
Wireless. 

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right softkey) and 
select Preferences > Phone Settings. 

3 Select the Services tab and then select 
Network.

4 From the Band selection list, select an 
option:

Automatic X: The network connection 
is automatically made.

Manual: Network connections are 
manually made. If you are manually 
selecting a network, select a network 
from the list of available networks.

5 Check the boxes to enable either or 
both of the following roaming options:

Before outgoing calls: Causes an alert 
to appear, warning you that you are on a 
roaming network when you attempt to 
dial an outgoing call.

Before data connections: Prevents a 
data connection while roaming. An alert 
appears, warning you that you are on a 
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roaming network when you attempt to 
make a data connection.

6 Press OK .

Selecting your privacy settings

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 Select the Services tab and set any of 
the following options:

Voice Privacy: Prevents over-the-air 
eavesdropping when this option is 
turned on and this feature is available on 
the Verizon Wireless network.

Location Privacy: Indicates whether 
your smartphone broadcasts your 
location at all times, or only during a 911 
call.

4 Press OK  to return to Phone 
Settings.

5 Press OK  to finish.

Enabling TTY

You can enable your smartphone for use 
with a TTY/TDD device. A TTY (also known 
as a TDD or Text Telephone) is a 
telecommunications device that enables 
people who are deaf or hard of hearing, or 
who have speech or language disabilities, 
to communicate by telephone.

Your smartphone is compatible with select 
TTY devices. You can connect a TTY/TDD 
machine, headset, or hands-free kit to your 
smartphone through the headset jack while 
in TTY/TDD mode.

Please check with the manufacturer of your 
TTY device for connectivity information. Be 
sure that the TTY device supports digital 
wireless transmission.

• Make sure a TTY/TDD device is 
connected to the headset jack on your 
smartphone. When you enable TTY, all 
audio modes are disabled on your 
smartphone, including holding the 
smartphone up to your ear and 
listening.

• Turn on your phone to access your 
Phone Settings. See Turning your 
phone on.

TIP For quick access to the Location Privacy 
setting, tap the Location Privacy icon on your 
Today Screen (see What are all those icons?).
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1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 On the Phone tab, select the TTY/TDD 
list and then select one of the following:

Off: Sends and receives voice.

TTY Full: Sends and receives text.

TTY + Talk: Sends voice and receives 
text.

TTY + Hear: Sends text and receives 
voice.If an alert appears, press OK .

4 Press OK .

NOTE When TTY/TDD is on, a TTY/TDD 
 icon appears at the top of the Today 

screen.

What are all those 
icons?

You can monitor the status of several items 
using icons at the top of your Today screen:

Your phone is on and you’re 
in a Verizon Wireless 
coverage area. If you’re 
roaming on another wireless 
service provider’s network, 
Roaming or Extended 

Network appears instead. If 
you’re outside a coverage 
area, No service appears 
instead. When you turn 
off your phone, Phone Off 
appears instead.

You missed an incoming call.

You have a voicemail 
message.

You have a new email 
message.
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You have a new text or 
multimedia message.

You have more than one of 
the conditions listed above.

Your phone is on. The bars 
display the signal strength. 
The stronger the signal, the 
more bars that appear. If you 
are outside a coverage area, 
no bars appear.

Your phone is off.

You are outside a Verizon 
Wireless coverage area and 
are roaming on another 
wireless service provider’s 
network. Additional fees may 
apply for calls or data 
transmission. Data services 
may not be available when   
you are roaming.

A voice call is in progress.

TTY/TDD is turned on.

All calls are being forwarded.

You are in an area that 
supports NationalAccess 
(1xRTT) data services.

You are in an area that 
supports BroadbandAccess 
(EVDO) data services.

A NationalAccess data call is 
in progress. You can make 
calls, but you cannot receive 
calls; any incoming calls go 
to voicemail. When you make 
a call, the data transmission 
is automatically interrupted.

A BroadbandAccess data call 
is in progress. You can still 
make or receive calls. When 
you make or receive a call, 
the data transmission is 
automatically interrupted.

Your phone is connected to a 
NationalAccess network, but 
you are not actively 
transmitting data. You can 
still make or receive calls.



Y O U R  P H O N E

W H A T  A R E  A L L  T H O S E  I C O N S ?74

4
C

H
A

P
T

E
R

Your phone is connected to a 
BroadbandAccess network, 
but you are not actively 
transmitting data. You can 
still make or receive calls.

ActiveSync synchronization is 
in progress with a Windows 
XP computer.

Your smartphone is 
connected to a computer or 
network, or Windows Mobile 
Device Center sync is in 
progress with a Windows 
Vista computer.

A data connection is not 
available or your phone is off.

Your smartphone battery is 
low.

Your smartphone battery is 
being charged.

Your smartphone is 
connected to a power outlet 
and the battery is fully 
charged.

Voice privacy is preventing 
over-the-air eavesdropping. 
Appears during a call when 
this option is turned on and is 
available on the Verizon 
Wireless network.

Location privacy is turned off, 
so your smartphone can 
broadcast your GPS location. 
The whereabouts of your 
smartphone can be 
determined by the Verizon 
Wireless network, by 
emergency agencies like 911, 
and by other apps on your 
smartphone. 

Location privacy is turned on, 
so only emergency call 
operators can determine the 
location of your smartphone. 
Your smartphone’s location 
cannot be determined by 
other apps on your 
smartphone.

 Bluetooth® wireless 
technology is off.
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Bluetooth wireless 
technology is on. 

Your smartphone is 
communicating with another 
Bluetooth device. 

A call is in progress and your 
smartphone is connected 
to a Bluetooth headset or 
car kit.

You have a reminder. If the 
reminder is not displayed on 
your Today screen, tap the 
icon to open the reminder.

You have an alert from 
Microsoft. If the alert is not 
displayed on your Today 
screen, tap the icon to open 
the alert.
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CHAPTER

5

Synchronizing information
Synchronizing means that information that has been entered or 
updated in one place—your Palm® Treo™ 700wx smartphone, 
your computer, or your corporate server—is automatically 
updated in the other. There’s no need to enter information twice. 
Some types of synchronization can happen on an automated 
schedule, so you don’t even have to think about it.

After you get into the habit of synchronizing regularly, you’ll 
know what a powerful tool synchronization is for transferring, 
updating, and backing up large amounts of information on your 
smartphone.

Benefits

• Quickly enter and update 
information on your computer and 
your smartphone

• Protect your information

• Send photos and videos to your 
smartphone from your desktop 
computer
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Synchronization 
overview

When you synchronize, info you enter on 
your smartphone, your computer, or your 
corporate server is automatically updated 
in the other location. There’s no need to 
enter the info twice. This is true whether 
you sync with your computer using 
desktop synchronization software (see 
Setting up your computer for 
synchronization) or wirelessly with your 
company’s Exchange server using 
Microsoft Exchange ActiveSync (see 
Setting up wireless synchronization).

How do I 
synchronize?

There are a number of ways to 
synchronize:

• Install desktop sync software on your 
computer.

• Synchronize wirelessly with an 
Exchange server.

• Maximize your sync options by doing 
both.

Synchronizing with desktop sync 

software

BEFORE YOU BEGIN Install the current 
version of the desktop sync software. You 
must install this software even if you have 
already installed a previous version of 
desktop sync software. See Installing 
ActiveSync desktop software: Windows XP 
or Installing Windows Mobile Device 
Center: Windows Vista for instructions.

After you install desktop sync software, 
you can synchronize by connecting your 
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smartphone to your computer using any of 
the following:

Sync cable: See Synchronizing using the 
sync cable.

Bluetooth® wireless technology: See 
Synchronizing over a Bluetooth connection.

Infrared (IR): See Synchronizing over an 
infrared connection.

The sync application on your smartphone is 
called ActiveSync. The name of the 
desktop sync software on your computer 
depends on your computer’s operating 
system:

Windows XP computer: The desktop 
sync software is called ActiveSync® 
desktop software.

Windows Vista computer: The desktop 
sync software is called Windows Mobile 
Device Center.

Synchronizing wirelessly with the server

You can set up your smartphone to 
synchronize email and other information 
wirelessly with Microsoft Exchange Server 
2007 or Exchange Server 2003 using 
Microsoft Exchange ActiveSync (see 

Setting up wireless synchronization). If you 
choose this method, synchronization takes 
place automatically after setup. You do not 
need to install the software from the 
Windows Mobile Getting Started CD.

NOTE We recommend that you install the 
desktop sync software from the CD even if 
you synchronize wirelessly with the server. 
You need the desktop sync software to 
synchronize pictures, videos, music files, 
and other info directly with your computer.

What can I 
synchronize?

If you have Microsoft Office Outlook® 2002 
or later installed on your computer, by 
default, the following information is 
synchronized when you synchronize using 
either desktop sync software or Microsoft 
Exchange ActiveSync:
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You can, however, customize sync settings 
to suit your needs and sync only some of 
these applications.

If you set up synchronization with your 
computer using the desktop sync 
software, information in the Favorites 
application is synchronized by default as 
well. You can also change settings to 
synchronize Word, Excel, PowerPoint, and 
PDF files, as well as pictures, music, 
videos, and other types of files (see 
Changing which applications sync).

IMPORTANT To synchronize Calendar, 
Contacts, Messaging (email and text 
messages), and Tasks, you must have 
Outlook 2002 or later installed on your 

computer. If you want to synchronize 
pictures, music, and videos, you need to 
have Windows Media Player 10 or later 
installed on your computer.

This table lists the types of info you can 
synchronize and the methods to use.

DID YOU KNOW? Synchronizing Favorites gives 
you an easy way to get favorites from the web 
browser on your computer into the web 
browser on your smartphone. Just add them 
to the folder called Mobile Favorites, which 
shows up in your computer browser’s list of 
favorites. When you sync, they become 
available on your smartphone as well. Backup 
copies of any favorites that you add on the 
smartphone browser are also stored in the 
Mobile Favorites folder.

TIP If you don’t already have Outlook or 
Windows Media Player installed on your 
computer, you can install them from the 
Windows Mobile Getting Started CD. Insert 
the CD into your computer’s CD drive, select 
Add Programs (Windows XP) or Bonus 

Software (Windows Vista), and then select 
Windows Media Player or the link to 
download a trial version of Outlook 2007.

TIP If you want to synchronize with a personal 
information manager (PIM) other than 
Microsoft Office Outlook, you must install a 
third-party solution. Contact the PIM’s vendor 
to learn if software is available for your 
smartphone
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Info type Method Where to learn more

Outlook Contacts, 
Calendar, Tasks

Desktop sync software 
(sync with computer) or 
Exchange ActiveSync 
(direct sync with server)

Setting up your computer for 
synchronization or 

Setting up wireless synchronization

Outlook Email Desktop sync software or 
Exchange ActiveSync

Setting up your computer for 
synchronization or 

Setting up wireless synchronization

Word, Excel, 
PowerPoint, PDF 
files

Desktop sync software Setting up your computer for 
synchronization

Synchronizing your Microsoft Office 
files

Changing which applications sync

Music and video 
files

Desktop sync software 
and Windows Media 
Player

Setting up your computer for 
synchronization

Changing which applications sync

Transferring media files to your 
smartphone

Pictures Windows XP: Desktop 
sync software

Windows Vista: Desktop 
sync software and 
Windows Media Player

Setting up your computer for 
synchronization

Changing which applications sync

Transferring media files to your 
smartphone (Windows Vista)
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Setting up your 
computer for 
synchronization

Before you can synchronize, you need to 
install synchronization software and 
connect your smartphone to your 
computer using the sync cable. Even if you 
already have desktop sync software 
installed on your computer, you must 
install the current version of the software.

System requirements

Your computer must meet the following 
minimum system requirements:

• Windows 2000 Service Pack 4, 
Windows XP Service Pack 2, or 
Windows Vista (later versions may also 
be supported)

• 32MB of available memory (RAM)

• 170MB of free hard disk space

• CD drive

• Available USB port

• USB sync cable (included with your 
smartphone)

• Adobe Flash Player (required to run the 
installation program)

Outlook Notes Desktop sync software Setting up your computer for 
synchronization

Changing which applications sync

Files to be 
transferred to an 
expansion card

Desktop sync software Setting up your computer for 
synchronization

Changing which applications sync

Info type Method Where to learn more
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Installing ActiveSync desktop software: 

Windows XP

If you have a Windows XP computer, the 
desktop sync software is called ActiveSync 
desktop software. On your smartphone, 
the sync application is called ActiveSync.

If your smartphone runs Windows Mobile 
5.0, use the version of ActiveSync desktop 
software included on the Windows Mobile 
Getting Started CD, which came with your 
smartphone. The Windows Mobile Getting 
Started CD recognizes that you have a 
Windows XP computer and automatically 
directs you to install ActiveSync desktop 
software. 

If you have upgraded your smartphone to 
Windows Mobile 6 Professional edition, 
you must download and install version 4.5 
of ActiveSync desktop software on your 
computer. Do not use the version 
included on the Windows Mobile Getting 
Started CD.

BEFORE YOU BEGIN If you are installing 
the software on a computer at work, make 
sure your company allows you to install 
new software—for example, that you have 
Administrator privileges. Contact your 
company’s IT department for help.

1 Close any applications that are currently 
running on your computer, including 
those running in the background. Your 
computer must have all its resources 
available to install the software.

2 Do one of the following:

If your smartphone runs Windows 

Mobile 5.0: Insert the Windows Mobile 
Getting Started CD into the CD drive on 
your computer.

If your smartphone has been 

upgraded to Windows Mobile 6 

Professional: On your computer, go to 
palm.com/us/support/treo/
treo700wxverizon/ and follow the link to 
download ActiveSync.

3 Follow the installation instructions that 
appear on both your computer and your 
smartphone.

TIP If you do not have Adobe Flash Player on 
your computer, you can download it for free 
from adobe.com

http://www.adobe.com
http://palm.com/us/support/treo/treo700wxverizon/
http://palm.com/us/support/treo/treo700wxverizon/
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During installation, you connect your 
smartphone to your computer and sync 
for the first time. Be sure to watch 
what’s happening on both your 
computer and your smartphone. For 
more info, see Connecting your 
smartphone to your computer and 
Synchronization: Overview.

Installing Windows Mobile Device Center: 

Windows Vista

If you have a Windows Vista computer, the 
desktop sync software is called Windows 
Mobile Device Center. The Windows 
Mobile Getting Started CD recognizes that 
you have a Windows Vista computer and 

automatically directs you to install 
Windows Mobile Device Center. On your 
smartphone, the sync application is called 
ActiveSync.

BEFORE YOU BEGIN If you are installing 
the software on a computer at work, make 
sure your company allows you to install 
new software—for example, that you have 
Administrator privileges. Contact your 
company’s IT department for help.

1 Close any applications that are currently 
running on your computer, including 
those running in the background. Your 
computer must have all its resources 
available to install the software.

2 Insert the Windows Mobile Getting 
Started CD into the CD drive on your 
computer.

3 If prompted, click RunStart.exe.

4 Click Continue.

5 Select your language and click Next.

6 Select Setup and Installation.

7 Make sure the Windows Mobile 

Device Center box is checked, and click 
Install.

TIP During software installation, you can 
select an option to synchronize email, 
contacts, calendar events, and tasks directly 
with Microsoft Exchange Server 2003 or 2007. 
If you choose this option, you are prompted to 
enter your mail server address and domain 
name and your Exchange server account 
username and password.

DID YOU KNOW? You can also install additional 
software from the Windows Mobile Getting 
Started CD (see Installing bonus software 
from the CD).
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8 Follow the installation instructions that 
appear on both your computer and your 
smartphone.

During installation, you connect your 
smartphone to your computer and sync 
for the first time. Be sure to watch 
what’s happening on both your 
computer and your smartphone. For 
more info, see Connecting your 
smartphone to your computer and 
Synchronization: Overview.

Using the desktop sync software

After you install the desktop sync software, 
synchronization happens automatically 
anytime you connect your smartphone to 
your computer, as described in the next 
section.

You can also open the desktop sync 
software window on your computer to 
perform the following tasks:

• Install applications from your computer 
to your smartphone (see Installing 
applications from your computer) or to 
an expansion card inserted into the 
expansion card slot on your smartphone 

(see Installing applications onto an 
expansion card)

• Change which applications synchronize 

• In ActiveSync desktop software on a 
Windows XP computer, enter settings 
to synchronize wirelessly with Microsoft 
Exchange Server 2003 or 2007

To access all of the desktop sync software 
features, your smartphone must be 
connected to your computer using the 
sync cable. After your smartphone are your 
computer are connected, do one of the 
following:

Windows XP: To open the ActiveSync 
desktop software window, double-click the 
ActiveSync  icon in the taskbar in the 
lower-right corner of your computer screen.

DID YOU KNOW? You can also change which 
applications synchronize (see Changing which 
applications sync) and enter settings to 
synchronize wirelessly (see Setting up 
wireless synchronization) in the ActiveSync 
app on your smartphone. Whether you enter 
changes on your smartphone or on your 
computer, the changes are transferred to the 
other location the next time you synchronize.
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Windows Vista: To open Windows Mobile 
Device Center, click Start > All Programs 
> Windows Mobile Device Center.

Desktop software installation also creates 
a folder for your smartphone on your 
computer. When your smartphone is 
connected to your computer, opening My 
Computer or Windows Explorer (Windows 
XP) or Computer (Windows Vista) displays 
an icon representing your smartphone. 
Double-clicking this icon displays folders 
containing items you synchronized, such as 
music files, pictures, and videos.

Connecting your smartphone to your 

computer

NOTE If you’re transferring info from a 
previous Windows Mobile® device or from 
a Palm OS® by ACCESS device, you can 
learn more about how to move content, 
such as pictures, music, and files, to your 
smartphone by going to palm.com/us/
support/treo/treo700wxverizon/.

1 Plug the USB sync cable into an 
available USB port or into a powered 
USB hub on your computer.

2 Connect the sync cable to your 
smartphone by inserting it into the two 
sockets to the left on the bottom of the 
smartphone.

TIP If the ActiveSync icon does not appear in 
the taskbar, go to Start, navigate to 
Programs, and then select Microsoft 

ActiveSync to open the ActiveSync window.

TIP You can enter a setting to have the 
ActiveSync window open automatically when 
you connect your computer and your 
smartphone. In the ActiveSync window, select 
File > Connection Settings, and then check 
the Open ActiveSync when my device 

connects box.

TIP For best performance, plug your sync 
cable directly into a USB port on your 
computer. If your computer has USB ports on 
both the front and back, we suggest using the 
back port. If you use a USB hub, make sure it’s 
a powered hub.

http://palm.com/us/support/treo/treo700wxverizon/
http://palm.com/us/support/treo/treo700wxverizon/
http://palm.com/us/support/treo/treo700wxverizon/
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3 Connect the charger cable to the 
multi-connector on the bottom of your 
smartphone.

TIP When the sync cable is inserted into the 
multi-connector, you can insert the AC charger 
into the socket on the sync cable to charge 
your smartphone. 

USB sync
cable

This button has no 
function with your 
smartphone

AC charger
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Synchronizing using 
the sync cable

Every time you connect your smartphone 
to your computer, the desktop sync 
software automatically turns on and checks 
whether changes you made on the 
computer or on the smartphone need to be 
synchronized.

1 Connect your smartphone to your 
computer (see Connecting your 
smartphone to your computer).

2 Check for synchronization progress:

Windows XP: Look for the animated 
ActiveSync  icon at the top of your 
smartphone screen and the 
ActiveSync  icon, now turned 
green, in the taskbar on your computer.

Windows Vista: Look for the animated 
connection  icon at the top of your 
smartphone screen.

• If you don’t see the correct icon, make 
sure the desktop sync software that 
came with your smartphone is 
running on your computer. 

• If you have any problems 
synchronizing, see Synchronization: 
Overview for troubleshooting 
suggestions.

This button has no 
function with your 
smartphone

TIP We recommend that you install the backup 
and restore app from the Windows Mobile 
Getting Started CD. A backup and restore app 
preserves your data and settings if your 
smartphone is ever lost or stolen, and it 
protects your data during a hard reset.
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Setting up wireless 
synchronization

Does your company use Microsoft Outlook 
as its email solution? Does your company 
also use Microsoft Exchange Server 2007 
or 2003 as its email server? If so, you may 
be able to wirelessly synchronize the email 
and other Outlook info on your smartphone 
and the same info stored on the Exchange 
server using Microsoft Exchange 
ActiveSync.

If you are using Exchange Server 2007, or 
Exchange Server 2003 that has been 
upgraded to Service Pack 2, you may be 
able to take advantage of the additional 
features of Microsoft Direct Push. 
Microsoft Direct Push is a two-way 
wireless delivery method that keeps your 
Outlook information always up-to-date and 
provides more efficient communication 
between the server and your smartphone. 
It includes features like Global Address 
List, Tasks Over The Air (OTA), and 
IP-based push updating of Calendar and 
Messaging (email and text messages).

BEFORE YOU BEGIN To synchronize 
wirelessly, you need to set up an Exchange 
Server account. Work with your system 
administrator to gather the following info, 
and then follow the steps in this section to 
set up an account:

• Mail server address and domain name.

• The username and password you use to 
access your corporate mail server.

• Security connection: Does your server 
use an encrypted (SSL) connection?

• Security measure: Is it OK to store your 
corporate email password on your 
smartphone?

DID YOU KNOW? Because your desktop copy of 
Outlook also syncs with the server, whatever 
is synchronized to the server from your 
smartphone also shows up in Outlook; and 
whatever you enter or change in Outlook on 
your computer syncs to the server and then 
shows up on your smartphone.
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1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right softkey) and 
select Add Server Source. 

4 Enter the server address. Check the 
This server requires an encrypted 

(SSL) connection box if your server 
uses an encrypted connection.

5 Press Next  (right softkey).

6 Enter the username and password you 
use to access your corporate mail 
server, and enter the Exchange server 
domain.

NOTE You can’t see your password as you 
enter it, so be careful. Be sure Caps Lock 
and Option Lock are not on unless you 
need them. For info on how to enter 
characters, see Entering lowercase and 
uppercase letters and Entering numbers, 
punctuation, and symbols.

TIP If you installed ActiveSync desktop 
software on a Windows XP computer, you 
may have already set up your smartphone to 
synchronize wirelessly with the server. To 
check, press Start, select Programs, and 
then select ActiveSync. Press Menu (right 
softkey). If Configure Server appears instead 
of Add Server Source, wireless sync is already 
set up, and you can skip this procedure.

TIP The Exchange server settings are case- 
sensitive. Be sure to enter uppercase and 
lowercase letters properly.
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7 Check the Save password box.

8 (Optional) Select Advanced to set the 
rules for fixing sync conflicts.

9 Press Next  (right softkey) and 
check the boxes for the types of 
information you want to synchronize 
with the Exchange server.

10 (Optional) Highlight an item and select 
Settings to change the synchronization 
settings for that type of information. 
Settings are not available for all items.

11 Press Finish  (right softkey). 
Synchronization with your Exchange 
server begins automatically. A status 
bar appears onscreen indicating sync 
progress.

You can set a schedule for synchronization 
to take place anytime info is updated on 
either your smartphone or the server or at 
certain intervals (see Setting the 
synchronization schedule), or allow 
synchronization to take place only when 
you initiate it manually (see Initiating a 
wireless sync manually).

TIP If you found out from your system 
administrator that it is not OK to store your 
corporate email password on your 
smartphone, don’t check the Save password 
box. You must synchronize manually (see 
Initiating a wireless sync manually).

TIP To automatically download more of an 
incoming email message than the default 
setting, select E-mail in step 10 and select a 
higher number from the Download size limit 
list. If you don’t increase this setting, you can 
manually download the rest of the message at 
your convenience.
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Setting the synchronization schedule

You can set a synchronization schedule in 
either of the following situations:

If you use Microsoft Exchange Server 

2007, or Microsoft Exchange Server 2003 

with Service Pack 2: By default, wireless 
sync takes place anytime info is updated 
on either your smartphone or the server 
using Microsoft Direct Push. To save 
battery life, however, you can set 
synchronization to take place at intervals 
that you specify.

If you use Microsoft Exchange Server 

2003 that is not upgraded to Service 

Pack 2: By default, wireless sync does not 
take place automatically. Set a 
synchronization schedule to have sync take 
place either anytime info is updated on 
your smartphone or the server, or at certain 
intervals.

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right softkey) and 
select Schedule. 

4 Set any of the following options:

Peak times: Sets the frequency for 
high-traffic time periods such as when 
you are at work or when email volume 
is high.

Off-peak times: Sets the frequency for 
low-traffic time periods such as late at 
night. 
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Use above settings when roaming: 
Sets the frequency while you are 
roaming outside Verizon Wireless’s 
network. By default, a scheduled sync 
does not work while you are roaming. 
This is to prevent roaming charges on 
your account. If roaming charges are not 
a concern, check this box.

Send/receive when I click Send: Sets 
whether items are sent as soon as you 
select Send in the Messaging 
application, or whether they are held 
until the next synchronization. 

5 Press OK .

Initiating a wireless sync manually

If you want to control exactly when a 
wireless sync takes place, or if it is not OK 
to store your corporate email password on 
your smartphone, you can initiate sync 
manually.

1 To set up manual sync, follow the 
preceding procedure, Setting the 
synchronization schedule. In the Peak 
times and Off-peak times lists, select 
Manually.

2 To initiate a manual sync, press 
Start  and select Programs.

3 Select ActiveSync .

4 Press Sync  (left softkey).

Other ways to 
synchronize

Synchronizing over a Bluetooth 

connection

You can synchronize your computer and 
smartphone using Bluetooth wireless 
technology.

BEFORE YOU BEGIN Make sure your 
computer is equipped with Bluetooth 
wireless technology and that the computer 
is set to be visible.

1 Do one of the following:

Windows XP: On your computer, 
double-click the ActiveSync  icon in 
the taskbar in the lower-right corner of 
the screen. In the ActiveSync window, 
select File, and then select Connection 

Settings.
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Windows Vista: Click Start > All 

Programs > Windows Mobile Device 

Center. Select Connect without 

setting up your device, and then 
select Connection settings.

2 Check the Allow connections to one 

of the following box, and then select 
Bluetooth.

3 On your smartphone, press Start  
and select Settings.

4 Select the Connections tab, and then 
select Bluetooth .

5 Select the Mode tab and check the Turn 

on Bluetooth box.

6 Press Start  and select Programs.

7 Select ActiveSync .

8 Press Menu  (right softkey) and 
select Connect via Bluetooth.

9 If this is the first time you’re making a 
Bluetooth connection to this computer, 
follow the onscreen prompts to set up a 
Bluetooth partnership with this 
computer. See Connecting to devices 
with Bluetooth® wireless technology 
for more information on partnerships.

10 Select Sync.

11 When synchronization has finished, 
press Menu  (right softkey) and 
select Disconnect Bluetooth.

Synchronizing over an infrared 

connection

If your computer has an IR (infrared) port, 
you can synchronize with your computer 
wirelessly using the IR port on your 
smartphone.

BEFORE YOU BEGIN

• Make sure your computer is equipped 
with an IR port.

• Turn on the feature to receive beamed 
information on your smartphone (see 
Turning on the option to receive 
beamed information).

1 Set up your computer to receive 
infrared beams. See ActiveSync Help on 
your computer for details.

2 Point the IR port directly on your 
smartphone at your computer’s IR port.

3 On your smartphone, press Start  
and select Programs.

4 Select ActiveSync .
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5 Press Menu  (right softkey) and 
select Connect via IR.

6 Select Sync.

Synchronizing with two computers

You can set up your smartphone to 
synchronize with up to two computers as 
well as with Exchange Server 2003 or 2007. 
When synchronizing with multiple 
computers, the items that you synchronize 
appear on all the computers.

For example, if you set up to sync your 
smartphone with two computers named 
C1 and C2, when you sync Contacts and 
Calendar on your smartphone with both 
computers, you get the following results:

• The contacts and calendar 
appointments that were on C1 are now 
also on C2.

• The contacts and calendar 
appointments that were on C2 are now 
also on C1.

• The contacts and calendar 
appointments from both computers are 
on your smartphone.

NOTE You can synchronize email in a 
Microsoft® Office Outlook® E-mail account 
on your smartphone with only one 
computer.

Setting 
synchronization 
options

Changing which applications sync

You must select sync options if you want to 
synchronize notes, pictures, and other 
types of files.

1 Press Start  and select Programs.

2 Select ActiveSync . 
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3 Press Menu  (right softkey) and 
select Options.

4 Do any of the following: 

• Check the box next to any items you 
want to synchronize. If you cannot 
check a box, you might have to 
uncheck a box for the same 
information type elsewhere in the list. 

• Uncheck the box next to any items 
you want to stop synchronizing. 

• Highlight an item and select Settings 
to customize the settings for that 
item. Settings are not available for all 
items.

Stopping synchronization

If you ever need to manually stop 
synchronization, follow these steps:

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Stop  (left softkey).

TIP For detailed information on synchronizing 
Word documents, Excel spreadsheets, and 
PowerPoint presentations, see Synchronizing 
your Microsoft Office files. For detailed 
information on synchronizing pictures, videos, 
and music files, see Synchronizing your media 
files  For information on changing email sync 
options, see Changing email download 
settings: Outlook email accounts or Changing 
email download settings: Other email 
accounts.

TIP To end the sync relationship between your 
smartphone and a computer so that items are 
no longer synchronized with that computer, 
select the computer name on the ActiveSync 
screen on your smartphone, and then select 
Delete.
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6

Your email
You already know how efficient email is for staying in touch. 
Now your Palm® Treo™ 700wx smartphone brings you a new 
level of convenience: email on the go. Enjoy the ease and 
speed of communicating with friends, family, and colleagues 
anywhere you can access the Verizon Wireless data network.

You can send photos to your friends and family, or create 
Microsoft Word or Excel files and send them to your 
colleagues. You can also receive attachments to view and edit 
at your convenience.

Benefits

• Receive photos, sound files, Word 
and Excel files, and more

• Attach and send files of almost 
any type

• Save messages from your 
computer to view at a convenient 
time
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Setting up email

You can use the Messaging application to 
send and receive email. Before you use 
your smartphone to send or receive 
messages, consult Verizon Wireless for 
pricing and availability of email services and 
data rate plans.

BEFORE YOU BEGIN

• Make sure your phone is on and you’re 
inside a coverage area before you send 
or receive messages.

• If you want delivery of Outlook email 
using Microsoft Direct Push, make sure 
that the IT organization of your company 
uses Exchange Server 2007, or 
Exchange Server 2003 with Service 
Pack 2.

Entering settings for an email account

DID YOU KNOW? You can enter settings for 
more than one email account; and you can 
use different email setup applications on your 
smartphone to enter settings for different 
accounts, depending on which app best 
meets your needs.
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Email account type Type of email you can access How to set up

POP/IMAP You can obtain email from an 
ISP or Internet email account 
such as EarthLink, or from a 
small business or corporate 
Internet email account.

See Setting up a POP/IMAP 
account in the Messaging 
application: Common email 
providers or Setting up a POP/
IMAP account in the 
Messaging application: Other 
email providers.

Microsoft Exchange 
server

You can retrieve corporate 
email using a Microsoft 
Exchange server. You can 
access email wirelessly if your 
company is using Microsoft 
Exchange ActiveSync®.

See Setting up wireless 
synchronization.

You may need to check with 
your IT organization to ensure 
that Exchange ActiveSync® is 
supported and to obtain the 
configuration settings.

Wireless Sync You can sync your email and 
other information when you’re 
away from your computer.

See Setting up a Wireless Sync 
email account.

Free web-based 
email

You can access mail from 
Yahoo!, Hotmail, and other free 
web-based systems.

Access the email website 
directly using your 
smartphone’s web browser.
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Where can I learn more?

• For help setting up an email account, go 
to: palm.com/emailsetup.

• For help with email account concepts, 
go to: kb.palm.com and enter 41456 as 
the solution id.

• For email settings for common ISPs, go 
to: kb.palm.com and enter 41727 as the 
solution id.

Setting up a POP/IMAP account in the 

Messaging application: Common email 

providers

Follow this procedure if you have a 
common email provider such as AOL, 
Yahoo!, or EarthLink. If you are setting up 
the Messaging application to work with 
your corporate email account, or you have a 
less common email provider, see Setting 
up a POP/IMAP account in the Messaging 
application: Other email providers.

BEFORE YOU BEGIN Ask your email 
provider or system administrator for your 
account username and password if you 
don’t know them.

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Select New E-mail Account.

4 Enter your email address. Check the box 
to have the setup process get your 
account settings from the Internet.

5 Press Next  (right softkey).

http://www.palm.com/emailsetup
http://kb.palm.com
http://kb.palm.com
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6 If the setup process finds your account 
settings, press Next  (right 
softkey).

If the setup process does not find your 
account settings, see Setting up a POP/
IMAP account in the Messaging 
application: Other email providers and 
continue with step 7 of that procedure.

7 Enter your name and, if you want, 
change your account display name to 
something meaningful. For example, if 
this is your work email account, you can 
change the display name to Work or 
your company’s name.

8 Press Next  (right softkey).

9 Verify or enter your account username, 
and enter your password.

10 If you want your password entered 
automatically, check the Save 

password box. If you want to enter 
your password each time you access 
this account, do not check this box.

11 Press Next  (right softkey).

12 (Optional) Select either of the following:

DID YOU KNOW? Checking the Save password 
box makes it easier to check your email, 
because you don’t have to enter your 
password each time. Leaving the box 
unchecked keeps your email more secure, 
because no one can download messages 
without entering your password.
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Automatic Send/Receive: Change the 
time interval for automatically 
downloading email, from every 5 
minutes to once a day. If you do not 
want to automatically download 
messages, select Manually.

Review all download settings: Select 
this option to change download 
settings; see Changing email download 
settings: Outlook email accounts or 
Changing email download settings: 
Other email accounts for information.

13 Press Finish  (right softkey). If 
prompted, select OK to download 
messages for this account now.

Setting up a POP/IMAP account in the 

Messaging application: Other email 

providers

You can set up an account in the 
Messaging application to send and receive 
email messages using an email account 
that you have with an Internet service 
provider (ISP), an email account that you 
access using a VPN server connection 
(such as a work account; see Connecting to 
a VPN), or any other IMAP or POP email 
account.

BEFORE YOU BEGIN Work with your 
email provider or system administrator to 
gather the following info:

• Account type (POP3 or IMAP)

• Mail server name for receiving mail

• Your username and password

• Any special security requirements

• Password security: Found out whether 
it’s OK to store your corporate email 
password on your smartphone

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Select New E-mail Account.

4 Enter your email address. Check the box 
if you want the setup process to try to 
get your account settings from the 
Internet.
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5 Press Next  (right softkey).

6 If you did not check the box in step 4 or 
the setup process does not find account 
settings, press Next  (right 
softkey).

If you did check the box and the account 
setup process finds your account 
settings, go to Setting up a POP/IMAP 
account in the Messaging application: 
Common email providers and continue 
with step 7 of that procedure.

7 If prompted, select either of the 
following as your email provider:

Internet e-mail: Select this option if you 
access email from any type of email 
account except a corporate account that 
uses an Exchange mail server.

Exchange server: Select this option if 
you access email from a corporate 
email account using an Exchange 
server.

8 Press Next  (right softkey).

9 Enter your name and, if you want, 
change your account display name to 
something meaningful. For example, if 
this is your work email account, you can 
change the display name to Work or 
your company’s name.
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10 Press Next  (right softkey).

11 Enter the name of the incoming mail 
server.

12 Select the Account type list, and then 
select POP3 or IMAP.

13 Press Next  (right softkey).

14 Enter your account username and 
password.

15 If you want your password entered 
automatically, check the Save 

password box. If you want to enter 
your password each time you access 
this account, do not check this box. 

16 Press Next  (right softkey).

17 If you receive an alert indicating that 
Verizon Wireless has already 
customized the outgoing mail server 
settings, press OK  to close the alert, 
and then press Next  (right 
softkey) on the outgoing mail server 
settings screen. Do not enter or change 
anything on the screen.

If you do not receive an alert, go to 
Entering outgoing server settings. 

TIP If you found out from your system 
administrator that it is not OK to store your 
corporate email password on your 
smartphone, don’t check the Save password 
box.

TIP If you do not receive an alert, and if your 
incoming mail requires SSL, you set that 
option with the outgoing server settings. See 
Entering outgoing server settings and check 
the Require SSL for Incoming e-mail box on 
the Advanced Server Settings screen.
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18 (Optional) Select either of the following:

Automatic Send/Receive: Change the 
time interval for automatically 
downloading email, from every 5 
minutes to once a day. If you do not 
want to automatically download 
messages, select Manually.

Review all download settings: Select 
this option to change download 
settings; see Changing email download 
settings: Outlook email accounts or 
Changing email download settings: 
Other email accounts for information.

19 Press Finish  (right softkey). If 
prompted, select OK to download 
messages for this account now.

Entering outgoing server settings

If, during account setup, you do not receive 
an alert saying that Verizon Wireless has 
set the outgoing mail options, you need to 
manually enter these settings.

BEFORE YOU BEGIN Work with your 
email provider or system administrator to 
gather the following info:

• Mail server name for sending mail

• Any special security requirements

DID YOU KNOW? On the Accounts tab in 
Messaging Options, an asterisk appears next 
to the account you most recently created.

TIP To delete an email account or to edit 
account settings—for example, if you need to 
change the name of the outgoing mail 
server—press Menu (right softkey) and select 
Tools > Options. To delete an account, 
highlight the account you want, press and 
hold Center on the 5-way, and then select 
Delete. (To delete an Outlook Email account, 
use the ActiveSync application, not the 
Messaging application.) To edit an account, 
select the account and go through the 
screens to change the settings you want to 
edit.
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1 On the screen for entering outgoing 
mail settings, select the correct settings 
for the following:

Outgoing (SMTP) mail server: Enter 
the server name.

Outgoing server requires 

authentication: Check the box if your 
outgoing mail server requires 
authentication.

Use the same user name and 

password for sending e-mail: Check 
the box if the server requires you to use 
your account username and password 
when sending email.

2 Select Advanced Server Settings, and 
then select the correct settings for any 
of the following:

Require SSL for Incoming e-mail: 

Check the box if your account requires 
SSL for incoming messages.

Require SSL for Outgoing e-mail: 
Check the box if your account requires 
SSL for outgoing messages.

Network connection: Select the type 
of connection to use for sending and 
receiving email.

3 Press Done  (left softkey). On the 
outgoing mail server screen, press 
Next  (right softkey).
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4 (Optional) Select either of the following:

Automatic Send/Receive: Change the 
time interval for automatically 
downloading email, from every 5 
minutes to once a day. If you do not 
want to automatically download 
messages, select Manually.

Review all download settings: Select 
this option to change download 
settings; see Changing email download 
settings: Outlook email accounts or 
Changing email download settings: 
Other email accounts for information.

5 Press Finish  (right softkey). If 
prompted, select OK to download 
messages for this account now.

Setting up a Wireless Sync email account

Wireless Sync is an email application from 
Verizon Wireless that lets you sync your 
email and other information when you’re 
away from your computer. The setup steps 
for a Wireless Sync account are different 
depending on whether your company has a 
Wireless Sync server.

Setting up a Wireless Sync email account 

if your company does not have a Wireless 

Sync server

BEFORE YOU BEGIN

• To use Wireless Sync, you must 
subscribe to the Wireless Sync feature 
from Verizon Wireless (additional 
charges may apply). 

• If you are accessing a corporate email 
account, you must install the desktop 
synchronization software that came 
with your smartphone (see Installing 
ActiveSync desktop software: 
Windows XP or Installing Windows 
Mobile Device Center: Windows Vista). 
You do not need to install the desktop 

TIP For more info about Wireless Sync, visit 
wirelesssync.vzw.com.

http://www.wirelesssync.vzw.com
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sync software if you are accessing an 
Internet email account such as Yahoo! 
or Gmail.

• Make sure your phone is on and that 
you’re inside a coverage area.

1 Press Start  and select Programs.

2 Select Wireless Sync .

3 Press Start  (left softkey). Wait a 
few minutes until your smartphone 
resets and the installation has finished.

4 Leave the My company has its own 

Wireless Sync server box unchecked, 
and press Next  (left softkey).

5 Do one of the following:

If you have a Wireless Sync 

password: Press Yes  (left 
softkey).

If you do not have a Wireless Sync 

password: Press Menu  (right 
softkey) and select No. Follow the 
onscreen instructions to create a 
password.

If you have forgotten your Wireless 

Sync password: Press Menu  
(right softkey) and select Forgot. Follow 

the onscreen instructions to retrieve 
your password.

6 Enter or confirm your mobile phone 
number. Enter your Wireless Sync 
password.

7 Check the I agree to the terms and 

conditions of service box, and then 
press Next  (left softkey). 

8 Select your time zone and enter your zip 
code, and then press Done  (left 
softkey).

9 Select the type of email account(s) you 
want to set up: Internet or Corporate. 
Enter your email address and the 
password you use to access this email 
account on your computer. Press 
Next  (left softkey).

10 For corporate accounts, if you have not 
already done so, install the desktop 
synchronization software that came 
with your smartphone (see Installing 
ActiveSync desktop software: 
Windows XP or Installing Windows 
Mobile Device Center: Windows Vista).

11 When the Congratulations! screen 
appears, press Done  (left 
softkey).
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12 When the First Synchronization dialog 
box appears, select one of the 
following:

Refresh: Replaces any existing email, 
contact, and calendar information on 
your smartphone with information for 
the account you just set up.

Merge: Merges any existing email, 
contact, and calendar information on 
your smartphone with information for 
the account you just set up.

Setting up a Wireless Sync email account 

if your company has a Wireless Sync 

server

BEFORE YOU BEGIN

• Check with your system administrator 
to find the correct format for your 
username and password, as well as 
whether a domain name is required to 
access email.

• Make sure your phone is on and that 
you’re inside a coverage area.

1 Press Start  and select Programs.

2 Select Wireless Sync .

3 Press Start  (left softkey). Wait a 
few minutes until your smartphone 
resets and the installation has finished.

4 Check the My company has its own 

Wireless Sync server box, and press 
Next  (left softkey).

5 Enter the server name and press 
Next  (left softkey).

6 Enter your account username and 
password, using the format provided by 
your system administrator. If required, 
enter the domain name also.

TIP For corporate email accounts, the default 
settings automatically synchronize wirelessly 
whenever info changes in Microsoft® Office 
Outlook®. To find out how often you can 
expect message delivery, contact your system 
administrator and ask about your company’s 
server settings. For Internet email accounts, 
the default settings automatically synchronize 
wirelessly every 30 minutes. To customize 
your Wireless Sync settings, select Settings 
on the Wireless Sync screen, and then select 
When to Sync.
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7 Check the I agree to the terms and 

conditions of service box, and then 
press Next  (left softkey). 

8 Select your time zone and enter your zip 
code, and then press Done  (left 
softkey).

9 When the Congratulations! screen 
appears, press Done  (left 
softkey).

10 When the First Synchronization dialog 
box appears, select one of the 
following:

Refresh: Replaces any existing email, 
contact, and calendar information on 
your smartphone with information for 
the account you just set up.

Merge: Merges any existing email, 
contact, and calendar information on 
your smartphone with information for 
the account you just set up.

Sending and 
receiving messages

Selecting which email account to use

If you set up more than one email account 
on your smartphone (see Setting up email), 
you can select the account you want to use 
to view or send messages in one of two 
ways:

• By default, when you open the 
Messaging application, a list of all of 
your email accounts appears. Select the 
account you want.

TIP For corporate email accounts, the default 
settings automatically synchronize wirelessly 
whenever info changes in Microsoft® Office 
Outlook®. To find out how often you can 
expect message delivery, contact your system 
administrator and ask about your company’s 
server settings. For Internet email accounts, 
the default settings automatically synchronize 
wirelessly every 30 minutes. To customize 
your Wireless Sync settings, select Settings 
on the Wireless Sync screen, and then select 
When to Sync.
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• If you turn off the option to display the 
list of accounts (see Customizing your 
email settings), when you open the 
Messaging application, the last account 
you were using is displayed. Press 
Left  or Right  to cycle through your 
accounts until the name of the account 
you want appears in the title bar.

Creating and sending an email message

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Select the email account you want to 
use to send a message.

4 Press Menu  (right softkey) and 
select New.

5 Enter the recipient’s email address. 
Here are some shortcuts:

• If the recipient’s name and email 
address are in your Contacts list, 
enter the first few letters of the 
recipient’s first name, last name, or 
email address, and then select the 
recipient’s name.

• If the recipient’s name is in an online 
address book, you can find the name 
and add it. See Using an online 
address book.

TIP Also press Left or Right to switch to a 
different account after you are finished 
working in the first account you selected.

DID YOU KNOW? You can also access the 
Messaging application from the Start menu.
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6 Select Subject and enter a title for the 
message.

7 Press Down  to go to the body of the 
message. Enter your message, or press 
Menu  (right softkey), select My 

Text, and then select a predefined 
phrase you want to insert.

8 (Optional) To attach an item to the 
message, press Menu  (right 
softkey) and select Insert. Select the 
type of item you want to attach, 
and then select the file or record a 
voice note.

9 (Optional) Press Menu  (right 
softkey) and do one or both of the 
following:

• Select Spell Check. When the spell 
check is complete, press OK .

• Select Message Options. Select the 
Priority list, select a priority setting 
for the message, and then press 
OK .

10 Press Send  (left softkey).

Receiving email messages

How you receive email messages depends 
on the type of account you are using and 
how you synchronize:

• If you synchronize wirelessly with your 
Exchange server using Microsoft 
Exchange ActiveSync, new email 
messages are sent to your smartphone 
when they appear on the server, 
according to the schedule you set up 

DID YOU KNOW? When addressing a message, 
you can enter the contact’s first and last 
initials separated by a space.

TIP To address a message to multiple 
recipients, separate the addresses by 
pressing Return or entering a semicolon (;).

TIP You can send an email message with a file 
attached from directly within other 
applications on your smartphone; see Sending 
email messages from within another 
application

TIP To save memory on your smartphone, turn 
off the option to save sent messages in the 
Saved folder. In the Inbox, press Menu (right 
softkey) and select Tools > Options. Select 
the Message tab, and then uncheck the Keep 

copies of sent items in Sent folder box.



Y O U R  E M A I L

S E N D I N G  A N D  R E C E I V I N G  M E S S A G E S116

6
C

H
A

P
T

E
R

(see Setting the synchronization 
schedule), or when you manually initiate 
a sync (see Initiating a wireless sync 
manually.

• If you use desktop sync software to 
synchronize your smartphone with your 
computer, messages in Outlook on your 
computer are transferred to your 
smartphone when you connect your 
computer and your smartphone (see 
Connecting your smartphone to your 
computer).

• For all other types of accounts, 
including ISP accounts and accounts 

you access using a VPN server 
connection (typically a work account; 
see Connecting to a VPN), message 
retrieval depends on the option you 
chose from the Automatic Send/
Receive list during account setup (see 
Setting up a POP/IMAP account in the 
Messaging application: Common email 
providers or Setting up a POP/IMAP 
account in the Messaging application: 
Other email providers), as follows:

If you chose a time interval: Your 
smartphone automatically checks for 
and downloads new messages 
according to that interval.

If you chose Manually: Follow these 
steps to send and receive messages:

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Select the email account containing the 
messages you want to view.

4 Press Menu  (right softkey) and 
select Send/Receive to synchronize 
your smartphone with your email 
server.

TIP If you sync email with Microsoft Exchange 
Server 2003 or 2007, you can synchronize 
messages in subfolders you create. In the 
Inbox, press Menu (right softkey) and select 
Tools > Manage Folders. Folders containing 
subfolders display a +. Select the + to view 
the subfolders. Check the box to the left of 
any subfolder you want to sync.

TIP If you synchronize email with Microsoft 
Exchange Server 2007, and you receive a 
message containing a link to a document on 
SharePoint or an internal file server, you can 
view the document by selecting the link.
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Receiving attachments

If you synchronize email with Exchange 
Server 2007, attachments are downloaded 
automatically when you download a 
message. Simply select the attachment 
name to open it. If you do not synchronize 
email with Exchange Server 2003, follow 
these steps to download attachments.

1 Scroll to the attachment name (below 
the subject) to highlight it. This marks it 
for download.

2 Synchronize the email account that 
contains the message, as described in 
the previous sections.

3 Scroll to and select the attachment 
name (below the subject) to open the 
attachment.

If you are synchronizing with Outlook on 
your computer and want to download 
attachments automatically, do the 
following:

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right softkey) and 
select Options.

4 Select E-mail, and then select 
Settings.

5 Check the Include file 

attachments box.

6 (Optional) To automatically download 
attachments up to a certain size only, 

TIP Partially downloaded messages appear in 
the message list with a partial envelope icon 
to the left of the subject. To view the full 
message, either press Menu (right softkey) 
and select Download Message, or open the 
message and select Get the rest of this 

message.

DID YOU KNOW? You can view messages sent 
as HTML with the HTML formatting intact.

DID YOU KNOW? You can receive and open 
attachments in a number of different formats, 
including PDF. PDF file attachments open in 
PDF Viewer on your smartphone (see PDF 
Viewer).

TIP To store attachments on an expansion 
card, insert the card into your smartphone’s 
expansion card slot, press Menu (right 
softkey) and select Tools > Options. Select 
Storage and check the When available, use 

this storage card to store attachments box.
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check the Only if smaller than box and 
enter the maximum attachment size.

7 Press OK .

To automatically download attachments 
from an IMAP4 email account (typically an 
ISP account) or an account that you access 
using a VPN server connection (typically a 
work account; see Connecting to a VPN), 
do the following:

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Do one of the following:

• If the account list is displayed, press 
Menu  (right softkey) and select 
Options.

• If the message list for a specific 
account is displayed, press 
Menu  (right softkey) and select 
Tools > Options.

4 On the Accounts tab, select the IMAP4 
account name. 

5 Press Next  (right softkey) until 
you reach Server information, and then 
select Options. 

6 Press Next twice, and then select 
either Get full copy of messages and 
When getting full copy, get 

attachments or Entire message, 
depending on the option displayed.

Working with email 
messages

Adding a contact from an email message

You can add a contact name or email 
address to your Contacts list directly from 
the To, cc, or bcc field of an email 
message. You can select the name or 
address from either an outgoing or an 
incoming message, and you can either 
create a new contact or add the 
information to an existing contact.

1 In an open message, highlight the 
name or address of the contact you 
want to add.

2 Press Center .

3 Press Save  (left softkey).

DID YOU KNOW? Embedded images and objects 
cannot be received as attachments, unless 
you have an IMAP4 email account with TNEF 
disabled. Note that TNEF must be enabled to 
receive meeting requests.
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4 Select <New Contact> to create a new 
contact entry for this name or address, 
or select an existing contact to add the 
name or address to that entry.

5 Enter or edit the contact information.

6 Press Save  (left softkey).

Adding an online address book

Many email servers, including servers 
running Exchange Server, can verify names 
with an online address book, also called a 
directory service or a Global Address List. 
After you create and enable an email 
account, the Messaging application checks 
your contacts list and then the directory 
service to verify names that you enter in 
the To, cc, and bcc fields.

BEFORE YOU BEGIN Do the following:

• Ask your system administrator for the 
name of the directory service and the 
server, and whether authentication is 
required for accessing an online address 
book.

• If your company is using Exchange 
Server 2007, or Exchange Server 2003 
upgraded to Service Pack 2, you must 
first synchronize with the Exchange 
server to enable the Global Address List 
to find a contact.

1 In the message list, press Menu  
(right softkey) and select Tools > 
Options.

2 Select the Address tab.

3 Select the address book you want to 
check for email addresses, and then 
select Add.

4 Enter the name of the directory service.

5 Enter the server name.

6 If your server requires authentication, 
check the box and enter your username 
and password.
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7 (Optional) Check the Check name 

against this server box to enable this 
directory service.

8 Select OK.

Using an online address book

You can access contact information, such 
as an email address or phone number, from 
your organization’s online address book or 
Global Address List (GAL). To access a 
GAL, make sure you are accessing either 
Exchange Server 2007, or Exchange Server 
2003 upgraded to Service Pack 2. This 
feature is useful only if you know the exact 
name as it appears in the directory.

BEFORE YOU BEGIN Add access to an 
online address book to your smartphone 
(see Adding an online address book).

1 In a new message, select the To field.
2 Press Menu  (right softkey) and 

select Add Recipient.
3 Press Menu  (right softkey) and 

select Company Directory.
4 Enter the contact name as it appears in 

the directory and press Find  (left 
softkey). You must spell the contact 
name correctly.

TIP To delete a directory service, highlight it, 
press and hold Center on the 5-way, and 
select Delete.

DID YOU KNOW? You can use the Global 
Address List to find a contact. In Contacts, 
press Menu (right softkey) and select 
Company Directory. When sending a 
meeting request, select Attendees, press 
Menu (right softkey), and then select 
Company Directory.

TIP When you sync with Outlook on your 
computer, disable your online address books 
to avoid errors. Press Menu (right softkey) and 
select Tools > Options. Select Address, 
select each online address book, and then 
uncheck the Check name against this server 
box. Be sure to turn this option back on if you 
synchronize other email accounts.
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Finding messages

You can find messages containing a 
specific word or phrase. The find feature 
searches names, email addresses, and 
subject lines.

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Select the account you want.
4 Begin typing the word or phrase you 

want to find. The list display changes to 
show only those messages containing 
the letters you have entered.

5 Continue entering letters to narrow the 
display until the message you want 
appears.

Replying to a message

1 Open the message to which you want 
to reply.

2 Press Reply  (left softkey).
3 Address the message and enter any 

text you want to add.

4 (Optional) Select Edit sender’s 

message to edit the original sender’s 
message text that you include in your 
reply.

5 Press Send  (left softkey).

Forwarding a message

1 Open the message you want to 
forward.

2 Press Menu  (right softkey) and 
select Reply > Forward.

3 Address the message and enter any 
text you want to add.

4 Press Send  (left softkey).

Deleting messages

You can delete a message you are reading, 
or you can delete one or more messages 
from the message list.

DID YOU KNOW? If you synchronize with 
Microsoft Outlook 2007, you can also find 
messages stored on your mail server.

DID YOU KNOW? If you reply to a message sent 
as HTML, the reply is sent in HTML also.

TIP To reply to both the sender and all other 
addressees, open the message, press Menu 
(right softkey), and then select Reply > Reply 
All.
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To delete a message you are reading:

• Press Menu  (right softkey) and 
select Delete.

To delete messages from the message list:

1 Highlight the message(s) you want to 
delete. To highlight multiple messages, 
tap and drag the stylus across the 
messages in the list.

2 Press Delete  (left softkey).

3 Select Yes to confirm the deletion.

Using email shortcuts

You can perform common email tasks by 
pressing and holding certain keys on the 
keyboard. Highlight the message you want, 
and then press and hold any of the 
following:

Adding a signature to your messages

You can use a different signature with each 
email account.

1 Go to your Today screen.

2 Press Messaging  (left softkey).

Press and 

hold… To…

H View all email shortcuts

A Reply to the sender of a 
message and all other 
addressees

R Reply to the sender only

K Mark a message read or 
unread

F Flag a message

M Move a message between 
folders

O Forward a message

D Delete a message

L Fully download a partially 
downloaded message

S Synchronize your 
smartphone with the server 
to get and send new 
messages

Press and 

hold… To…
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3 Do one of the following:

If the account list is displayed: Press 
Menu  (right softkey) and select 
Options.

If the message list for a specific 

account is displayed: Press 
Menu  (right softkey) and select 
Tools > Options.

4 On the Accounts tab, select 
Signatures.

5 Select the account for which you want 
to create a signature.

6 Check the Use signature with this 

account box to add this signature to 
new messages you create with this 
account.

7 (Optional) Check the Use when 

replying and forwarding box to add 
this signature to messages you reply to 
or forward with this account.

8 Highlight the text Enter a signature 

here and enter the signature text you 
want to use.

9 Press OK .

Customizing your 
email settings

Customizing general email settings

When you customize settings for an email 
account, the options you choose apply to 
that account only.

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Do one of the following:

If the account list is displayed: Press 
Menu  (right softkey) and select 
Options.

If the message list for a specific 

account is displayed: Press 
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Menu  (right softkey) and select 
Tools > Options.

4 On the Accounts tab, set any of the 
following options:

Security: Allows you to specify 
whether you receive a warning 
message before you open a URL or file 
link that is not on your smartphone.

Display account picker when opening 

Messaging: Specifies whether a list of 
your email accounts appears when you 
open the Messaging application, 
allowing you to select the one you want 
to use. If the box is unchecked, the 
Messaging application opens to the last 
account you used.

5 Select the Message tab and set any of 
the following options:

When replying to e-mail, include 

body: Indicates whether the body of a 
message you received appears in your 
response to that message.

Keep copies of sent items in Sent 

folder: Indicates whether messages 
you send are stored in the Sent folder.

TIP If the Display account picker when 

opening Messaging box is unchecked, 
repeatedly press Left or Right on the 5-way 
after you open the Messaging application to 
cycle through your accounts.
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Warn when deleting messages in the 

message list: Specifies whether a 
confirmation message appears when 
you delete one or more messages from 
the message list.

After deleting or moving a message: 
Specifies what you want to see after 
you delete or move an email message 
you are reading: the account Inbox or 
the next message.

6 Select the Address tab and set any of 
the following options:

In Contacts, get e-mail addresses 

from: Indicates whether you want to 
check Contacts in addition to any 
directory services for email addresses.

Check names using these address 

books: Indicates which directory 
services you want to check for email 
addresses.

Add: Enables you to add directory 
services to the list of online address 
books.

7 Select the Storage tab and set any of 
the following options:

When available, use this storage card 

to store attachments: Indicates 
whether you want to automatically 
store email attachments on an 
expansion card (sold separately). You 
must have a card inserted in your 
smartphone’s expansion card slot to 
select this option.
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Empty deleted items: Select 
Immediately to have the Deleted folder 
emptied anytime you delete a message. 
Select On connect/disconnect to have 
the folder deleted anytime you open or 
quit the Messaging application. Select 
Manually to manually empty the 
Deleted folder.

8 Press OK .

Changing email download settings: 

Outlook email accounts

You can customize the download options 
for an Outlook email account you 
synchronize with your computer or with an 
Exchange server.

NOTE To change options for other types of 
email accounts, see Changing email 
download settings: Other email accounts.

1 Press Start , select Programs.

2 Select ActiveSync .

3 Press Menu  (right softkey) and 
select Options.

4 Under your sync method (Microsoft 
Exchange or Windows PC), highlight 
E-mail and select Settings.

5 Select any of the following options:

Download the past: Specifies the 
number of days’ worth of email to be 
retrieved for each automatic or manual 
sync.

Message format: Specifies the format 
for sending and receiving messages. If 
you select HTML, messages sent to you 
as HTML are received with their 
formatting intact. If you select Plain 
Text, all messages are received as plain 
text.

TIP If you choose to manually empty the 
Deleted folder, you delete messages from this 
folder in the same way that you delete any 
other messages (see Deleting messages). 
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Download size limit: Specifies the size 
of an incoming message that is 
automatically downloaded. For any 
message that exceeds this size, you 
must manually download the rest of the 
message. Selecting a higher limit 
means more of your messages are fully 
downloaded, but message retrieval 
might take longer. You can also choose 
to download message headers only, 
regardless of size.

Include file attachments: Specifies 
whether to download attached files with 
a message.

Only if smaller than: Specifies the 
maximum size of attachments that can 
be downloaded. If an attachment 
exceeds the maximum size, you must 
download it manually (see Receiving 
attachments).

6 (Optional) Select Advanced, and then 
select any of the following options:

Encrypt all outgoing e-mail 

messages: Specifies whether 
downloaded messages should be 
encrypted for extra security.

Sign all outgoing e-mail messages: 
Specifies whether messages should be 
given a digital signature as an extra 
security measure.

Choose Certificate: Specifies the 
certificate to use as a digital signature.

My e-mail addresses: Indicates the 
addresses to which the security 
measures should be applied.

7 Press OK .
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Changing email download settings: Other 

email accounts

You can customize the download options 
for each email account that you have with 
an Internet service provider (ISP) or that 
you access using a VPN server connection 
(typically a work account).

NOTE To change options for a Microsoft 
Office Outlook account, see Changing 
email download settings: Outlook email 
accounts.

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Do one of the following:

If the account list is displayed: Press 
Menu  (right softkey) and select 
Options.

If the message list for a specific 

account is displayed: Press 
Menu  (right softkey) and select 
Tools > Options.

4 Select the email account you want. 

5 Press Next  (right softkey) until 
the following screen is displayed.

6 Select either of the following:

Automatic Send/Receive: Specifies 
the time interval for automatically 
downloading email, from every 5 
minutes to once a day. If you do not 
want to automatically download 
messages, select Manually.

Download messages: Specifies the 
number of days’ worth of email to be 
retrieved for each automatic or manual 
retrieval.

TIP To save memory, limit the number of 
emails that are downloaded to your 
smartphone by selecting a smaller time 
interval for how many days’ worth of 
messages are downloaded.
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7 Select Advanced Settings, and then 
select any of the following:

Send/receive when I click Send: 

Specifies whether you can manually 
send and receive messages, in addition 
to automatically downloading them.

Use automatic send/receive schedule 

when roaming: Specifies whether 
automatic downloading takes place 
when you are roaming. This may result 
in higher connection charges than 
downloading while in your home 
network.

When deleting messages: Specifies 
whether messages should be deleted 
from the mail server when you delete 
them on your smartphone, or whether 
messages you delete on your 
smartphone should remain on the 
server.

8 Press Done  (left softkey).

9 Press Next  (right softkey).

10 Select either of the following:

Message format: Specifies the format 
for sending and receiving messages. If 
you select HTML, messages sent to you 
as HTML are received with their 
formatting intact. If you select Plain 
Text, all messages are received as 
plain text.
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Message download limit: Specifies 
the size of an incoming message that is 
automatically downloaded. For any 
message that exceeds this size, you 
must manually download the rest of the 
message. Selecting a higher limit 
means more of your messages are fully 
downloaded, but message retrieval 
might take longer. You can also choose 
to download message headers only, 
regardless of size.

11 Press Finish  (right softkey).

Working with 
meeting invitations

You can receive meeting invitations on your 
smartphone in the same way that you 
receive email messages. 

NOTE Use the Calendar application to 
create meeting invitations on your 
smartphone; see Sending a meeting 
request.

Here are the key features of meeting 
invitations:

• Meeting invitations appear on your 
smartphone in the Messaging 
application, not in the Calendar 
application.

• From within the Messaging application, 
you can accept, decline, or tentatively 
accept a meeting invitation.

• If you accept an invitation, the meeting 
shows up as an appointment in the 
Calendar application.

• You can reply to and forward meeting 
invitations in the same way as email 
messages.

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Select the account you want.

4 Select a meeting invitation to open it. 
Meeting invitations are displayed with 
this icon: .

DID YOU KNOW? Messages sent to you as plain 
text are always received as plain text, even if 
you select HTML.
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5 To accept the invitation, press 
Accept  (left softkey), select 
whether to edit (include comments 
with) your response, and then 
select OK.

To decline or tentatively accept the 
invitation, press Menu  (right 
softkey) and select Decline or 
Tentative.

Sending email 
messages from 
within another 
application

You can send files such as pictures, videos, 
and ringtones as attachments to email 
messages (see Creating and sending an 
email message).

You can send certain files as attachments 
from within the application where the file is 
created or stored. For example, if you take 
a picture with the built-in camera on your 
smartphone, you can select an option to 
send the picture as an attachment to an 
email message. You can also use this 
feature with videos and sound files. For 
details, see the chapter on the specific 
application.

TIP If you receive an updated meeting 
invitation, you can again choose to accept, 
decline, or tentatively accept. If you receive a 
meeting cancellation, you don’t need to do 
anything.
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CHAPTER

7

Your text and multimedia 
messages
If you need to get a short message to a friend or a colleague 
fast, send a text message from your Palm® Treo™ 700wx 
smartphone to their mobile phone or email address.

If you need more than text to express yourself, use multimedia 
messaging to give your message extra impact by adding a 
photo, video, or sound file.

Benefits

• Enjoy quick communication

• Use text messaging to chat with 
friends

• Be as simple or as creative as you 
want



In this chapter
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Sending and 
receiving text and 
multimedia 
messages

You can use the Messaging application to 
send and receive brief text messages 
(SMS) and multimedia messages (MMS).

Creating and sending a text message

Each text message can have up to 160 
characters. Write the message yourself or 
save time by using predefined My Text 
phrases, such as “Call me” or “On my 
way.” You can also create your own 
predefined phrases and add them to My 
Text.

BEFORE YOU BEGIN

• Before you use your smartphone to 
send or receive messages, consult 
Verizon Wireless for pricing and 
availability of text and multimedia 
messaging services.

• Make sure that your phone is on and 
that you’re inside a coverage area (see 
Turning your phone on).

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Select Text Messages.

4 Press Menu  (right softkey) and 
select New.

5 Enter the recipient’s name, mobile 
phone number, or email address. Here 
are some shortcuts:

DID YOU KNOW? You can send and receive text 
messages even while you are on a phone call. 
This is easiest when using a hands-free 
headset or the speakerphone.
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• If the recipient’s name and mobile 
number are in your Contacts list, type 
the first few letters of the first or last 
name or simply enter the first initial, 
followed by a space, and then the last 
initial to find a name. 

• Press Center  to view a list of 
recently used addresses, and select 
the recipient from the list. Select Add 

Recipient to add a recipient from your 
Contacts list.

• If the recipient’s name is in an online 
address book, press Center , 
enter the name, press Menu  
(right softkey), and then select 
Company Directory. Select the 
name, and then select either the 
phone number or the email address. 
For more information, see Using an 
online address book.

• If the recipient’s name and mobile 
number are not in your Contacts list, 
enter the full mobile number or email 
address.

6 Enter your message, or press 
Menu  (right softkey), select My 

Text, and then select a predefined 
phrase you want to insert. 

7 (Optional) Press Menu  (right 
softkey) and select Spell Check.

8 Press Send  (left softkey).

TIP To address a message to multiple 
recipients, separate the addresses by 
pressing Return or entering a semicolon (;). 
You can send a message to up to 20 
addresses.

TIP To send a message to a different number 
for a contact, select the contact in the To field, 
and then edit the number that appears in the 
box directly below the contact number. You 
can also select a number by pressing Center 
on the 5-way, and then edit it.

TIP To add a new My Text phrase, select Edit 

My Text Messages in the list.

TIP Some symbols can’t be used in text 
messages. Invalid characters are automatically 
replaced by the Messaging application.
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Creating and sending a multimedia 

message

Multimedia messages consist of pictures, 
videos, text, and sounds presented as one 
or more slides. You can include any of the 
following items:

Ringtones

• MIDI

Sound clips

• AMR

• QCELP

Pictures

• JPEG

• GIF

• WBMP

Videos

• 3GPP

• 3GPP2

• MPEG4

BEFORE YOU BEGIN

• Before you use your smartphone to 
send or receive messages, consult 
Verizon Wireless for pricing and 
availability of text and multimedia 
messaging services.

• Make sure that your phone is on and 
that you’re inside a coverage area (see 
Turning your phone on).

1 Go to your Today screen.

2 Press Messaging  (left softkey).

3 Select MMS.

4 Press Menu  (right softkey) and 
select New.
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5 Enter the recipient’s mobile phone 
number or email address. Here are 
some shortcuts:

• If the recipient’s name and mobile 
number are in your Contacts list, type 
the first few letters of the first or last 
name or simply enter the first initial, 
followed by a space, and then the last 
initial to find a name.

• Press Center  to view a list of 
recently used addresses, and select 
the recipient from the list. Select Add 

Recipient to add a recipient from your 
Contacts list.

• If the recipient’s name is in an online 
address book, press Center , 
enter the name, press Menu  
(right softkey), and then select 
Company Directory. Select the 
name, and then select either the 
phone number or the email address. 
For more information, see Using an 
online address book.

• If the recipient’s name and mobile 
number are not in your Contacts list, 
enter the full mobile number or email 
address.

6 Select Subject and enter a title for the 
message.

7 Select New Slide.

8 Select Add Picture/Video, and then 
select one of the following:

Add Picture: Lets you insert a picture. 
You can take the picture with the built-in 
camera or insert an existing picture.

Add Video: Lets you insert a video. You 
can capture a video with the built-in 
camera or insert an existing video clip. If 
you insert a video, you cannot add any 
more pictures, videos, or sounds to that 
message.

Add Sound: Lets you record a 
message, such as a voice caption for a 
picture, or insert an existing sound, such 
as a ringtone. You can add one sound 
per slide; to send more than one sound 
in a message, add another slide to your 
message. If you capture a picture with 
the built-in camera and save it with a 
voice caption, the voice caption does 
not count as a sound file. 

9 Select Add Text and enter a text 
caption or message for the item you 
inserted.
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10 Tap Next  and repeat steps 8–9 to 
add other items in this message.

11 (Optional) Tap Preview  to view the 
message as the recipient will see it.

12 After you finish creating the message, 
press OK .

13 Press Send  (left softkey).

Receiving text and multimedia messages

When your phone is on and you are in a 
wireless coverage area, you automatically 
receive new text messages. For 
multimedia messages, you can set your 
smartphone to automatically download 
new messages or to notify you that 
messages are ready to be downloaded. 

You can also set your smartphone to notify 
you when a new text or multimedia 
message arrives.

The new message notification may include 
any of the following options:

View: Opens the message so you can 
view its full contents.

Download: Downloads the rest of the 
message from the server. 

Reply: Opens a message addressed to the 
sender’s phone number.

Dismiss: Closes the notification and puts 
the message in your Inbox.

Menu: Opens a menu where you can 
select other options.

TIP To add a new My Text phrase, select Edit 

My Text Messages in the list. 

DID YOU KNOW? A multimedia message can 
contain up to 350KB and can consist of multi-
ple items (up to 16 slides). 

TIP While creating a message, select the 
arrows at the bottom of the screen to move 
between slides.

DID YOU KNOW? Message notifications include 
the message text unless you have turned on 
privacy mode (see Customizing text 
messages). If privacy mode is on, the 
notification states only the type of incoming 
message.
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If you have multiple messages, the 
notification includes the number of 
messages and the type (text or 
multimedia).

Viewing/playing a message

You can open a message from a 
notification or from the Inbox of the 
Messaging application. When you open a 
multimedia message, playback starts 
automatically.

1 Do one of the following to open the 
message:
• Press Start  and select 

Messaging. Select MMS. From the 
Inbox, select the message you want 
to view.

• From a notification, select View.

2 For a multimedia message, do any of 
the following:
Go the previous or next slide: Tap the 
previous  icon or the next  icon.

Pause or resume playback: Tap the 
pause  icon or the play  icon. 

Save the item that is playing: Press 
Menu  (right softkey) and 
select Save.

Go to the top of the message: Press 
Menu  (right softkey) and select 
Message Overview.

Reply to the message: Press Menu 
 (right softkey) and select Reply 

or Reply All.

Call the sender: Press Menu  
(right softkey) and select Call Sender.

Save the message as a template for 

other messages: Press Menu  
(right softkey) and select Save as 

Template.
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3 Press OK .

Sorting your messages

You can sort the messages in any folder by 
date or by sender.

1 Go to the Inbox or other folder you want 
to sort.

2 Press Menu  (right softkey) and 
select Sort by.

3 Select Message Type, From, Received, 
or Subject.

Deleting a single message

1 Go to the Inbox or other folder 
containing the message you want to 
delete.

2 Highlight the message.

3 Press Delete  (left softkey).

4 Select Yes to confirm the deletion.

Deleting multiple messages

1 Go to the Inbox or other folder 
containing the messages you want to 
delete.

2 Press Menu  (right softkey) and 
select Tools > Clear “Text Messages” 

or Tools > Clear “MMS.”

3 Select Yes to confirm the deletion.

DID YOU KNOW? When viewing a multimedia 
message containing multiple slides, you can 
press Right on the 5-way to move to the next 
slide, or press Left on the 5-way to move to 
the previous slide.



Y O U R  T E X T  A N D  M U L T I M E D I A  M E S S A G E S

S E T T I N G  M E S S A G E  P R E F E R E N C E S142

7
C

H
A

P
T

E
R

Setting message 
preferences

You can set options for both text and 
multimedia messages in the Messaging 
application. The settings you select apply 
to all your text or multimedia messages. 

Customizing text messages

1 Press Start  and select Messaging.

2 Press Menu  (right softkey) and 
select Options.

3 Select Text Messages.

4 Check the Request delivery 

notifications box to receive an alert 
when a text messages has been 
delivered.

5 Press OK .

Customizing multimedia messages

1 Press Start  and select Messaging.

2 Press Menu  (right softkey) and 
select Options.

3 Select MMS.
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4 Select either of the following options:

Automatically Collect Messages: 
Specifies that you want the Messaging 
application to automatically download 
multimedia messages. If the box is 
unchecked, you must manually 
download new incoming multimedia 
messages.

Confirm message deletion: Indicates 
whether you want to receive an alert 
confirming that you want to delete a 
multimedia message.

5 Press OK .
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CHAPTER

8

Your connections to the web 
and wireless devices
You use the web for so many things: finding driving directions, 
getting news, buying gifts, checking web-based email. Now, with 
the Verizon Wireless network and the web browser on your 
Palm® Treo™ 700wx smartphone, you can take the web with you 
almost anywhere you go.

The built-in Bluetooth® wireless technology on your smartphone 
helps you easily set up wireless connections to a number of 
devices, so you can enjoy the convenience of cable-free 
connectivity. You can also use your smartphone to connect your 
computer to the Internet and to share contacts or your favorite 
photos with other people.
Benefits

• Carry the web with you

• Store web pages for offline 
viewing

• Connect to Bluetooth headsets 
and car kits

• Connect your computer to the 
Internet through your smartphone
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Browsing the web

Internet Explorer Mobile provides quick and 
easy access to web pages. You can view 
most sites on your smartphone that you 
can view on your computer, including those 
with security and advanced features, such 
as JavaScript and frames.

Internet Explorer Mobile supports 
JavaScript, Secure Sockets Layer (SSL), 
and cookies, but does not support plug-ins 
(Flash, Shockwave, VBScript, WML script, 
and so on) or Java applets.

BEFORE YOU BEGIN Do the following:

• Be sure to subscribe to data services 
from Verizon Wireless. This is 
necessary for browsing the web.

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

Viewing a web page

By default, Internet Explorer Mobile scales 
web page content to fit your smartphone 
screen so that you can view most of the 
information without scrolling left or right.

1 Press Start  and select Internet 

Explorer.

2 Highlight the address line, enter the 
address of the web page you want to 
view, and then press Center . To 
return to a recently viewed page, select 
the address line list, and then select the 
web address.

DID YOU KNOW? The security certificates and 
128-bit SSL strong encryption enable you to 
browse secure sites for tasks such as online 
shopping, banking, and email. Remember, 
some secure sites also require a specific 
browser and may not work with Internet 
Explorer Mobile. Ask the organization for an 
alternate access point that is compatible with 
Internet Explorer Mobile.

DID YOU KNOW? You can also start a web 
search from your Today screen by selecting 
the Web search field, entering the item you 
want to find, and then pressing Center on the 
5-way.
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3 Press Menu  (right softkey), 
select View, and then select one of the 
following:

One Column: Arranges web pages into 
one column that is as wide as the 
screen, so that you don’t have to scroll 
horizontally.

Fit To Screen: Maintains a layout similar 
to what you see on a desktop computer, 
but makes items smaller and arranges 
the content so that you can see most of 
it without scrolling horizontally.

Desktop: Keeps the same layout and 
size as on a desktop computer, which 
requires both horizontal and vertical 
scrolling.

Full Screen: Hides the status and 
navigation areas and fills the entire 
screen with the web page. To exit full 
screen mode, press  (right 
softkey), or tap and hold anywhere on 
the screen and uncheck Full Screen.

Show Pictures: Shows or hides 
pictures on web pages. Hiding pictures 
speeds up the time it takes to load 
pages.

Navigating web pages

Here are some tips on viewing web pages 
and moving around in them:

• To view the previous page, press 
Back  (left softkey) or 
Backspace .

• To refresh the page with the latest 
content from the Internet, press 
Menu  (right softkey) and select 
Refresh.

DID YOU KNOW? If you browse to a secure web 
page, the lock icon in the address line appears 
closed instead of open.
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• To scroll through the page in One 
Column View or Default View, press 
Up  or Down . In Desktop View, 
press Up , Down  Left , or 
Right  to scroll in all directions.

• To follow a link to another web page 
press Up  or Down  to highlight 
the link, and then press Center  to 
go to the selected page. You can also 
tap the link on the screen with the 
stylus.

• To send email from a web page, 
select the address link. You need to 
configure an email application on your 
smartphone before you can use this 
feature (see Your email).

• To adjust the size of the text on web 
pages, press Menu  (right 
softkey), select View > Text Size, and 
then select the size you want.

• To view a web page’s properties, 
press Menu  (right softkey) and 
select Tools > Properties.

• To view each item in a list, select the 
list and scroll using Up  or 
Down .

• In a list, press Left  or Right  to 
cycle between items, and then press 
Center  to accept the change.

• In a form, such as a browser search 
field, press Center  to interact 
with the form, and then press Center 

 to stop interacting with the form.

4 Press OK  to close Internet Explorer 
Mobile.

Creating a favorite

Favorites let you bookmark a web page so 
that you can instantly access it without 
entering the web address.

BEFORE YOU BEGIN Create the folders 
where you want to store your favorites 
first. After you create a favorite, you can’t 
move it to another folder (see Organizing 
your favorites).

TIP To send a link, press Menu (right softkey) 
and select Tools > Send Link. Select the 
option you want to use to send the link: SMS 
(text message), MMS (multimedia message), 
or an email account.



Y O U R  C O N N E C T I O N S  T O  T H E  W E B  A N D  W I R E L E S S  D E V I C E S

B R O W S I N G  T H E  W E B150

8
C

H
A

P
T

E
R

1 Go to the page you want to mark as 
a favorite.

2 Press Menu  (right softkey) and 
select Add to Favorites.

3 (Optional) Select Name and enter a 
different description.

4 (Optional) Select Create in, and then 
select the folder where you want to 
store the favorite.

5 Select Add.

Viewing a favorite

1 Press Start  and select Internet 

Explorer.

2 Press Menu  (right softkey) and 
select Favorites.

3 Select the page you want to view in 
the list.

Organizing your favorites

You can create folders to organize your 
favorites. For example, you can store travel 
links in one folder, stock links in another, 
and business links in a third folder.

1 Press Start  and select Internet 

Explorer.

2 Press Menu  (right softkey) and 
select Favorites.

3 Select the Add/Delete tab.

4 Select New Folder.

5 Enter a name for this folder, and then 
select Add.

6 Press OK .

TIP To delete a favorite or folder, press Menu 
(right softkey) and select Favorites. Select the 
Add/Delete tab, highlight the item you want 
to delete, and then select Delete. Select Yes 
to confirm deletion and press OK.
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Downloading files and images from a 

web page

You can download files that are usable on 
your smartphone, such as new 
applications, MIDI ringtones, or pictures.

1 Go to the page that contains the link to 
the file you want to download.

2 Do either of the following:

To download a file: Press Left  or 
Right  to highlight the link to the file. 
Press Center , and then select Save 

As.

To download an image: Tap and hold 
on the image, select Save Image, and 
then select Save As.

3 Select Name and enter a new name for 
the file.

4 Select the Folder list, and then select 
the folder where you want to save the 
file.

5 Select the Location list, and then select 
where you want to store the file: Main 

memory or Storage card. The Storage 
card option appears only if you have an 
expansion card (sold separately) 
inserted into your smartphone.

6 Press OK .

Copying text from a web page

You can copy text from a web page and 
paste it in other applications.

1 Use the stylus to highlight the text you 
want to copy.

2 Press Menu  (right softkey) and 
select Edit > Copy.

DID YOU KNOW? You can select the Downloads 
favorite to access the Verizon Wireless 
downloads page.

TIP You can copy the text from the entire web 
page. Tap and hold on the page, and then tap 
Select All Text. Tap and hold on the page 
again, and then tap Copy.
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3 Go to the application in which you want 
to paste, and then position the cursor 
where you want to paste the text.

4 Press Menu  (right softkey) and 
select Edit > Paste.

Returning to recently viewed pages

The History list stores the addresses of the 
pages you visited recently.

1 Press Menu  (right softkey) and 
select History.

2 (Optional) Tap the Show list in the 
upper-left, and then select how you 
want to sort the History list.

3 Select the web page you want to view.

Customizing your Internet Explorer 

Mobile settings

1 Press Menu  (right softkey) and 
select Tools > Options.

2 On the General tab, set any of the 
following options:

Home page: Sets the page that 
appears when you open Internet 
Explorer Mobile. To use the page you 
were on when you opened the menu, 
select Use Current. To select the 
original home page, select Use Default.

Encoding: Sets the character set for 
the web pages you view.

TIP If Internet Explorer Mobile does not 
recognize a phone number as dialable, you 
can copy the phone number (as text) and 
paste it into the phone Dial Pad.
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3 Select the Memory tab and set any of 
the following options:

Save links to pages visited in the 

past: Sets how many days of activity 
the History list stores.

Clear History: Empties the History list.

Delete Files: Removes web files that 
you previously viewed synchronized 
with your computer.

4 Select the Security tab and set any of 
the following options:

Allow cookies: Sets whether your 
smartphone accepts cookies (small files 
containing info about your identity and 
preferences). The page sends the file 
and stores it on your smartphone.

Clear Cookies: Deletes any cookies 
stored on your smartphone.

Warn when changing to a page that 

is not secure: Sets whether a message 
appears when you switch from a secure 
page to one that is not secure.

Warn when page content is blocked 

due to security settings: Sets whether 
a message appears when you attempt 
to open a page that does not meet the 
security standards associated with your 
smartphone.

5 Press OK .
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Connecting to 
devices with 
Bluetooth® 
wireless technology

With the Bluetooth® wireless technology 
on your smartphone, you can connect to a 
number of Bluetooth devices such as a 
headset or hands-free car kit, as well as to 
other phones, handhelds, or piconets. 
When you connect to another device, you 
create a partnership (also referred to by 
terms such as trusted pair, trusted device, 
or pairing) with that device. If your 
computer is enabled with Bluetooth 
wireless technology, you can also 
synchronize wirelessly or use your phone 
as a wireless modem.

You can create a list of Bluetooth devices 
that you trust to communicate with your 
smartphone. When communicating with 
trusted devices, your smartphone skips the 
discovery process and creates a secure 
link as long as the device is within range. 
Bluetooth range is up to about 30 feet 
(10 meters) in ideal conditions. 
Performance and range are affected by 
physical obstacles, radio interference from 
nearby electronic equipment, and other 
factors.

When you configure a headset (see 
Connecting to a Bluetooth® hands-free 
device), the headset is automatically added 
to your trusted device list. Follow the 
steps in this section to add other devices, 
such as your computer, to your trusted 
device list.

KEY TERM Partnership Two devices—for 
example, your smartphone and a hands-free 
device—that can connect because each 
device finds the same passkey on the other 
device. After you form a partnership with a 
device, you don’t need to enter a passkey to 
connect with that device again.

DID YOU KNOW? Check your battery level before 
establishing a Bluetooth connection. If the 
battery level is low, you can’t make a 
Bluetooth connection.
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Entering basic Bluetooth settings

1 Go to your Today screen and tap 
Bluetooth .

2 Select the Mode tab and check the Turn 

on Bluetooth box.

3 Check or uncheck the Make the device 

visible to other devices box.

Check this box to allow Bluetooth 
devices that are not on your Trusted 
Device list to request a connection with 
your device. Your device remains 
accessible to other devices until you 
uncheck the box.

The Bluetooth status icon

The Bluetooth icon on your Today screen 
indicates the status of the Bluetooth 
feature:

Requesting a connection with another 

Bluetooth device

1 Go to your Today screen and tap 
Bluetooth .

2 Select the Mode tab and check the Turn 

on Bluetooth box.

 Bluetooth off

 Bluetooth on

 Connected to a Bluetooth device

 Call in progress with a Bluetooth 
headset or car kit
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3 Select the Devices tab, and then select 
Add new device.

4 Wait for your smartphone to search for 
devices and to display the device list.

5 Select the device with which you want 
to connect, and then press Next  
(right softkey).

6 Enter an alphanumeric passkey 
between 1 and 16 characters long, and 
then press Next  (right softkey).

IMPORTANT Some hands-free devices 
have a predefined passkey. If your device 
has a predefined passkey, you can find it in 
the documentation for that device. Other 
devices provide a screen where you enter 
a passkey that you make up. In either case, 
you must use the same passkey on both 
your smartphone and the other device. We 
recommend that where possible, you 
make up a passkey of 16 alphanumeric 
characters (letters and numerals only) to 
improve the security of your smartphone. 
The longer the passkey, the more difficult it 
is for the passkey to be deciphered.

7 If the passkey is not built-in, enter the 
same passkey on the other Bluetooth 
device.

8 (Optional) Check the box next to any 
service for which you want to use your 
other Bluetooth device.

9 Press Finish  (right softkey).

10 Press OK .
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You can now communicate with this device 
whenever it is within range and the 
Bluetooth feature on your smartphone is 
turned on. The range varies greatly 
depending on environmental factors. The 
maximum is about 30 feet (10 meters).

Accepting a connection from another 

Bluetooth device 

1 Go to your Today screen and tap 
Bluetooth .

2 Select the Mode tab and check the Turn 

on Bluetooth box.

3 If you have already set up a partnership 
with the transmitting device, your 
smartphone is ready to receive the info. 
Skip to step 8.

If you haven’t set up a connection, 
check the Make this device visible to 

other devices box to let the device find 
your smartphone and request a 
connection.

4 When prompted to add this device, 
select Yes.

5 Enter the same passkey on your 
smartphone and on the Bluetooth 
device.

6 (Optional) To give the partnership a 
more meaningful name, select Display 

Name and enter a new name.

7 Press Finish  (right softkey).

8 When your smartphone is receiving 
info, a notification tells you that a 
transmission is in progress. To stop the 
transmission, press Cancel  (right 
softkey). To close the notification, press 
Hide  (left softkey).

TIP To delete the established partnership with 
a device, go to the Bluetooth Settings screen 
and select the Devices tab. Highlight the 
connection you want to remove, press and 
hold Center on the 5-way, and then select 
Delete. Select Yes to confirm the deletion. 
The deleted device can no longer 
automatically connect with your smartphone.
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Using your device as 
a wireless modem 

Your smartphone’s data capabilities enable 
you to use your smartphone as a wireless 
modem for your laptop computer. Use this 
feature to send and receive email, browse 
the Internet, and access your company’s 
network if you do not have another Internet 
connection for your laptop—for example, 
when working remotely at airports and 
other locations.

You can use your device as a wireless 
modem in one of two ways:

• Connect your smartphone to your 
computer using the USB sync cable.

• If your computer is enabled with 
Bluetooth wireless technology, set up 
your smartphone as a wireless modem 
using the built-in Bluetooth technology.

BEFORE YOU BEGIN

• To use this service, you must have 
access to a wireless data network, and 
a separate data service plan may also 
be required. Contact Verizon Wireless 
for more information. 

• In addition, you must have a desktop 
application that supports this feature. 
Verizon Wireless may provide a 
dedicated software application, or visit 
the following web site for additional 
instructions from Palm: palm.com/us/
support/treo/treo700wxverizon/.

Preparing your smartphone for a wireless 

modem connection using a USB cable

1 On your smartphone, press Start  
and select Programs.

2 Select Modem Link .

http://palm.com/us/support/treo/treo700wxverizon/
http://palm.com/us/support/treo/treo700wxverizon/
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3 If an alert appears, press OK .

4 Select the Connection list, and then 
select USB. 

5 Press Activate  (left softkey).

6 After you have connected, on your 
computer, open your web browser to 
confirm that you can connect to the 
Internet.

Preparing your computer for a wireless 

modem connection using a USB cable

To complete the configuration and connect 
your laptop to the Internet using your 
smartphone, you must first install the 
VZAccess application from the Windows 
Mobile Getting Started CD. Insert the CD 
into your computer’s CD drive and select 
Add new programs to my desktop PC.

NOTE Palm does not support wireless 
modem connections on Mac OS X 
computers. Third-party solutions may be 
available, but these solutions are not 
supported by Palm.

Preparing your computer for a wireless 

modem connection using Bluetooth 

technology

BEFORE YOU BEGIN

• Make sure your smartphone is visible 
(see Entering basic Bluetooth settings).

• Create a partnership between your 
smartphone and your computer. We 
recommend that you initiate the 
partnership from your smartphone 
(see Requesting a connection with 
another Bluetooth device).

TIP You cannot sync your smartphone with 
your computer when Modem Link is 
activated. To deactivate Modem Link, 
complete steps 1–3 and press Deactivate. 

TIP If you’re using your smartphone as a wire-
less modem to connect to the Internet 
through a BroadbandAccess connection, the 
data connection is terminated whenever you 
receive or make a phone call.
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Bluetooth connectivity and setup varies 
from computer to computer based on your 
operating system version and the way your 
computer is enabled with Bluetooth 
technology.

The instructions that follow are general 
instructions for setting up a connection 
with a computer that has a Windows 
certified Bluetooth device and is running 
Windows XP SP2.

For instructions on setting up other 
operating systems or Bluetooth devices, 
see the documentation that came with the 
computer and the Bluetooth device.

1 On your computer, click Start and 
select Run.

2 Enter telephon.cpl, and then click OK.

3 On the Modems tab, click Add to open 
the Select Bluetooth Device dialog box. 

4 Select your smartphone from the list of 
devices to use as a modem. 

5 Click Start > Control Panel > Phone 

and Modem Options. 

6 Enter #777 as the phone number to dial.

7 (Optional) Create an Internet connection 
by clicking Start > Control Panel > 
Network Connections.

8 After you have connected, on your 
computer, open your web browser to 
confirm that you can connect to the 
Internet.
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Your photos, videos, and 
music
Do you have a wallet bulging with photos of friends, family, 
pets, and your most recent vacation?

Are you tired of carrying both your MP3 player and your phone? 

Your Palm® Treo™ 700wx smartphone solves both problems. 
You can keep your favorite photos—videos, too—right on your 
smartphone. And there’s no need to carry an expensive MP3 
player, because you can play music on your smartphone. 
Simply transfer songs onto your smartphone or an expansion 
card (sold separately) and then listen through your stereo 
headset.

Benefits

• Easily access your favorite people, 
places, and songs

• Arrange your photos, videos, and 
songs

• Avoid having to use a separate 
photo viewer, MP3, CD, or 
mini-disc player
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Synchronizing your 
media files

You can synchronize pictures, videos, and 
music files between your smartphone and 
your computer so that changes you make 
show up on both your computer and your 
smartphone. To synchronize media files, 
you must first choose Media as one of your 
synchronization options on your 
smartphone; see Changing which 
applications sync.

The procedure for synchronizing media 
files is different for computers running 
Windows XP and computers running 
Windows Vista.

Synchronizing media files: Windows XP

BEFORE YOU BEGIN You must install the 
current version of ActiveSync® desktop 
software from the Windows Mobile 
Getting Started CD (see Installing 
ActiveSync desktop software: 
Windows XP) and select the option to 
synchronize media on your smartphone 
(see Changing which applications sync).

When you synchronize your smartphone, 
your pictures and videos are synchronized 
between your smartphone and your 
desktop computer. On your computer, you 
can view the pictures and videos, and you 
can also send them to friends using your 
desktop email application.

To find all synchronized pictures and videos 
on your computer, look in C:\Documents 
and Settings\<Username>\My 
Documents\Treo My Documents.

You use Windows Media Player to 
synchronize music files; see Transferring 
media files to your smartphone.

Synchronizing media files: Windows Vista

BEFORE YOU BEGIN You must install 
Windows Mobile Device Center from the 
Windows Getting Started Disc (see 
Installing Windows Mobile Device Center: 
Windows Vista) and select the option to 
synchronize media on your smartphone 
(see Changing which applications sync).

On a computer running Windows Vista, 
you use Windows Media Player to 
synchronize all types of media files—
pictures, videos, and music files—that are 
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on your computer to your smartphone. See 
Transferring media files to your 
smartphone.

To synchronize pictures and videos from 
your smartphone to your computer, follow 
these steps:

1 Connect your smartphone to your 
computer with the USB sync cable.

2 On your computer, click Start > All 

Programs > Windows Mobile Device 

Center.

3 Select Connect without setting up 

your device.

4 Select Pictures, Music and Video.

5 Select X new pictures/video clips are 

available for import.

All new or changed pictures and videos on 
your smartphone are synchronized to your 
computer.

Camera

Your smartphone comes with an 
easy-to-use, built-in, 1.3 megapixel camera 
with 2x digital zoom. You can use the 
camera to take and view pictures and 
videos and send them to your friends and 
family. To add a personal touch to your 
smartphone, use your pictures as your 
Today screen background and as caller ID 
images (see Using a picture as the Today 
screen background and Adding a contact). 
You can even use your videos to create 
video ringtones (see Creating a video 
ringtone).

You can receive and view pictures and 
videos, and send pictures and videos as 
attachments or multimedia messages (see 
Pictures & Videos). Or add a picture to a 
contact (see Adding a contact). You can 
also move pictures and videos to a 
computer by synchronizing your 
smartphone with your computer (see 
Synchronizing your media files).
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Taking a picture

By default, pictures are stored in the My 
Pictures folder on your smartphone. If you 
want to store your pictures on an 
expansion card (sold separately), you can 
change where pictures are stored (see 
Customizing your Camera settings). For 
information on accessing your pictures on 
your Windows XP computer, see 
Synchronizing media files: Windows XP.

1 Press Start  and select Programs.

2 Select Camera .
 

3 Adjust the position of your smartphone 
until you see the subject you want to 
photograph on the screen. Your 
smartphone has a self-portrait mirror 
next to the camera lens on the back of 
your smartphone. Use the mirror when 
you want to be in the picture you’re 
taking.

DID YOU KNOW? Pictures are captured and 
stored in 16-bit color, JPG format. Resolution 
settings range from a low end of QQVGA 
(120 x 160 pixels) to a high end of 
1.3 megapixels (1280 x 1024 pixels). You can 
change the default setting. See Customizing 
your Camera settings for details.

TIP If you see a camcorder icon below the 
preview image, video mode is on. To turn on 
the still camera, press Menu (right softkey) 
and select Still. 
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4 (Optional) Adjust any of the following:

Zoom: Press Up  to zoom in or 
Down  to zoom out.

Resolution: Press Menu  (right 
softkey) and select Resolution to 
change the image quality.

5 (Optional) Set a five-second timer: Press 
Menu  (right softkey), select 
Mode, and then select Timer.

6 Press Center  to capture the picture 
or start the timer. Hold your smartphone 
still until the picture renders

7 Do one of the following:

• Press Camera  (left softkey) to 
take another picture.

• Press OK  and then press 
Thumbnails  (left softkey) to 
return to Thumbnail View.

Taking pictures in burst mode

Burst mode takes five pictures in quick 
succession, with one button press.

1 Press Start  and select Programs.

2 Select Camera .

3 Press Menu  (right softkey) and 
select Mode > Burst.

4 Press Center .

Recording a video

Videos can be any length, provided you 
have enough storage space available. By 
default, videos are stored in the My 
Pictures folder on your smartphone. If you 
want to store your videos on an expansion 
card (sold separately), see Customizing 
your Camera settings to change where 
videos are stored. For information on 
accessing your videos on your 
Windows XP computer, see Synchronizing 
media files: Windows XP.

DID YOU KNOW? After three minutes of 
inactivity when previewing an image, the 
camera goes into standby mode. Press any 
key or tap the screen to return to the image 
preview. 

DID YOU KNOW? Videos are captured and 
stored in 3GP format. Video resolution ranges 
from 176 x 144 pixels to 352 x 288 pixels.
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1 Press Start  and select Programs.

2 Select Camera .

3 Press Menu  (right softkey) and 
select Video.

4 Adjust the position of your smartphone 
until you see the subject you want to 
record on the screen. Your smartphone 
has a self-portrait mirror next to the 
camera lens on the back of your 
smartphone. Use the mirror when you 
want to be in the video you’re 
recording.

5 Press Menu  (right softkey) and 
select Quality to change the video 
resolution.

6 Press Menu  (right softkey) and 
select Brightness to change the 
brightness setting.

7 Press Center  to start recording.

8 When you have finished recording, 
press Stop  (left softkey) or 
Center  to stop recording.

9 (Optional) To review the video in 
Windows Media Player Mobile, press 
Thumbnails  (left softkey), 
highlight the video, and then press 
Center . Press OK  to return to 
Thumbnail View. 

Customizing your Camera settings

1 Press Start  and select Pictures & 

Videos.

2 Press Menu  (right softkey) and 
select Options.

TIP If you don’t like a video you recorded, 
delete it. See Deleting a picture or video for 
details.

DID YOU KNOW? After three minutes of 
inactivity when previewing an image, the 
camera goes into standby mode. Press any 
key or tap the screen to return to the image 
preview. If the camera goes to standby while 
the recording is paused, the video recording is 
stopped and the video is saved.
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3 On the General tab, set any of the 
following options:

Use this picture size: Sets the size of 
pictures you send with the Messaging 
application.

When rotating a picture, rotate 90 

degrees: Sets the direction in which 
pictures rotate.

4 Select the Slide Show tab, and set any 
of the following options:

During slide shows, optimize for 

viewing: Sets whether pictures are 
optimized for portrait or landscape 
format during slide shows.

Play screensaver when connected to 

my PC and idle for 2 minutes: Sets 
whether the pictures in your My 
Pictures folder are used as a 
screensaver when your smartphone is 
connected to your computer and 
ActiveSync® desktop software is not 
running.
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5 Select the Camera tab, and set any of 
the following options:

Type filename prefix: Assigns a name 
to a series of pictures to be captured, 
such as Seattle001, Seattle002, and 
so on.

Save files to: Specifies whether 
pictures and videos are stored on your 
smartphone or on an expansion card. 
The Storage card option appears only if 
you have an expansion card (sold 
separately) inserted into your 
smartphone.

Still image compression level: 
Sets the default quality and size for 
newly captured  still pictures.

6 Select the Video tab, and set any of the 
following options:

Include audio when recording video 

files: Turns the microphone on and off 
so that you can record videos with or 
without sound.

Time limit for videos: Limits the length 
of videos you record. You can select the 
No limit option.

7 Press OK  to return to 
Thumbnail View.
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Pictures & Videos

Viewing a picture

In addition to viewing the pictures you 
capture with the built-in camera, you can 
view pictures captured on many popular 
digital cameras or downloaded from the 
Internet. Your smartphone supports the 
following picture formats:

• JPG

• PNG

• BMP

• GIF

1 Press Start  and select Pictures & 

Videos.

2 Select the picture you want to view. 

3 Press OK  to return to Thumbnail 
View.

Viewing a video

In addition to viewing the videos you 
capture with the built-in camera, you can 
view videos captured on many popular 
digital cameras or streamed from 
websites. Your smartphone supports and 
streams the following types of video files:

• MPEG-4

• 3GPP2

• 3GPP

• WMV, WMA, ASF

• RTSP Streaming

1 Press Start  and select Pictures & 

Videos.

2 Select the video you want to view. For 
more info on viewing videos, see 
Playing media files on your smartphone.

3 Press OK  to return to Thumbnail 
View.

TIP To view pictures or videos in a different 
folder, tap the Show list in the upper-left, and 
then select the album you want to view.
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Viewing a slide show

1 Press Start  and select Pictures & 

Videos.

2 Press Menu  (right softkey) and 
select Play Slide Show. The slide show 
plays automatically.

3 Press Center  to display the slide 
show toolbar, which you can use to 
Rotate , Play , Pause , Reverse 

, Forward , and Stop  the slide 
show.

NOTE You must tap the onscreen slide 
show icons. You cannot select them with 
the 5-way.

Sending a picture or video

You can send a picture or video to other 
picture-enabled mobile devices or to an 
email address as an attachment.

You cannot send copyrighted pictures or 
videos that appear with a lock icon in 
Thumbnail View.

1 In Thumbnail View, highlight the picture 
or video you want to send.

2 Press Menu  (right softkey) and 
select Send.

3 Select the option you want to use to 
send the picture or video: an email 
account or MMS (multimedia message).

4 When the Messaging application opens, 
address and send the message 
(see Creating and sending an email 
message or Creating and sending a 
multimedia message).

Creating a video ringtone

You can save a video that you record as a 
ringtone.

1 In Thumbnail View, highlight the video 
you want to use as a ringtone.

2 Press Menu  (right softkey) and 
select Save to Contact Ring Tone.

3 Select the contact to whom you want to 
assign the ringtone.

TIP You can manually go forward or backward 
through slides by pressing Right or Left on 
the 5-way.
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Organizing pictures and videos

You can move or copy pictures and videos 
to other folders or between your 
smartphone and an expansion card (sold 
separately) inserted into your smartphone.

1 In Thumbnail View, highlight the picture 
or video you want to move or copy.

2 Do one of the following:

• To move the picture or video to 
another location, press Menu  
(right softkey) and select Edit > Cut.

• To keep the picture or video in two 
locations, press Menu  (right 
softkey) and select Edit > Copy.

3 Tap the Show list in the upper-left, and 
select the location where you want to 
place the picture or video.

4 Press Menu  (right softkey) and 
select Edit > Paste.

You can also view a specific folder or 
expansion card and arrange the pictures 
and videos by name, date, or size.

1 Tap the Show list in the upper-left, and 
then select the folder you want to view.

2 Tap the Sort By list in the upper-right, 
and then select the sort method: 
Name, Date, or Size.

Using a picture as the Today screen 

background

1 In Thumbnail View, highlight the picture 
you want to use.

2 Press Menu  (right softkey) and 
select Set as Today Background.

3 Select the Transparency level list and 
select the appropriate level. Use a 
higher percentage for a more 
transparent picture and a lower 
percentage for a more opaque picture.

4 Press OK  to return to Thumbnail 
View.

Editing a picture

For more extensive edits, just download 
your picture or video to your computer and 
edit it in your favorite graphics program. 
Then sync the picture or video back to your 
smartphone.
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1 In Thumbnail View, select the picture 
you want to edit.

2 Press Menu  (right softkey) and 
select Edit.

3 Do any of the following:

• To rotate the picture 90 degrees, 
press Rotate  (left softkey).

• To crop the picture, press 
Menu  (right softkey) and select 
Crop. Tap and drag the stylus to 
highlight the area to crop. Tap inside 
the box to crop the highlighted area. 
Tap outside the box to cancel 
cropping.

• To adjust the brightness and contrast 
levels of the picture, press Menu 

 (right softkey) and select 
AutoCorrect.

• To undo an edit, press Menu  
(right softkey) and select Undo.

• To cancel all unsaved edits you made 
to the picture, press Menu  
(right softkey) and select Revert to 

Saved.

• To save the edited picture with the 
same file name, press OK .

• To save the edited picture with a 
different file name, press 
Menu  (right softkey) and select 
Save As. Enter a new name for the 
file and press OK .

 Deleting a picture or video

1 In Thumbnail View, highlight the picture 
or video you want to delete.

2 Press Menu  (right softkey) and 
select Delete.

3 Select Yes to confirm the deletion.

Renaming a picture or video

1 In Thumbnail View, highlight the picture 
or video you want to delete.

2 Press Menu  (right softkey) and 
select Properties.

3 Enter a new name for the picture or 
video.

4 Press OK  to return to Thumbnail 
View.
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Windows Media 
Player Mobile

Windows Media Player Mobile can play 
music, audio, and video files that are 
stored on your smartphone or on an 
expansion card (sold separately) in any of 
the following file formats:

• WMA 

• WMV 

• MP3

• 3GP

IMPORTANT You must have QuickTime 
Player version 6.5 or later installed on your 
computer to play videos recorded by your 
smartphone. You can download the videos 
from an expansion card or you can click the 
video thumbnail after synchronizing the 
files.

You can listen to these music, audio, and 
video files through the speaker on the back 
of your smartphone or through the stereo 
headset.

Transferring media files to your 

smartphone

Use the Sync feature in the desktop 
version of Windows Media Player to 
transfer digital music, audio, video, and 
playlist files from your computer to an 
expansion card or your smartphone. Using 
the Sync feature ensures that the files are 
transferred correctly.

BEFORE YOU BEGIN Do the following:

• Be sure you have Windows Media 
Player 10 or later installed on your 
computer. 

Windows XP users: Windows Media 
Player 10 must be installed on your 
computer before you install ActiveSync 
desktop software. (If you are having 

DID YOU KNOW? You can also download 
animated GIF files and view them in Internet 
Explorer Mobile.

TIP For tips on using the desktop version of 
Windows Media Player, go to the Help menu 
in Windows Media Player on your computer.
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trouble, see My video and music files 
won’t sync.)

Windows Vista users: Version 11 of 
Windows Media Player is already 
installed and ready to use on your 
computer.

• To sync media files with your computer, 
set the Media sync option on your 
smartphone (see Setting 
synchronization options).

1 On your computer, open Windows 
Media Player.

2 (Optional) If you’re transferring media 
files to an expansion card, insert a 
32MB or larger expansion card into your 
smartphone.

3 Connect your smartphone to your 
computer with the USB sync cable.

4 Do one of the following:

Windows XP: When the Device Setup 
Wizard opens on your computer, 
click Automatic. Check the Customize 

the playlists that will be 

synchronized box.

Windows Vista: Select the Sync tab, 
and then select Treo > Set Up Sync. 
Check the Sync this device 

automatically box.

5 Select the playlists you want to sync. 
On a Windows Vista computer, select 
the All Photos and All Videos playlists 
to synchronize pictures and videos 
between your smartphone and your 
computer.

6 Click Finish to begin the transfer. If you 
are transferring files to an expansion 
card, be patient; transferring media files 
to an expansion card can take several 
minutes.

Playing media files on your smartphone

1 Press Start  and select Programs.

2 Select Windows Media .

3 If the Library screen is not displayed, 
press Menu  (right softkey) and 
select Library. 

4 Tap the Library list in the upper-left, and 
then select the library you want to use.
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5 Select the category containing the 
media file you want to play. Continue 
selecting categories until the list of 
individual items (videos, songs, albums, 
or artist names) appears.

6 Select the item you want to play (such 
as a song, album, or artist name).

7 Press Play  (left softkey). See the 
next section for playback controls.

8 Press Menu  (right softkey) and 
select any of the following during 
playback:

Library: Displays the Library screen so 
you can select a different media file to 
play.

Shuffle/Repeat > Shuffle: Plays the 
Now Playing playlist in random order. A 

checkmark appears next to this 
command when it is on.

Shuffle/Repeat > Repeat: Plays the 
Now Playing playlist repeatedly. A 
checkmark appears next to this 
command when it is on.

Stop: Ends playback.

Playback controls

Use any of the following onscreen controls 
during playback:

 or Center  plays the current file.

 or Center  pauses the current file.

 or Left  skips to the beginning of the 
current file or to the previous file.

 or Right  skips to the next file.

 sets the point from which playback 
begins. Tap and drag the slider to 
change the current position.

 or Volume button increases the 
volume level.

 or Volume button decreases the 
volume level.

 turns the sound on or off.

TIP  To play a file that is not in a library, go to 
the Library screen, press Menu (right softkey), 
and then select Open File.

TIP For more information on using libraries, 
see (Working with libraries).

TIP If you can’t find the item you want, update 
the library (see Working with libraries).
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 displays a video using the full 
screen.

 displays a website where you can 
find music and videos to play.

 indicates the rating of the current 
file. Select the star to change the rating.

Working with libraries

A library represents each of the storage 
locations available to Windows Media 
Player Mobile. If you have an expansion 
card (sold separately) inserted into your 
smartphone, you should have two libraries: 
My Device and My Storage Card. Each 
library contains links to the media files in 
that location. Windows Media Player 
Mobile usually updates the My Device 

library automatically, but you must 
manually update the My Storage Card 
library.

1 Press Start  and select Programs.

2 Select Windows Media .

3 If the Library screen is not displayed, 
press Menu  (right softkey) and 
select Library. 

4 Press Menu  (right softkey) and 
select Update Library.

5 Wait for the files to be added, and then 
press Done  (right softkey).

DID YOU KNOW? You can play streaming files 
from the web. To play a Microsoft Media 
Streaming (MMS) file, press Menu on the 
Library screen and select Open URL. Select 
URL and enter the website address, or select 
History and select a site you’ve visited 
before.

DID YOU KNOW? If you close the Windows 
Media Player Mobile window, your music 
continues to play in the background.

TIP If you don’t see a media file that you 
added, manually update the library.

TIP To delete an item from a library, highlight 
the item and then press and hold Center on 
the 5-way to open the shortcut menu. Select 
Delete from Library, and then select Yes to 
confirm the deletion.

DID YOU KNOW? If you move files between your 
smartphone and an expansion card, be sure to 
update your libraries, or you won’t be able to 
see the files in their new location.
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Working with playlists

A playlist is a list of media files that play in 
a specific order. You can use playlists to 
group audio files or video files together for 
convenient playback. For example, in the 
desktop Windows Media Player, you can 
create a playlist of upbeat songs for when 
you exercise and a playlist of soothing 
songs for a long flight. When you 
synchronize, your favorite playlists are 
automatically copied to your smartphone. 
Your playlists appear in your libraries (in the 
My Playlists category).

A temporary playlist, called Now Playing, 
appears on the Now Playing menu. It lists 
the currently playing file, as well as any 
files that are queued up to play next. You 
can add to, modify, or clear the files on the 
Now Playing playlist.

1 Go to the Now Playing screen:

• If you are on the Library screen, 
select the Now Playing category.

• If you are on the Playback screen, 
select Now Playing.

2 Do any of the following:

• To move a file up or down one slot, 
highlight the file and select 
Move Up  or Move Down .

• To add a file, highlight the file, select 
Add , press Menu  (right 
softkey), and then select Queue Up.

• To delete a file from the playlist, 
highlight the file and select 
Remove .

TIP You can also move a file in the Now 
Playing playlist by tapping and dragging it to a 
new position.
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• To view more info about a file, 
highlight the file and select 
Properties .

• To remove all items from the Now 
Playing playlist, press Menu  
(right softkey) and select Clear Now 

Playing.

Customizing Windows Media Player 

Mobile

1 If you are on any screen other than the 
Playback screen, press OK  to go to 
the Playback screen.

2 Press Menu  (right softkey) and 
select Options.

3 On the Playback tab, set any of the 
following options:

Show time as: Sets whether the time 
remaining or time elapsed appears in 
the Playback screen.

Pause playback while using another 

program: Sets whether playback 
continues if you switch to another 
application.

Resume playback after a phone call: 

Sets whether playback continues after 
you finish a phone call.

4 Select the Video tab and set any of the 
following options:

Play video in full screen: Sets whether 
videos automatically play in full screen 
format.

Scale to fit window: Sets whether 
videos are automatically scaled to fit the 
Playback screen.

5 Select the Network tab and set the 
following options:

Protocol: Enables and disables the 
available protocols. You must select at 
least one protocol. You can also set a 
UDP port.
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Internet connection speed: Specifies 
the speed of your network connection, 
and specifies whether you want the 
device to detect connection speed.

6 Select the Library tab and set whether 
you want to see the Library or the 
Playback screen when you open 
Windows Media Player Mobile.

7 Select the Skins tab and select 
Previous or Next to set the player’s 
background.

8 Select the Buttons tab to change any of 
the available button settings:

• To assign a button, highlight the item 
you want to set, select Assign, and 
then press the button you want to use 
for that item.

• To restore an item’s factory setting, 
highlight the item and select Reset.

• To unassign an item, highlight the 
item and select None.

9 Press OK .
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Your personal information 
organizer
Say good-bye to paper calendars and throw away those 
scribbled to-do lists. Your Palm® Treo™ 700wx smartphone is all 
you need to organize your personal information and keep it with 
you wherever you go.

You never lose your information, even if your battery is 
completely drained. All your personal information is backed up 
each time you synchronize, and your information is kept private 
when you use the security features available on your 
smartphone. Also, you can easily share info with others 
electronically.

Benefits

• Track current, future, and past 
appointments

• Make to-do lists that get done

• Set reminders for appointments, 
birthdays, important tasks, and 
more
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Contacts

Adding a contact

1 Press Start  and select Contacts.

2 Press New  (left softkey).

3 Use the 5-way  to move between 
fields as you enter information.

Here are some helpful tips for entering 
info:

• To enter complete name or address 
(work, home, or other) information, 
tap the arrow on the right side of the 
line and enter the information in the 
box that appears. When finished, tap 
outside the box to accept the 
information and close the box.

• To add a caller ID picture that displays 
when that person calls, select 
Picture, and then select Camera and 
take a picture, or select an existing 
picture from Thumbnail View.

TIP Take some time to scroll down through all 
the fields in a new contact. There are fields for 
multiple addresses, phone numbers, email 
addresses, and much more.

TIP Be sure to enter mobile numbers and 
email addresses in the correct fields so that 
Messaging can find this info when you 
address a message and Calendar can find your 
contacts when you want to invite them to 
meetings.
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• To assign a ringtone to the entry, 
select Ring tone and select a tone.

• To assign the entry to one or more 
categories, select Categories and 
then check the categories under 
which you want this entry to appear. 
To add a new category, press 
New  (left softkey), enter the 
category name, and then press 
OK .

4 To add a note to an entry, select the 
Notes tab.

5 After you enter all the information, 
press OK .

Viewing or changing contact information

1 In the Contacts list, begin entering any 
combination of letters from the 
contact’s first and/or last name. If you 
use both first- and last-name letters, 
separate them by a space.

You can type letters from the last name 
first. For example, entering SM finds 
both Smilla Anderson and John Smith. 
Entering SM AN finds both Smilla 
Anderson and Ann Smith.

2 To view a contact entry, select it. To edit 
a contact entry, highlight the contact 
name and continue with step 3.

3 Press Menu  (right softkey) and 
select Edit.

4 Make changes to the entry as 
necessary.

5 Press OK .

DID YOU KNOW? When you select a contact 
entry, you are presented with several options 
for contacting the person, depending on what 
information you have entered for the contact. 
For example, you may see options for calling a 
number associated with the contact, sending 
an email to the contact’s email address, or 
calling the last number you dialed to call the 
contact.

DID YOU KNOW? You can find a contact by 
company name. On the Contacts list screen, 
press Menu (right softkey) and select View 

By > Company. Select a company name to 
see the contacts who work there.

TIP To view a particular group of contacts, 
press Menu (right softkey), select Filter, and 
then select the category you want to view.
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Deleting a contact

1 In the Contacts list, highlight the 
contact you want to delete.

2 Press Menu  (right softkey) and 
select Delete Contact.

3 Select Yes to confirm the deletion.

Customizing Contacts

1 Go to the Contacts list.

2 Press Menu  (right softkey) and 
select Options.

3 Set any of the following options:

Show alphabetical index: Displays the 
alphabet at the top of the Contacts list. 
You can use this index to find a contact.

Show contact names only: Enables 
you to display more names on the 
Contacts list by hiding everything but 
the contact’s name.

Area code: Specifies the default area 
code for new contact entries.

4 Press OK .

Finding a contact in an online address 

book

In addition to having contacts on your 
device, you can also access contact 
information from your organization’s online 
address book or Global Address List (GAL).

BEFORE YOU BEGIN Do the following:

• Make sure you are accessing Exchange 
Server 2007, or Exchange Server 2003 
upgraded to Service Pack 2.

• Add access to the online address book 
to your smartphone. See Adding an 
online address book.

• After adding the online address book, 
synchronize with the Exchange server 
so that the Company Directory option 
appears.

1 Press Start  and select Contacts.

2 Press Menu  (right softkey), 
select Company Directory, enter the 
name of the contact, and then select 
Search. 
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Calendar

Displaying your calendar

1 Press Start  and select Calendar.

2 Press Menu  (right softkey) and 
select View.

3 Select one of the following views:

Agenda: Shows your daily schedule in 
list format. Upcoming appointments are 
bold; past appointments are dimmed. 
Agenda View displays a horizontal time 
strip at the top to show at a glance 
when you have appointments.

Day: Shows your daily schedule in 
day-planner format. 

Week: Shows your schedule for an 
entire week.

Month: Shows your schedule for a 
whole month.

 A morning appointment

 An afternoon appointment

 Both morning and afternoon 
appointments

 An all-day event

Year: Shows a calendar for a six-month 
period.

4 Use the 5-way  to move to another 
day, week, month, or year (depending 
on the current view).

DID YOU KNOW? If your schedule contains a 
conflict—two appointments that overlap—you 
can see the conflict in both Day View and 
Week View.

TIP To switch views, press the left softkey. 
Don’t confuse the view name displayed above 
the left softkey with the current view. The left 
softkey displays the name of the next view 
you see when you press the key.
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Creating an appointment

1 Press Start  and select Calendar.

2 Press Menu  (right softkey) and 
select New Appointment.

3 Enter a subject (description) and a 
location.

4 Select Starts and select the starting 
date and time.

5 Select Ends and select the ending date 
and time.

6 Press OK .

Adding an alarm reminder to an event

1 Create an event and then select it.

2 Press Menu  (right softkey) and 
select Edit.

3 Select Reminder and then select 
Remind Me.

4 Enter the number of minutes, hours, 
days, or weeks before the event you 
would like to receive the alarm.

5 Press OK .

Creating an untimed event

An untimed event, such as a birthday, 
anniversary, or vacation, does not occur at 

TIP To “pencil in” an appointment, select 
Status, and then select Tentative.

TIP You can display your appointments on your 
Today screen (see Selecting which items 
appear on your Today screen).

Type of time units

Number of time units
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a particular time of day. These events 
appear as banners at the top of your 
calendar; they don’t occupy blocks of time. 
For example, “Submit Final Draft” in the 
following screenshot is an untimed event.

1 Press Start  and select Calendar.

2 Press Menu  (right softkey) and 
select New Appointment.

3 Enter a subject (description).

4 Select the starting and ending dates.

5 Select All Day, and then select Yes.

6 Press OK .

Scheduling a repeating appointment

1 Create an appointment or untimed 
event, and then select it.

2 Press Menu  (right softkey) and 
select Edit.

3 Select Occurs, and then select a repeat 
pattern. To create a repeat pattern, 
select Edit pattern and follow the 
onscreen instructions.

4 Press OK .

Sending a meeting request

You can email meeting invitations to 
contacts who use Microsoft Office 
Outlook® or Outlook Mobile.

BEFORE YOU BEGIN Create contact 
entries with email addresses for the people 
you want to invite to a meeting. You can’t 
access contact entries without email 
addresses from your calendar.

DID YOU KNOW? An untimed event can last 
longer than a day.

TIP To enter a birthday or an anniversary, 
create an untimed event that repeats every 
year.



Y O U R  P E R S O N A L  I N F O R M A T I O N  O R G A N I Z E R

C A L E N D A R 189

10

C
H

A
P

T
E

R

1 Create an event, and then select it.

2 Press Menu  (right softkey) and 
select Edit.

3 Select Attendees. Select Add 

Required Attendee, and then select 
the name of the contact you want to 
invite. To invite other attendees, select 
Add Required Attendee, and then 
select the names.

4 (Optional) To invite optional attendees, 
select Add Optional Attendee, and 
then select the names.

5  Press OK .

The next time you synchronize, the 
meeting request is sent to the attendees. 
When attendees accept your meeting 
request, the meeting is automatically 

added to their schedules. When you 
receive their response, your calendar is 
updated as well.

Replying to a meeting request

You receive and reply to meeting requests 
in the Messaging application (see Working 
with meeting invitations). If you accept or 
tentatively accept an invitation, it shows up 
as an appointment in your Calendar.

Marking an event as sensitive

If other people have access to your 
Microsoft Office Outlook calendar on your 
computer and you don’t want them to see 
an appointment, you can mark that 
appointment as private to hide it from other 
Microsoft Office Outlook users.

1 Create an event, and then select it.

2 Press Menu  (right softkey) and 
select Edit.

3 Select Sensitivity, and then select one 
of the following:

Personal: Displays the event on your 
smartphone and on your computer. 
Meeting attendees or recipients see 

DID YOU KNOW? If you are using Exchange 
Server 2007, or Exchange Server 2003 with 
Service Pack 2, you can use your corporate 
Global Address List to find contact information 
for an attendee. Select Attendees, press 
Menu (right softkey), and then select 
Company Directory. Enter the name of the 
attendee and select Find.
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“Please treat this as Personal” near the 
top of an open appointment.

Private: Displays the event on your 
smartphone and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Private” near the 
top of an open appointment. If you sync 
with an Exchange server, other users 
who can access your folders can’t see 
your private events; they see private 
events as unavailable time slots.

Confidential: Displays the event on 
your smartphone and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Confidential” near 
the top of an open appointment. 

4 Press OK .

Organizing your schedule

Use categories to view various types of 
events.

1 Create an event, and then select it.

2 Press Menu  (right softkey) and 
select Edit.

3 Select Categories, and then check the 
categories that apply to this event. 
To add a new category, press 
New  (left softkey), enter the 
category name, and then press OK .

4 Press OK  two more times.

5 After you assign events to categories, 
press Menu  (right softkey) and 
select Filter.

6 Select the type of events you want to 
view.

TIP If you don’t see an option on the screen, 
press Down on the 5-way to scroll to other 
options. For example, when editing an event, 
you don’t see the Sensitivity option until you 
scroll toward the bottom of the entry.
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Deleting an event

1 Highlight the event you want to delete.

2 Press Menu  (right softkey) and 
select Delete Appointment.

3 Select Yes to confirm the deletion.

Customizing Calendar

1 Press Menu  (right softkey) and 
select Tools > Options.

2 On the General tab, set any of the 
following options:

Start in: Specifies which view is 
displayed when you open Calendar.

1st day of week: Specifies Sunday or 
Monday as the first day of the week for 
all Calendar views.

Week view: Specifies whether five, six, 
or seven days appear in Week View.

Show half hour slots: Specifies 
whether time slots appear in hour or 
half-hour increments in Day View and 
Week View.

Show week numbers: Specifies 
whether week numbers (1–52) appear 
in Week View.

3 Select the Appointments tab and set 
any of the following options:

TIP Wonder why you’re not seeing all the 
events in your day? Check to make sure that 
the filter is set to All Appointments.
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Set reminders for new items: 

Specifies whether a reminder is 
automatically added to new events and 
how long before the event the reminder 
appears. You can override this setting 
for individual events.

Show icons: Specifies which icons 
appear next to events.

 The event has a reminder.

 The event repeats in a specified 
pattern.

 The event has a note attached.

 A location has been assigned to the 
event.

 The event is a meeting.

 The event is marked private.

Send meeting requests via: Specifies 
the email account used to send meeting 
requests.

4 Press OK .

Tasks
You can use Tasks to remind you of tasks 
you need to complete and to keep a record 
of completed tasks.

Adding a task

1 Press Start  and select Programs.

2 Select Tasks .

3 Press Menu  (right softkey) and 
select New Task.

4 Enter a description of the task in the 
Subject field.

5 Set any of the following:

TIP Not all icons appear in all Calendar views.
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Priority: Specifies the priority level for 
this task. Later you can arrange your 
tasks based on the importance of each 
task.

Status: Indicates whether the task is 
now completed.

Starts: Specifies when the task begins.

Due: Specifies the due date for the 
task.

Occurs: Indicates if the task repeats at 
regular intervals and how often it 
repeats.

Reminder: Sets an alarm for this task 
and indicates when you want to be 
reminded.

Categories: Assigns the task to one or 
more categories. To add a new 
category, press New  (left 
softkey), enter the category name, and 
then press OK .

Sensitivity: Marks this task as Normal, 
Personal, Private, or Confidential (see 
Marking an event as sensitive for 
descriptions of these three terms).

6 (Optional) Select the Notes tab and 
enter additional text for the task.

7 Press OK .

Checking off a task

1 Highlight the task you want to check off.

2 Press Complete  (left softkey).

TIP You can also add a task by selecting the 
Tasks entry bar at the top of the task list 
screen, entering the task description, and 
then tapping anywhere outside of the entry 
bar. Select the icons to the left of the bar to 
set the task as high or low priority.

TIP You can display your tasks on your Today 
screen (see Selecting which items appear on 
your Today screen).
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Organizing your tasks

1 In the Tasks list, press Menu  
(right softkey) and select Filter.

2 Select which tasks you want to view: 
All Tasks, Recently Viewed, 
No Categories, Active Tasks, 
Completed Tasks, or a specific 
category, such as Business or Personal.

3 Press Menu  (right softkey) and 
select Sort By.

4 Select the sort method: Status, 
Priority, Subject, Start Date, or 
Due Date.

Deleting a task

1 Highlight the task you want to delete.

2 Press Menu  (right softkey) and 
select Delete Task.

3 Select Yes to confirm the deletion.

Customizing Tasks

1 Go to the Tasks list.

2 Press Menu  (right softkey) and 
select Options.

3 Set any of the following options:

Set reminders for new items: 

Automatically adds a reminder to new 
tasks. The default reminder is set to 
8:00 on the morning the task is due. You 
can override this setting for individual 
tasks.

Show start and due dates: Displays 
task start and due dates in the Tasks 
list.

Show Tasks entry bar: Displays the 
Tasks entry bar at the top of the Tasks 
list.

4 Press OK .

TIP You can also mark a task complete by 
tapping the check box next to the task on the 
Tasks list.

DID YOU KNOW? Overdue tasks appear in red.
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Notes

Notes are a great way to capture thoughts, 
questions, and meeting notes on your 
smartphone. You can also create a voice 
note or add a recording to an existing note.

BEFORE YOU BEGIN To take advantage of 
all the sync features available in the Notes 
application, install the desktop 
synchronization software (see Setting up 
your computer for synchronization).

Creating a note

1 Press Start  and select Programs.

2 Select Notes .

3 Press New  (left softkey).

4 Do one of the following:

• Type the text with the keyboard.

• If you turned on writing mode (see 
Customizing Notes), write the text 
with the stylus.

• Press Menu  (right softkey), 
select Draw, and then draw a sketch 
with the stylus, crossing at least three 
ruled lines.

5 Press OK .

Creating a voice note

1 Press Start  and select Programs.

2 Select Notes .

3 Do one of the following:

To create a new voice note: Press 
New  (left softkey)

To add a voice recording to an 

existing note: Open the note to which 
you want to add the recording.

4 If the voice note controls are not visible 
at the bottom of the screen, press 
Menu  (right softkey) and select 
View Recording Toolbar. 
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5 Tap the Record  icon.

6 Speak into the microphone on your 
smartphone, or hold it close to another 
sound source.

7 When you finish recording, tap the 
Stop  icon. A Recording  icon 
appears in the note or note list, 
depending on where you recorded the 
note.

8 Press OK .

Creating a note from a template

1 Go to the Notes list.

2 Tap the Show list in the upper-left, and 
then select Templates. If you don’t see 
Templates in the Show list, select More 

Folders to access this folder.

3 Open the template you want to use.

4 Enter the information.

5 Press OK .

6 Rename the note and move it to the 
appropriate folder. See Organizing your 
notes for details.

Organizing your notes

You can rename your notes, move notes to 
another folder, and move notes between 
your smartphone and an expansion card 
(sold separately).

1 Go to the Notes list and highlight a note 
you want to move.

DID YOU KNOW? You can add several voice 
notes within a single note.

TIP To play a recording, select the voice note 
in the Notes list or open the note containing 
the recording and tap the Recording icon. Tap 
the controls at the bottom of the screen to 
control playback and volume.

Voice 
note 
controls

TIP To create a new template, highlight the 
note you want to save as a template. Press 
Menu (right softkey) and select 
Rename/Move. Select Name, and then enter 
a name for the template. Select the Folder 
list, select Templates, and then press OK.
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2 Press Menu  (right softkey) and 
select Rename/Move.

3 Select Name and enter a new name for 
the note.

4 Select Folder, and then select the folder 
in which you want to store the note.

5 Select Location, and then select Main 

memory or Storage Card. The Storage 
Card option appears only if you have an 
expansion card (sold separately) 
inserted into your smartphone.

6 Press OK .

Deleting a note

1 Go to the Notes list and highlight the 
note you want to delete.

2 Press Menu  (right softkey) and 
select Delete.

3 Select Yes to confirm the deletion.

Customizing Notes

1 Go to the Notes list.

2 Press Menu  (right softkey) and 
select Options.

3 Set any of the following options:

Default mode: Makes the default entry 
mode either Writing or Typing. The 
default is Typing; if you change it to 
Writing, you can write notes directly on 
the screen using the stylus.

Default template: Specifies the default 
template for new notes.

Save to: Indicates the default location 
where new notes are stored.

Record button action: Specifies what 
happens when you press the Side 
button to record a voice note while in 
another application: whether the Notes 
application opens or whether you stay 
in the current application.

4 Press OK .

TIP To create a new folder, go to the Notes list, 
tap the Show list in the upper-left, and then 
select Add/Delete. Select New, enter a name 
for the folder, and then press OK.

TIP To use the Record button action feature, 
you need to assign the Side button to open 
Notes. See Reassigning buttons.

TIP Tap Global Input Options to set options 
for entering text in any application (see Setting 
input options).
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CHAPTER

11

Your Microsoft Office and 
other document tools
Your Palm® Treo™ 700wx smartphone enables you to take your 
office with you—including your Microsoft Office files. With 
Microsoft Office, you can carry, create, view, and edit Microsoft 
Word and Excel files directly on your smartphone. You can also 
view, carry, and manage PowerPoint files on your smartphone. 
You can keep updated copies of the files on both your 
smartphone and your computer so that you can work on them 
in the most convenient location at any time.

You can also use PDF Viewer to view PDF files on your 
smartphone.

Benefits

• Manage Word, Excel, and 
PowerPoint files on your 
smartphone

• Improve productivity by taking 
important docs, spreadsheets, and 
presentations with you

• Work with PDF files
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Synchronizing your 
Microsoft Office files

You can create and edit Microsoft Office 
files on your computer or on your 
smartphone and then synchronize the files 
so that changes you make show up on both 
your computer and your smartphone. To 
synchronize Microsoft Office files, you 
must first choose Files as one of your 
synchronization options on your 
smartphone if you did not do so during 
desktop software installation; see Setting 
up your computer for synchronization and 
Changing which applications sync.

The procedure for synchronizing files 
is different for computers running 
Windows XP and computers running 
Windows Vista. 

Synchronizing files: Windows XP

1 Connect your smartphone to your 
computer with the USB sync cable.

NOTE Most ActiveSync desktop software 
options are available only when your 
smartphone is connected to your 
computer.

2 On your computer, double-click the 
ActiveSync®  icon in the taskbar in 
the lower-right corner of your computer 
screen to open the ActiveSync desktop 
software window.

TIP If the ActiveSync icon does not appear in 
the taskbar, go to Start, navigate to 
Programs, and then select Microsoft 

ActiveSync to open the ActiveSync window.
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3 Under Information Type, double-click 
Files to view a list of all 
synchronized files.

4 Do any of the following:

• To delete a file from the file sync 
folder on your computer and from 
your smartphone, highlight the file 
name and click Remove.

• To copy a file from your computer to 
your smartphone, click Add, browse 
to and highlight the file, and then click 
Open.

NOTE If you receive an error while 
synchronizing files, make sure that all of 
the files you’re trying to sync are closed on 
both your computer and on your 
smartphone.

Synchronizing files: Windows Vista

1 On your computer, copy or save the file 
to the Documents\Documents on 
username’s Smartphone folder.

2 Connect your smartphone to your 
computer with the USB sync cable. 
Synchronization takes place 
automatically.

Where are the changes I made to my file?

Don’t look for the changed file in its original 
location on your computer. Only the 
synchronized version contains the changes, 
and that version is in the ActiveSync file 
sync folder. To find this folder, do one of 
the following:

Windows XP: On your computer desktop, 
double-click the file sync folder icon. This is 
a shortcut to the file sync folder.

Windows XP: In ActiveSync desktop 
software, double-click Files. The location of 
the file sync folder appears in the File 
Synchronization Settings dialog box (under 
On this computer, synchronize the files in 
this folder).

TIP If Files doesn’t appear under Information 
Type, open the Tools menu and select 
Options. Make sure the Files box is checked.

DID YOU KNOW? The Documents on 
username’s Smartphone folder is created 
when you select the option to sync Files.
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Windows Vista: Open the Documents\ 
Documents on username’s Smartphone 
folder.

On your smartphone, you can find the 
synchronized file by doing either of the 
following:

• Press Start  and select Office 

Mobile. Select the application that 
opens the file: Word Mobile , Excel 
Mobile , or PowerPoint Mobile .

• Press Start , select Programs, and 
then select File Explorer . Tap the 
Show list in the upper-left and select 
My Device > My Documents.

Word Mobile

You can create and edit documents and 
templates and save them as DOC, RTF, 
TXT, and DOT files. You can also edit 
Microsoft Office Word documents and 
templates that you create on your 
computer. However, keep in mind that 
some of the information and formatting 
may be lost when you save the document 
on your smartphone.

The following features are not supported in 
Word Mobile:

• Backgrounds.

• Bidirectional text.

• Document protection.

• Metafiles.

• Artistic page borders. Lined page 
borders are supported.

• Password-protected files. Remove 
password protection on your computer 
before opening the file on your 
smartphone.

• Shapes and text boxes.

• Smart tags.

The following features are partially 
supported in Word Mobile:

Picture bullets: Regular bullets are 
supported.

DID YOU KNOW? If you have a PDF file (.pdf), 
you can view the file using PDF Viewer. Press 
Start, select Programs, and then select PDF 

Viewer (see PDF Viewer).
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Revision marks: Documents appear as 
though all revisions were accepted; if the 
document is saved, revision marks are lost.

Table styles: Some or all of the formatting 
is lost if the document is saved.

Underline styles: Unsupported styles are 
mapped to one of the four supported 
styles: regular, dotted, wavy, or 
thick/bold/wide.

Legacy Pocket Word files: You can open 
PSW files, but if you edit a file, you need to 
save it in DOC, RTF, TXT, or DOT format.

The following features are not supported 
on your smartphone, but they remain in the 
file so that when you open the file on your 
computer, they appear as expected: 

Fonts and font sizes: Original fonts are 
listed on your smartphone and are mapped 
to the closest font available.

Footnotes, endnotes, headers, and 

footers.

Lists: Indented lists are mapped to the 
closest indentation level supported by 
Word Mobile.

Page breaks: Although not displayed, all 
page breaks, except a break placed at the 

end of a document, are retained in the 
document.

Creating a document

1 Press Start  and select Office 

Mobile.
2 Select Word Mobile .
3 The first time you open Word Mobile, a 

new document opens. Otherwise, 
press New  (left softkey).

4 Enter the text of the document.
5 Press OK  to save the file. When you 

save a new document, it is 
automatically named after the first 
several words in the file.

Opening an existing document

1 Press Start  and select Office 

Mobile.
2 Select Word Mobile .
3 In the document list, select the 

document you want to open.

TIP To zoom in or out, press View (left 
softkey), select Zoom, and then select the 
zoom level.
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Creating a document from a template

1 Go to the documents list.

2 Tap the Show list in the upper-left and 
select Templates. If you don’t see 
Templates in the Show list, select More 

Folders to access this folder.

3 Open the template you want to use.

4 Press Menu  (right softkey) and 
select File > Save As.

5 Select Name and enter a new name for 
the file.

6 Select the Folder list, and then select 
the folder where you want to save the 
file.

7 Select the Type list, and then select the 
format in which you want to save the 
file.

8 Select the Location list, and then select 
Main memory or Storage Card. The 
Storage Card option appears only if you 
have an expansion card (sold separately) 
inserted into your smartphone.

9 Select Save.

Finding or replacing text in a document

1 Open the document containing the text 
you want to find.

2 Press Menu  (right softkey) and 
select Edit > Find/Replace.

3 Select Find what and enter the text you 
want to find.

4 (Optional) Check the Match case box to 
find text that matches the capitalization 
in the text you entered step 3.

5 (Optional) Check the Match whole 

words only box to find only full words 
that match the text you entered in 
step 3.

6 Select Find to locate the first instance 
of the text you entered in step 3, or 
select Replace, enter the replacement 
text, and then select Find.

TIP To create a new template, highlight the 
document you want to save as a template. 
Press Menu (right softkey) and select 
Rename/Move. Select Name and enter a 
name for the template. Select the Folder list, 
and then select Templates. Press OK.
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7 Select Next to find the next instance of 
the text, or select Replace to replace it. 
To replace all instances of the text, 
select Replace All.

8 When you see a message that the 
search is done, press OK .

Moving or copying text

1 Open the document containing the text 
you want to move or copy.

2 Highlight the text you want to move or 
copy.

3 Press Menu  (right softkey) and 
select Copy to copy the text, or select 
Cut to move the text.

4 Open the document where you want to 
insert the text and position the cursor 
where you want the text to appear.

5 Press Menu  (right softkey) and 
select Paste.

Saving a copy of a document

NOTE If a document was previously saved 
on a computer, any unsupported formatting 
may be lost when you save the file.

1 Open the document you want to copy.

2 Press Menu  (right softkey) and 
select File > Save As.

3 Select Name and enter a new name for 
the file.

4 Select the Folder list, and then select 
the folder where you want to save the 
file.

5 Select the Type list, and then select the 
format in which you want to save the 
file.

6 Select the Location list, and then select 
whether you want to store the file on 
your smartphone (Main memory) or on 
an expansion card (Storage Card). The 
Storage Card option appears only if you 
have an expansion card (sold separately) 
inserted into your smartphone.

7 Select Save.

Formatting text

1 Open the document you want to 
format.

2 Highlight the text you want to format.

3 Press Menu  (right softkey) and 
select Format > Font.



Y O U R  M I C R O S O F T  O F F I C E  A N D  O T H E R  D O C U M E N T  T O O L S

W O R D  M O B I L E 207

11

C
H

A
P

T
E

R

4 Set any of the following options for the 
highlighted text:

Font: Specifies the typeface.

Font color: Specifies the color.

Size: Specifies the point size.

Bold: Indicates whether the text 
appears normal or thick.

Italic: Indicates whether the text 
appears upright or slanted.

Underline: Indicates whether the text 
appears with an underscore.

Highlight: Indicates whether the text 
appears with a yellow highlight.

Strikethrough: Indicates whether the 
text appears with a line through it.

5 Press OK  to return to the document.

Formatting paragraphs and lists

1 Open the document you want to 
format.

2 Position the cursor in the paragraph you 
want to format.

3 Press Menu  (right softkey) and 
select Format > Paragraph.

4 Set any of the following options:
Alignment: Aligns the text paragraph 
with the left, right, or center of 
the page.

List: Creates a bulleted or numbered 
list.

Indentation: Changes the paragraph 
margins.

• Left: Sets the left margin for the 
entire paragraph.

• Right: Sets the right margin for the 
entire paragraph.

• Special: Lets you indent the first line 
or set a hanging indent.

• By: Sets the size of the special 
indentation.

5 Press OK  to return to the document.

Checking spelling in a document

1 Open the document you want to check.

TIP You can also use the Formatting toolbar at 
the bottom of the document screen to create 
a list and to align text. To indent text in lists, 
you must use the Formatting toolbar. 
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2 Press Menu  (right softkey) and 
select Tools > Spelling. To check the 
spelling of specific text, highlight it 
before you select the Spelling 
command.

3 If an unknown or misspelled word is 
encountered, do one of the following:

• Select the correct word in the list if 
the word is spelled incorrectly.

• Select Ignore if the word is spelled 
correctly. To ignore all instances of the 
word, select Ignore All.

• Select Add to add a new word to the 
spelling dictionary.

Organizing your documents

You can rename your documents, move 
your documents to another folder, and 
move your documents between your 
smartphone and an expansion card (sold 
separately) inserted into your smartphone.

1 Go to the documents list.

2 Highlight a file.

3 Press Menu  (right softkey) and 
select Rename/Move.

4 Select Name and enter a new name for 
the document.

5 Select the Folder list, and then select 
the folder to which you want to move 
the document.

6 Select the Location list, and then select 
Main memory or Storage Card. The 
Storage Card option appears only if you 
have an expansion card (sold separately) 
inserted into your smartphone.

7 Press OK .

Deleting a document

1 Go to the documents list.

2 Highlight the document you want to 
delete.

3 Press Menu  (right softkey) and 
select Delete.

4 Select Yes to confirm the deletion.

TIP To create a new folder, go to the 
documents list, tap the Show list in the 
upper-left, and then select Add/Delete. Select 
New, enter a name for the folder, and then 
press OK.

TIP When you go to a folder, you can easily 
search your documents by sorting by type.
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Customizing Word Mobile

1 Go to the document list.
2 Press Menu  (right softkey) and 

select Options.
3 Set any of the following options:

Default template: Sets the default 
template for new documents.

Save to: Sets the default location 
where new documents are stored.

Display in list view: Sets the types of 
files that appear in the documents list.

4 Press OK .

PowerPoint Mobile
With PowerPoint Mobile, you can open and 
view slide show presentations created on 
your computer. Many presentation 
elements such as slide transitions, 
animations, and URL links are also 
supported. Microsoft Office PowerPoint® 
features not supported on your 
smartphone include the following: 

• Notes written for slides 
• Rearrangement or editing of slides

• Files created in PPT format earlier than 
Microsoft PowerPoint 97

• HTML files in HTM and MHT formats

Playing a presentation

1 Press Start  and select Office 

Mobile.

2 Select PowerPoint Mobile .

3 In the presentations list, select the 
presentation you want to play.

4 Do any of the following:

• Press Right  to advance to the next 
slide or Left  to view the previous 
slide.

NOTE If a presentation is set up as a timed 
slide show, the slides advance 
automatically. Presentations pause during 
zooming.

• Press Center , select Go to Slide, 
and then select the slide you want to 
view.

• Press Center  and select Next or 
Previous to play animations.

• To zoom in, Press Center  and 
select Zoom In. Tap and drag the 
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slide to scroll the slide. To return to 
normal view, press Center  and 
select Zoom Out.

5 To end the slide show, press 
Center  (right softkey) and select 
End Show.

Setting presentation playback options

1 In the presentations list, highlight the 
presentation for which you want to 
change the settings.

2 Press Menu  (right softkey) and 
select Set up show.

3 On the Orientation tab, select the 
orientation you want. To select the 
orientation that best fits your 
smartphone screen, select Default.

4 Select the Playback tab, and check the 
Override playback options for all 

files box.

5 Set any of the following options:

Show without animation: Turns off 
builds and other animations.

Show without slide transition: Turns 
off transition effects between slides.

Use timings, if present: Enables the 
timings recorded with each slide in a 
presentation. If a presentation is set up 
as a timed slide show, the slides 
advance automatically. Presentations 
pause during zooming.

Loop continuously: Advances to the 
first slide after playing the last slide in a 
presentation.

6 Press OK .

Excel Mobile

With Excel Mobile you can create and edit 
workbooks and templates on your 
smartphone. You can also edit workbooks 
and templates that you create on your 
computer. However, keep in mind that you 
may lose some of the information and 
formatting when you save the workbook on 
your smartphone.

TIP To turn the presentation into a 
continuously looping slide show, check both 
the Use slide timings, if present, and the 
Loop continuously boxes.
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Note the following formatting 
considerations:

Alignment: Vertical text appears 
horizontal.

Borders: Appear as a single line.

Cell patterns: Patterns applied to cells are 
removed.

Fonts and font sizes: The original font is 
listed on your smartphone and mapped to 
the closest font available. Original 
fonts reappear on your computer.

Number formats: Microsoft Office Excel® 
97 conditional formatting is displayed in 
Number format.

Formulas and functions: Unsupported 
functions are removed, and only the 
returned value of the function appears. 
Formulas containing the following are also 
converted to values:

• An array or array argument, for example, 
=SUM({1;2;3;4})

• External link references or an 
intersection range reference

• References past row 16384 are 
replaced with #REF!

Protection settings: Most protection 
features are disabled but not removed. 
However, password protection is removed. 
You must remove the password protection 
in Microsoft Office Excel on your computer 
before opening the file on your 
smartphone.

Zoom settings: Worksheet-specific zoom 
settings are not retained. The zoom setting 
applies to the entire workbook.

Worksheet names: Names that refer to 
other workbooks, arrays, array formulas, or 
intersection ranges are removed from the 
name list, causing those formulas to be 
resolved as “#NAME?” All hidden names 
are not hidden.

AutoFilter settings: AutoFilters that cause 
rows to be hidden are supported. Use the 
Unhide command to display hidden rows. 
Other AutoFilters are removed, but you can 
use the AutoFilter command in Excel 
Mobile to perform similar functions.

Chart formatting: All charts are saved as 
they appear in Excel Mobile. Unsupported 
chart types are changed to one of these 
supported types: Column, Bar, Line, Pie, 
Scatter, and Area. Background colors, 



Y O U R  M I C R O S O F T  O F F I C E  A N D  O T H E R  D O C U M E N T  T O O L S

E X C E L  M O B I L E212

11
C

H
A

P
T

E
R

gridlines, data labels, trend lines, shadows, 
3D effects, secondary axes, and 
logarithmic scales are turned off.

The following features aren’t supported in 
Excel Mobile and are removed or modified 
when you open a workbook on your 
smartphone:

• Hidden, dialog, and macro sheets

• VBA modules

• Text boxes

• Drawing objects and pictures

• Lists

• Conditional formats and controls

• Pivot table data (converted to values)

Creating a workbook

1 Press Start  and select Office 

Mobile.

2 Select Excel Mobile .

3 The first time you open Excel Mobile, a 
new workbook appears. Otherwise, 
press New  (left softkey).

4 Highlight a cell where you want to enter 
text or other info.

5 Enter the info in the cell, and then press 
Return .

6 Repeat steps 4 and 5 to enter the 
remaining info.

7 Press OK  to save the file. When you 
save a new workbook, it is automatically 
named and placed in the workbook list.

Creating a workbook from a template

1 Go to the workbook list.

2 Tap the Show list in the upper-left and 
select Templates. If you don’t see 
Templates in the Show list, select More 

Folders to access this folder.

3 Open the template you want to use.

4 Press Menu  (right softkey) and 
select File > Save As.

5 Select Name and enter a new name for 
the workbook.

6 Select the Folder list, and then select 
the folder where you want to save the 
workbook.

7 Select the Type list, and then select the 
format in which you want to save the 
workbook.

8 Select Save.
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Viewing a workbook

1 Press Start  and select Office 

Mobile.

2 Select Excel Mobile .

3 In the workbook list, select the 
workbook you want to view.

4 Press View  (left softkey) and 
select any of the following:

Full Screen: Shows as much data as 
possible on the screen. To return to the 
normal view, tap Restore in the 
upper-right.

Zoom: Sets the magnification level so 
that you can easily read the worksheet.

Sheet: Lets you switch to a different 
worksheet.

Split: Divides the window into two 
scrollable areas. To move the split bar, 
tap and drag it. To remove the split bar, 
press View  (left softkey) and 
select Remove Split.

Freeze Panes: Locks rows and columns 
so they remain visible while you scroll. 
Highlight the cell at the point at which 
you want to lock before you select this 
command. To unlock the rows or 
columns, press View  (left 
softkey) and select Unfreeze Panes.

Toolbar: Indicates whether the toolbar 
appears onscreen.

Status Bar: Indicates whether the 
status bar appears onscreen.

Show: Indicates whether headings and 
scroll bars appear onscreen.

TIP To create a new template, highlight the 
workbook you want to save as a template. 
Press Menu (right softkey), select 
Rename/Move, select Name, and then enter 
a name for the template. Select the Folder list 
and select Templates. Press OK.

DID YOU KNOW? You can also switch 
worksheets by selecting the sheet list at the 
bottom of the screen.
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Calculating a sum

1 Press View  (left softkey) and 
select Toolbar.

2 Highlight the cell where you want to 
insert the sum.

3 Select . 

4 Tap and drag the stylus across the cells 
you want to add. 

5 Press Return .

Entering a formula

1 Highlight the cell where you want to 
enter the formula.

2 Enter equals sign ( = ) followed by any 
values, cell references, name 
references, operators, and functions.

Examples:

• =(B4/25)+100

• =Revenue-Expenses

3 Press Return .

Referring to a cell or range in a formula

1 Open the workbook where you want to 
refer to a cell or range in a formula.

2 Begin entering a formula in a cell.

3 Select the cell, or select an entire range 
to set the reference.

4 Finish entering the formula and press 
OK .

TIP To jump to a cell or region, press Menu 
(right softkey) and select Edit > Go To. Select 
Cell reference or name and enter the target 
cell info or select Current region. Select OK.

TIP For simple calculations, use the Calculator 
(see Calculator). 

TIP To insert a symbol, place the cursor where 
you want the symbol. Press Menu (right 
softkey) and select Insert > Symbol. 
Highlight the symbol you want to insert, and 
select Insert.

TIP To refer to a cell from another worksheet 
in your formula, enter the worksheet name 
followed by an exclamation point (!) and the 
cell, range, or name reference. 
Example: =Sheet1!Earnings

TIP To create a 3-D reference in your formula, 
specify two or more sheets in a workbook; 
use a colon between the first and last 
worksheet names.
Example: =SUM(Sheet2:Sheet6!$A$2:$C$5)
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Inserting a function

1 Open the workbook where you want to 
insert the function.

2 Highlight the cell where you want to 
enter a function.

3 Press Menu  (right softkey) and 
select Insert > Function.

4 Select the Category list, and then 
select the type of function you want to 
insert.

5 Select the Function list, and then select 
the specific function you want to insert.

6 Select OK.

Entering a sequence automatically

1 Highlight both the cells containing the 
info you want to automate and the 
adjacent destination cells.

2 Press Menu  (right softkey) and 
select Edit > Fill.

3 Select the Direction list, and then 
select the direction you want to 
populate.

4 Select the Fill type list, and then 
select Series.

5 Select the Series type list, and then 
select the type of series you want. If 
you select Date or Number, enter a 
Step value increment.

6 Select OK.

Adding cells, rows, and columns

1 Open the workbook you want.

TIP Select Autofill as the series type to 
quickly fill cells with repetitive data such as 
numbers or repeated text. Autofill takes the 
content of the first cell in the highlighted row 
or column and copies it down or across the 
rest of the selection.
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2 Highlight the area where you want to 
insert elements.

3 Press Menu  (right softkey) and 
select Insert > Cells.

4 Select how you want to insert the 
elements:

Shift cells right: Inserts the same 
number of new cells as the number of 
cells you highlighted horizontally in 
step 2. For example, if you selected an 
area containing two cells horizontally 
(say, A1 and B1), selecting Shift cells 
right inserts two horizontal cells; so the 
original A1 and B1 (and their contents) 
are now C1 and D1. The highlighted area 
and all cells on the right move the same 
number of columns—two in this 
example—to the right.

Shift cells down: Inserts the same 
number of new cells as the number of 
cells you highlighted vertically in step 2. 
For example, if you selected an area 
containing two cells vertically (say, A1 
and A2), selecting Shift cells down 
inserts two vertical cells; so the original 
A1 and A2 (and their contents) are now 
A3 and A4. The highlighted area and all 

cells below it move the same number of 
rows—two in this example—down.

Entire row: Inserts the same number of 
new rows as the number of cells you 
highlighted vertically in step 2. For 
example, if you selected an area 
containing two cells vertically (say A1 
and A2), selecting Entire row inserts 
two rows; so the original rows 1 and 2 
(and their contents) are now rows 3 and 
4. The rows containing the highlighted 
area and all rows beneath it move the 
same number of rows—two in this 
example—down.

Entire column: Inserts the same 
number of new columns as the number 
of cells you highlighted horizontally in 
step 2. For example, if you selected an 
area containing two cells horizontally 
(say, A1 and B1), selecting Entire 
column inserts two columns; so the 
original columns A and B (and their 
contents) are now columns C and D. 
The columns containing the highlighted 
area and all columns on the right move 
the same number of columns—two in 
this example—to the right.
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5 Select OK.

Formatting cells

1 Open the workbook you want to format.

2 Highlight the cells you want to format.

3 Press Menu  (right softkey) and 
select Format > Cells.

4 Select any of the following tabs:

Size: Sets the row height and column 
width.

Number: Sets the type of information 
the cells contain.

Align: Sets whether text wraps within 
the highlighted cells, and sets horizontal 
and vertical alignment position.

Font: Sets the typeface, color, size, and 
style attributes.

Borders: Turns borders on and off for 
various cell edges, and sets the border 
and background colors.

5 Press OK .

Formatting rows and columns

1 Open the workbook you want to format.

2 Highlight the rows or columns you want 
to format.

3 Press Menu  (right softkey) and 
select Format > Row or Format > 
Column.

4 Select any of the following:

AutoFit: Adjusts the size of the 
highlighted rows or columns to their 
contents.

Hide: Hides the highlighted rows or 
columns.

Unhide: Displays hidden rows or 
columns in the highlighted area.

TIP To add a new worksheet, press Menu 
(right softkey) and select Format > Modify 

Sheets. Select Insert, enter a name for the 
worksheet, and then press OK. To change the 
order of the worksheets, highlight a 
worksheet you want to move, select Move 

Up or Move Down, and then press OK.

TIP To name the highlighted cell or range of 
cells, press Menu (right softkey) and select 
Insert > Define Name. Enter the name and 
select Add. Press OK.
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Renaming a worksheet

1 Open the workbook containing the 
worksheet you want to rename.

2 Press Menu  (right softkey) and 
select Format > Modify Sheets.

3 In the Sheets list, highlight the 
worksheet you want to rename.

4 Select Rename, enter a new name for 
the worksheet, and then press OK  
twice.

Sorting info in a worksheet

1 Highlight the cells you want to sort.

2 Press Menu  (right softkey) and 
select Tools > Sort.

3 Select the Sort by list, and then select 
the primary sort column.

4 Check the Ascending box to sort in 
ascending (A-Z or 0-9) order. Leave the 
box unchecked to sort in descending 
(Z-A or 9-0) order.

5 (Optional) Select the Then by lists, and 
then select second- and third-level 
sorting options.

6 Check or uncheck the Exclude header 

row from sort box to indicate whether 
you want to sort the header row.

7 Select OK.

Filtering info in a worksheet

1 Highlight the cells that contain the info 
you want to filter.

2 Press Menu  (right softkey) and 
select Tools > AutoFilter. In each 
column containing a highlighted cell, an 
arrow appears on the right side of the 
cell nearest the top of the column.

3 Tap the arrow to open a list, and then 
select a filter. This hides all rows that do 
not include the selected filter.

4 (Optional) Do any of the following:

• Open the other lists, and select other 
filters.

DID YOU KNOW? You can adjust the column and 
row size by tapping and dragging the right 
edge of the column or the bottom edge of the 
row. To automatically fit rows and columns to 
their contents, double-tap the lower edge of 
the row heading or the right edge of the 
column heading.
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• To display all rows again, open the 
filter lists, and then select All.

• To turn off filtering, press 
Menu  (right softkey) and select 
Tools > AutoFilter again.

Creating a chart

1 Open the workbook in which you want 
to create a chart.

2 Highlight the cells you want to include 
in the chart.

3 Press Menu  (right softkey) and 
select Insert > Chart.

4 Select the type of chart, and then press 
Next  (right softkey).

5 Confirm the area you want the chart to 
include, and then press Next  
(right softkey).

6 Select the data layout, and then press 
Next  (right softkey).

7 Check the boxes to indicate whether 
the first row and column represent 
labels.

8 Select whether you want the chart to 
appear as a separate worksheet within 
the current workbook, or as part of the 
current worksheet.

9 Press Finish  (right softkey).

Formatting or changing a chart

1 Open the workbook that contains the 
chart you want to format.

2 Open the chart.
3 Press Menu  (right softkey) and 

select Format > Chart.
4 Select any of the following tabs:

Titles: Specifies the title of the chart 
and headings, whether a legend 
appears, and the placement of the 
legend.

Scale: Specifies the minimum and 
maximum scales for charts with x and y 
axes.

Type: Specifies the chart style. You can 
use this setting to convert your chart to 
a different format.

Series: Lets you add, modify, format, or 
delete related data points without 
affecting the info in your worksheet.

5 Press OK .

DID YOU KNOW? You can also create custom 
filters where you specify comparisons. Open 
the filter lists and select Custom.
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Finding or replacing info in a workbook

1 Open the workbook containing the info 
you want to find.

2 Press Menu  (right softkey) and 
select Edit > Find/Replace.

3 Select Find what and enter the info you 
want to find.

4 (Optional) Check the Match case box to 
find text that matches the capitalization 
in any text you entered in step 3.

5 (Optional) Check the Match entire cells 
box to find only full cells whose 
contents match any text you entered in 
step 3.

6 Select the Look in field, and then select 
whether to search in formulas or values.

7 Select Find to locate the first instance 
of the info you entered in step 3, or 
select Replace, enter the replacement 
info, and then select Find.

8 Select Next to find the next instance of 
the info, or select Replace to replace it. 
To replace all instances of the info, 
select Replace All.

9 When you see a message that Excel 
Mobile is done searching, press OK .

Organizing your workbooks

You can rename your workbooks. You can 
also move them to another folder or move 
them between your smartphone and an 
expansion card (sold separately).

1 Go to the workbook list.

2 Highlight a file.

3 Press Menu  (right softkey) and 
select File > Rename/Move.

4 Select Name and enter a new name for 
the workbook.

5 Select the Folder list, and then select 
the folder to which you want to move 
the workbook.

6 Select the Location list, and then select 
Main memory or Storage Card. The 
Storage Card option appears only if you 
have an expansion card (sold separately) 
inserted into your smartphone.

7 Press OK .

TIP When you go to a folder, you can easily 
search your files by sorting by type. 
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Deleting cells, rows, and columns

1 Open the workbook containing the 
elements you want to delete.

2 Highlight the area you want to delete.

3 Press Menu  (right softkey) and 
select Edit > Delete Cells.

4 Select how you want to remove the 
elements:

Shift cells left: Deletes the highlighted 
cells and moves all cells on their right to 
the left.

Shift cells up: Deletes the highlighted 
cells and moves all cells below them up.

Entire row: Deletes the entire row(s) in 
which the highlighted cells are located, 
and moves all rows below up. 

Entire column: Deletes the entire 
column(s) in which the highlighted cells 
are located, and moves all columns on 
their right to the left.

NOTE Excel Mobile adjusts formulas to 
reflect the new cell locations. However, a 
formula that refers to a deleted cell 
displays the #REF! error value.

5 Select OK.

Customizing Excel Mobile

1 Go to the workbook list.

2 Press Menu  (right softkey) and 
select Options.

3 Set any of the following options:

Template for new workbook: 
Specifies the default template for new 
workbooks.

Save new workbooks to: Specifies 
where new workbooks are stored.

Files to display in list view: Specifies 
which types of files appear in the 
workbook list.

4 Press OK .

TIP To delete a workbook, go to the workbook 
list and highlight the workbook you want to 
delete. Press Menu (right softkey) and select 
Delete. Select Yes to confirm.

TIP To delete a worksheet, press Menu (right 
softkey) and select Format > Modify Sheets. 
Highlight the worksheet you want to delete, 
and then select Delete. Select Yes and press 
OK.
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PDF Viewer

Picsel PDF Viewer lets you view PDF files 
whether they are saved to your 
smartphone, attached to email messages, 
stored on an expansion card (sold 
separately) inserted into your smartphone’s 
expansion card slot, or downloaded from 
the web. You can customize the document 
display.

Opening a file

1 Press Start  and select Programs.

2 Select PDF Viewer .

3 Select the Folder list, and then select 
the folder containing the file you want 
to open. If you’re not sure which folder 
the file is in, select All Folders.

4 Select the Type list, and then select the 
type of file you want to open.

5 Select the file you want.

6 (Optional) Optimize your viewing of the 
file by doing any of the following:

• To switch between zoom mode and 
pan mode, press Center .

• In zoom mode, to zoom in and out 
while viewing the PDF file, press 
Up , or Down .

• In pan mode, to pan the display in a 
given direction, press Right , 
Left , Up , or Down .

TIP Select the Name, Folder, or Date column 
heading to sort the displayed files by that 
heading. This can help you find the file you 
want more quickly.

TIP To close the Open screen without making 
a selection, select Cancel.

TIP To see which mode you are in, press 
Show Mode (left softkey) to display the mode 
icon. Press Hide Mode (left softkey) to hide 
the mode icon.
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• To rotate the displayed page, press 
Menu  (right softkey) and select 
Page > Rotate.

Moving around in PDF files

To move around within a PDF file, do either 
of the following:

To go to the next or previous page in 

the file: Press Menu  (right 
softkey) and select Page > Next Page 
or Page > Previous Page.

To go to the first or last page in the 

file: Press Menu  (right softkey) 
and select Page > First page or Page > 
Last page.

Customizing the display

You can choose between two views for 
displaying PDF files.

1 Press Menu  (right softkey) and 
select Page.

2 Select one of the following options:

Fit to width: Resizes the file so that the 
width of the file matches the width of 
the screen; you may need to scroll up or 
down to view the entire document.

Fit to page: Resizes the file so that the 
entire file—both width and height—fits 
on one screen.

Customizing PDF Viewer

1 Press Menu  (right softkey) and 
select Settings.

2 Select any of the following options:

Clear History: Deletes all files from the 
Recent list (see Opening a file).

Files: Specifies which file types can be 
opened with PDF Viewer.

About: Contains information on the 
PDF Viewer application.

TIP When you have a file open, to open a 
different file you have recently viewed, press 
Menu (right softkey), and then select Recent 
> [the name of the file you want].
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Your application and info 
management tools
Your Palm® Treo™ 700wx smartphone comes equipped with a 
variety of tools for managing and organizing your information. 
Get the most out of your smartphone: Install some of the 
thousands of business, education, or leisure-time applications 
available. After you use your smartphone to create or capture 
important business and personal information, use one of 
several options to share the info with others. Insert expansion 
cards (sold separately) for a compact and limitless answer to 
the storage dilemma. And because there’s one on your 
smartphone, you never need to carry a separate calculator.

Benefits

• Locate info in any application

• Install applications, games, and 
other software

• Keep others up-to-date with 
meaningful business and personal 
information

• Store, carry, and exchange info

• Always have a calculator with you
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Finding information

Quickly find who or what you’re looking for 
by using one of these search features:

Lookup: Find and dial your contacts by 
name or phone number. See Dialing by 
contact name for details.

Search: Look through the text in all the 
applications on your smartphone.

File Explorer: Browse through the files 
and folders on your smartphone or on an 
expansion card (sold separately) inserted 
into your smartphone.

Global Address List Lookup: Look up 
names in your online corporate address 
list.

Email message search: Display only those 
messages whose senders, recipients, or 
subjects match the text you enter (see 
Finding messages).

Using Search

Search for files and other items stored in 
the My Documents folder on your 
smartphone or on an expansion card (sold 
separately) inserted into your smartphone. 
You can search by file name or by words 
located in the item. For example, you can 
search for words within notes, 
appointments, contacts, and tasks.

1 Press Start  and select Programs.

2 Select Search .

3 Select Search for, and then enter the 
file name, word, or other info you want 
to find.TIP For information on opening and closing 

apps, see Opening and closing applications.
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4 Select the Type list, and then select the 
kind of information you want to find.

5 Press Search  (left softkey).

6 Use the 5-way  to select and view an 
item from the results of the search. A 
storage card symbol appears next to the 
names of files that are located on an 
expansion card.

Exploring files and folders

You can use File Explorer to browse the 
contents of folders on your smartphone or 
on an expansion card (sold separately) 
inserted into your smartphone. The root 
folder on your smartphone is named My 
Device. My Device is similar to My 
Computer (Windows XP) or Computer 
(Windows Vista) on your computer.

1 Press Start  and select Programs.

2 Select File Explorer .

3 Select the folder you want to explore. If 
the folder you want is not displayed, tap 
the Show list in the upper-left and 
select My Device to view all folders.

TIP If you’ve looked for an item before, select 
the Search for list, and then select the item in 
the list.

TIP When two or more words are entered in 
the Search for field, the search results 
contains only items that contain all of the 
words.

TIP If you are searching for information in 
certain applications, such as Messaging or 
Word Mobile, select Advanced for more 
search options.

Show list

Sort by 
list
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4 Do any of the following:

• To open an item, select it.

• To quickly delete, rename, beam, or 
email an item, highlight the item, 
press and hold Center  to open 
the shortcut menu, and then select 
the appropriate command.

• To move a file to another folder, 
highlight the item, press and hold 
Center  to open the shortcut 
menu, and select Cut or Copy. Open 
the destination folder, press and hold 
Center  to open the shortcut 
menu, and then select Paste.

• To highlight multiple items, tap and 
drag the stylus.

IMPORTANT Do not delete any files that 
you cannot identify. These files may be 

required for your smartphone to function 
properly.

Installing applications

Your smartphone comes with several 
built-in and ready-to-use applications. You 
can also install any of the additional 
software included on the Windows Mobile 
Getting Started CD as well as other 
third-party applications that are compatible 
with Microsoft Windows Mobile® 6 
Professional edition devices, such as 
business software, games, and more.

Applications you download to your 
computer are likely to be in a compressed 
format such as ZIP. If the file is 
compressed, you can use a decompression 
utility on your computer, such as WinZip, to 
decompress the file before you install the 
application on your smartphone, or you can 
copy the compressed file to your 
smartphone and select it in File Explorer to 
decompress it.

These instructions tell you how to install 
basic files onto your smartphone. Some 

DID YOU KNOW? When the items in a folder are 
displayed, you can sort them by name, date, 
size, or type. Select the Sort by list in the 
upper-right, and then select the sort method.

TIP The storage card symbol appears next to 
the names of files that are stored on an 
expansion card.
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software uses an installer or wizard to 
guide you through the process. For details, 
consult the documentation that came with 
the software.

Installing bonus software from the CD

The Windows Mobile Getting Started CD 
includes several bonus software 
applications that you can install on your 
smartphone. You can install these 
applications when you install the desktop 
software, or you can install them later.

1 Insert the Windows Mobile Getting 
Started CD into the CD drive on your 
computer.

2 Click Add Programs (Windows XP) or 
Bonus Software (Windows Vista).

3 Click the name of the application you 
want to install.

4 Click Install (on the right side of the 
screen).

5 (Optional) Repeat steps 3 and 4 to 
install additional applications.

6 Synchronize your smartphone with your 
computer to install the application(s) on 
your smartphone.

Installing third-party applications

When installing third-party applications, 
note the following:

• Install only apps that are designed for 
Microsoft Windows Mobile 6 
Professional. Apps designed for 
Microsoft Windows Mobile 6 Standard 
or any edition of Windows Mobile 5.x 
software are not compatible with your 
smartphone.

• If you can try a free or trial version of 
the software before purchasing it, you 
can test it first to make sure it works 
properly.

NOTE If you encounter a problem with a 
third-party application (such as an error 
message), contact the application’s vendor. 
For general troubleshooting of third-party 
applications, see Third-party applications.

TIP If an application does not have a Microsoft 
Mobile to Market certificate, you see a 
message indicating that the application is 
untrusted. If this occurs, you can indicate 
whether you want to continue the installation.
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Installing applications from the Internet

You can use Internet Explorer Mobile to 
install Windows Mobile apps in the CAB 
file format directly from the Internet. For 
files in any other format except CAB, you 
must first download the files to your 
computer and then install them to your 
smartphone by synchronizing.

1 Make sure your phone is on and that 
you are in a coverage area (see Turning 
your phone on).

2 Press Start  and select Internet 

Explorer.

3 Go to the page that contains the link to 
the application you want to download.

4 Press Left  or Right  to highlight the 
link to the file, and then press 
Center  to start the download 
process.

5 When the download has finished, press 
Start  and select Programs.

6 Select File Explorer .

7 Go to the My Documents folder in File 
Explorer.

8 Select the file you downloaded to start 
the installation program.

Installing applications from your 

computer

BEFORE YOU BEGIN To install an 
application from your computer to your 
smartphone, you must first install the 
desktop synchronization software on 
your computer (see Installing ActiveSync 
desktop software: Windows XP or 
Installing Windows Mobile Device Center: 
Windows Vista).

1 Connect your smartphone to your 
computer to synchronize and install the 
application(s) on your smartphone.

2 Open My Computer or Windows 

Explorer on your computer.

3 Double-click the icon representing your 
smartphone.

4 Copy the application file(s) into the 
folder.

DID YOU KNOW? You can purchase a third-party 
application that lets you run Palm OS® 
applications on your smartphone.



Y O U R  A P P L I C A T I O N  A N D  I N F O  M A N A G E M E N T  T O O L S

R E M O V I N G  A P P L I C A T I O N S232

12
C

H
A

P
T

E
R

Installing applications onto an expansion 

card

BEFORE YOU BEGIN To install an 
application from your computer to an 
expansion card, you must first install the 
desktop synchronization software on 
your computer (see Installing ActiveSync 
desktop software: Windows XP or 
Installing Windows Mobile Device Center: 
Windows Vista).

1 Insert the expansion card (sold 
separately) into the expansion card slot 
(see Inserting and removing expansion 
cards).

2 Connect your smartphone to your 
computer using the USB sync cable.

3 Open My Computer or Windows 

Explorer on your computer.

4 Double-click the icon representing your 
smartphone.

5 Navigate to the folder representing the 
expansion card.

6 Copy the application file(s) into the 
expansion card folder.

Removing 
applications

To free up memory on your smartphone, 
you can remove applications that you no 
longer use. You can remove only 
applications, patches, and extensions that 
you install; you cannot remove the built-in 
applications that reside in the read-only 
memory (ROM) portion of your 
smartphone.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Remove Programs .
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3 Select the application that you want to 
remove.

4 Select Remove.

5 Select Yes to confirm the deletion.

Sharing information

Your smartphone comes equipped 
with a variety of options for sharing 
information, so that you can choose the 
quickest, most convenient way to send 
your info or to receive info from another 
device.

• In many applications, you can send a file 
or an entry by email or beaming. Open 
the app to the file or entry list and 
highlight the item you want to send. 
Press Menu  (right softkey) and 
select the Send or Beam option.

• In Microsoft Outlook®, you can insert a 
picture or attach a note or other file to 

an email. You can also receive pictures 
and attachments (see Your email).

• You can attach a picture, video, or sound 
file to a multimedia message (see 
Creating and sending a multimedia 
message).

• You can synchronize to share info 
between your smartphone and your 
computer or between your smartphone 
and Microsoft Exchange Server 2003 or 
2007 (see Synchronizing information).

• If you are near someone, you can beam 
files and applications between your 
smartphone and your neighbor’s device 
using the IR port or Bluetooth® wireless 
technology (see Beaming information).

• You can also store files on an expansion 
card and share the expansion card (see 
Using expansion cards).

Beaming information

Your smartphone is equipped with an IR 
(infrared) port that enables you to beam 
information to another device with an IR 
port. The IR port is located on the top of 

DID YOU KNOW? Built-in applications that 
cannot be deleted are not listed in the 
Remove Programs list.
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your smartphone near the antenna. You can 
also beam using the Bluetooth wireless 
technology on your smartphone.

The normal range for beaming with IR is 
about 8 inches (20 centimeters). The 
maximum range for beaming with 
Bluetooth technology is about 30 feet 
(10 meters). Performance and range are 
affected by physical obstacles, radio 
interference from nearby electronic 
equipment, and other factors.

Beaming an entry or file

BEFORE YOU BEGIN To beam using 
Bluetooth technology, make sure your 
smartphone has the Bluetooth feature 

turned on (see Entering basic Bluetooth 
settings).

1 Highlight the entry or file you want to 
beam.

2 Press Menu  (right softkey) and 
select Beam… (the menu item changes 
names based on the type of item you 
highlighted).

3 Do one of the following:

Bluetooth: When the name of the 
receiving device appears, select [the 

device name]/Tap to send to begin the 
transfer. A blue icon indicates a 
Bluetooth connection.

IR: Point the IR port on your smartphone 
directly at the IR port of the receiving 

TIP For best results, the path between the 
two devices must be clear of obstacles, and 
both devices kept stationary. If you have 
difficulty beaming, shorten the distance and 
avoid bright sunlight.

DID YOU KNOW? The type of information you 
can beam depends on the type of device you 
are beaming to. Other Windows Mobile 6 
Professional devices are always compatible 
with your Treo 700wx smartphone.



Y O U R  A P P L I C A T I O N  A N D  I N F O  M A N A G E M E N T  T O O L S

U S I N G  E X P A N S I O N  C A R D S 235

12

C
H

A
P

T
E

R

device. Select [the device name]/Tap 

to send. A red icon indicates an IR 
connection.

4 Wait for Done to appear next to the 
name of the receiving device before you 
continue using your smartphone.

Turning on the option to receive beamed 

information

By default, the option to receive beamed 
information on your smartphone is turned 

off. You need to turn the beam option on 
before you can receive information being 
beamed from another device.

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Beam .

3 Check the Receive all incoming 

beams box.

Receiving beamed information

1 Turn on your screen if it is not already 
on.

2 If you are beaming over an IR 
connection, point the IR port on your 
smartphone directly at the IR port of the 
transmitting device.

3 When the Receiving Data message 
appears, select Yes to receive the 
beam.

Using expansion 
cards

The expansion card slot on your 
smartphone enables you to add SD cards 

TIP The regional setting determines the list of 
characters that can be used when info is 
beamed between devices. If you try to send 
or receive a character that is not on the list, it 
appears as a question mark (see Setting 
display formats).
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and MultiMediaCard cards to extend the 
storage capacity of your smartphone. For 
example, SD or MultiMediaCard expansion 
cards can store the following:

NOTE Your smartphone does not support 
SDHC (SD High Capacity) expansion cards. 
These cards typically have a capacity of 
over 2GB.

You can also purchase SDIO cards that 
contain software such as presentation 
modules. When purchasing an SDIO card, 
make sure that the card is compatible with 
the Treo 700wx smartphone.

Expansion cards are sold separately.

Inserting and removing expansion cards

1 Press down and release the dummy 
card.

2 After you feel the expansion card slot 
eject the dummy card, remove the card 
from the slot.

3 To insert an expansion card, hold your 
smartphone with the screen facing you 

• Pictures
• Videos

• Games
• Applications

• MP3 audio files
• Email attachments

• Databases

TIP Your smartphone comes with a dummy 
card inside the expansion card slot, to protect 
the slot. When you do not have a functioning 
card inside the slot, reinsert the dummy card 
to protect the slot opening.

TIP SD cards are faster than MultiMediaCard 
cards for reading and writing information.

TIP We recommend that you purchase 
preformatted expansion cards. To format a 
card on your own, you need to connect a card 
reader (sold separately) to your computer.



Y O U R  A P P L I C A T I O N  A N D  I N F O  M A N A G E M E N T  T O O L S

U S I N G  E X P A N S I O N  C A R D S 237

12

C
H

A
P

T
E

R

and hold the card with the label facing 
you. The notch on the card should be in 
the lower-left corner, next to the 
antenna.

4 Insert the card into the expansion card 
slot until you feel it lock into place and 
you hear the confirmation tone.

Opening applications on an expansion 

card

After you insert an expansion card into the 
expansion card slot, you can open any of 
the applications stored on the expansion 
card.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Tap the Show list in the upper-left and 
select Storage Card.

5 Select the application you want to open.

Saving files to an expansion card

You can save space on your smartphone by 
saving files to an expansion card. For 
example, when you create new Word 
Mobile documents, notes, Excel Mobile 
workbooks, pictures, videos, and audio 
files, you can save them directly to an 
expansion card. Saving files to an 

TIP To run an application on an expansion card, 
your smartphone must have enough free 
space in the internal memory to run the 
application.

Notch

Show list
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expansion card also makes it easy to share 
those files with others. (Some applications 
may not support this feature.)

1 Insert an expansion card into the 
expansion card slot.

2 Open the application from which you 
want to save the info.

3 Press Menu  (right softkey) and 
select Options.

4 Select the option for where to save info, 
and then select Storage Card. The 
option name changes depending on the 
application you are in.

5 Press OK .

Moving info between your smartphone 

and an expansion card within an 

application

In certain applications—for example, 
Pictures & Videos and the Office Mobile 
applications—you can move files directly to 
another location. For applications that do 

not support this feature, see Moving info 
between your smartphone and 
an expansion card using File Explorer.

1 Insert an expansion card into the 
expansion card slot.

2 Open the application from which you 
want to move the info.

3 Go to the list view and highlight the file 
or application you want to move. If you 
do not see the item, tap the Show list 
in the upper-left and select All Folders, 
then navigate to the folder containing 
the item.

4 Press Menu  (right softkey) and 
select Rename/Move.

5 Select the Location list, and then select 
where you want to move the info: 
Storage Card or Main memory.

6 Press OK .

Moving info between your smartphone 

and an expansion card using File Explorer

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

TIP If you don’t see a Save to option on the 
Options screen, look on the other tabs (if 
present). If you still can’t find a Save to list, the 
application may not support this feature.
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4 Highlight the file or application you want 
to copy or move (see Exploring files and 
folders).

5 Press Menu  (right softkey) and 
select Edit > Copy or Edit > Cut.

6 Go to the folder where you want to 
place the selected item.

7 Press Menu  (right softkey) and 
select Edit > Paste.

8 Press OK .

Viewing available expansion card 

memory

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Settings.

3 Select the System tab, and then select 
Memory .

4 Select the Storage Card tab.

5 Press OK .

Exploring files on an expansion card

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Tap the Show list in the upper-left and 
select Storage Card.

5 Select the folder or files you want to 
view.

6 Press OK .

Renaming an expansion card

If you change the contents of an expansion 
card, you may at some point want to 
rename the card to better match its 
contents.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

TIP Your applications are usually located in the 
My Device/Program Files folder.

TIP Before copying information to or renaming 
the files or folders on an expansion card, or 
renaming the card itself, make sure the card is 
not write-protected. See the instructions that 
came with your card for details.
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4 Tap the Show list in the upper-left and 
select My Device.

5 Highlight the current expansion card 
name (Storage Card by default).

6 Press Menu  (right softkey) and 
select Rename.

7 Enter a new name for the card.

8 Press OK .

Encrypting an expansion card

When you encrypt an expansion card, the 
info on the card can be read only by your 
smartphone—so no one can see what’s on 
the card if it gets lost or stolen.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Settings.

3 Select the System tab, and then select 
Encryption.

4 Check the Encrypt files placed on 

storage cards box.

NOTE If your organization enforces an 
encryption policy, you can see that the box 
is checked but cannot uncheck it.

Calculator

You can use Calculator for basic arithmetic 
calculations, such as addition, subtraction, 
multiplication, and division.

Performing calculations

1 Press Start  and select Programs.

2 Select Calculator .

3 Tap the onscreen numbers and perform 
calculations, including the following:

 Clears the last digit in a multi-digit 
entry.
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 Clears the current calculation or the 
displayed number. You can also press C 
on the keyboard.

 Calculates the reciprocal of a 
number.

 Calculates percentage.

 Calculates the square root of a 
number.

 Switches a number between 
negative and positive.

Using the Calculator memory

• To store a displayed number, tap the box 
to the left of the entry box or press M. 
An M appears in the box.

• To add the displayed number to the 
number stored in memory, tap  or 
press P.

• To display the number stored in 
memory, tap  or press R. 

• To clear the memory, tap  or press L.

TIP You can paste numbers into Calculator as 
well as copy calculation results to be pasted 
into another app. Press Edit (left softkey) and 
select Paste or Copy.

TIP You can also turn on Option Lock and use 
the number keys to enter numbers.

TIP For more advanced calculations, use Excel 
Mobile. See Excel Mobile for details.

DID YOU KNOW? When you store a number in 
memory, it replaces the number that is 
currently stored.
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CHAPTER

13

Your personal settings
Customizing is optional. But why not personalize your Palm® 
Treo™ 700wx smartphone to make it match your lifestyle and 
work even harder for you?

You can easily customize the sounds, fonts, screen colors, and 
more on your smartphone. Take advantage of various levels of 
security. Prevent making an accidental (and expensive) phone 
call by locking the keyboard. Some preference settings can help 
extend the life of your battery. There are lots of ways to make 
your smartphone work better for you.

Benefits

• Conserve power

• Secure your phone and your data

• Make your screen easy to read

• Streamline smartphone use
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Today screen settings

Selecting your Today screen background

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 On the Appearance tab, check the Use 

this picture as the background box.

4 Select Browse.

5 Select the picture you want to use.

6 Press OK .

Selecting which items appear on your 

Today screen

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 Select the Items tab.

4 Check the boxes next to the items you 
want to appear on your Today screen, 
and uncheck any items that you do not 
want to appear.

5 (Optional) Highlight an item and select 
Move Up or Move Down to change the 
order in which items appear on the 
Today screen.TIP To change the color theme for your 

smartphone, select a new theme from the 
Appearance tab in Today Settings (see 
Changing the system color scheme).
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6 (Optional) Highlight an item and select 
Options (if available) to configure the 
settings for the item. Press OK  to 
return to Today Settings.

7 Press OK .

System sound 
settings

When you’re in a meeting, at the movies, 
or anywhere that silence is required, you 
can immediately silence all sounds on your 
smartphone, including Calendar 
notifications and system sounds. This does 
not mute the speaker during phone calls.

Silencing sounds

1 Slide the Ringer switch to 
Sound Off . The smartphone 
vibrates briefly.

2 To hear all sounds again, slide the 
Ringer switch to Sound On .

When you slide the Ringer switch back to 
the Sound On position, it restores the 
previous sound settings. For example, if 
the smartphone ring volume is set to the 
loudest setting and you slide the Ringer 
switch to Sound Off, you do not hear the 
smartphone ring. When you move the 
Ringer switch back to Sound On, the 
smartphone ring volume is still set to the 
loudest setting.

DID YOU KNOW? There are lots of third-party 
plug-ins available for your Today screen.

TIP Can’t get music to play out of the built-in 
MP3 player? Check the Ringer switch. If it’s 
set to Sound Off, you won’t be able to hear 
music.

DID YOU KNOW? Your smartphone includes a 
silent alarm that can vibrate even when the 
Ringer switch is set to Sound Off.

Sound OffSound On
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Selecting Sounds & Notifications

1 Press Start  and select Settings.

2 On the Personal tab, select Sounds & 

Notifications .

3 On the Sounds tab, set any of the 
following options:

Events: Turns sounds on/off for system 
warnings and error messages.

Programs: Turns sounds on/off in the 
applications on your smartphone.

Notifications: Turns alarms and 
reminders on/off in the applications on 
your smartphone.

Screen taps: Turns sounds associated 
with tapping the screen on/off, and sets 
the volume level when this sound is 
turned on.

Hardware buttons: Turns sounds 
associated with pressing buttons on/off, 
and sets the volume level when this 
sound is turned on.

TIP To record, preview, delete, and send 
sounds, select the Manage tab. To add an 
existing sound file—for example, a sound file 
you downloaded—to the list, press Menu 
(right softkey) select Add, and then navigate 
to and select the file. To record a sound, press 
Menu (right softkey) and select New Sound. 
To play a sound, select it and press Play (left 
softkey). To delete a sound, highlight it and 
press Backspace. To send a sound, highlight 
it, press Menu (right softkey), and then select 
Beam Sound or Send Sound.
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4 Select the Notifications tab and set 
any of the following options:

Event: Specifies the action for which 
you want to change the settings. The 
remaining options vary based on the 
event you select.

Play sound: Lets you turn the sound 
on/off for the selected event. To select a 
different sound, select the list to the 
right of this setting, and then select a 
different sound. To preview the sound, 
select Play sound, and then select 
Play.

Repeat: Indicates whether the sound 
plays more than once, if turned on.

Display message on screen: Indicates 
whether a notification message appears 
onscreen for the selected event.

Vibrate when ringer switch off/on: 
Indicates whether your smartphone 
vibrates to notify you about the selected 
event.

5 Press OK .

Display and 
appearance settings

Adjusting the brightness

1 Press Option  and then press .

2 Press Left  and Right  to adjust the 
brightness.

3 Press OK .

Changing the text size and clarity

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 Select the Text Size tab.
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4 Press Left  and Right  to adjust the 
text size.

5 Select the Clear Type tab.

6 To smooth the edges of screen fonts, 
check the Enable Clear Type box.

7 Press OK .

Displaying the clock

You can display a clock at the top of every 
screen. You can also choose between a 
digital and an analog clock display.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the More tab.

4 To display the clock, check the Display 

the clock on the title bar in all 

programs box.

5 Press OK .

6 To change the clock display format, tap 
and hold the clock, and then select 
Analog or Digital. If you select analog 
format, a clock icon  appears 
displaying the time.

Setting display formats

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Regional Settings .

3 On the Region tab, select a region from 
the list. The region selection determines 
all display formats (date, time, and so 
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on) on your smartphone unless you use 
another Regional Settings field to select 
a different format for a specific type of 
display item.

4 (Optional) Select any of the following 
tabs to customize the format settings:

Number: Sets the decimal symbol and 
number of decimal places, the digit 
grouping symbol and group size, list 
separators, negative number sign 
symbol and format, leading zero display, 
and measurement system (metric vs. 
U.S.).

Currency: Sets the currency symbol 
and position, the decimal symbol and 
number of places, digit grouping symbol 
and group size, and negative number 
format.

Time: Sets the time style, separators, 
and AM and PM symbols.

Date: Sets the short date style, 
separators, long date style, and 
calendar type.

5 Press OK .

Aligning the screen to correct tapping 

problems

Occasionally, your screen may need to be 
readjusted. You know your screen needs 
adjustment when the wrong feature is 
activated when you tap the screen. To fix 
the problem, align the screen.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 On the General tab, select Align 

Screen.

4 Tap the screen where indicated.

5 Press OK .

Changing the system color scheme

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 On the Appearance tab, select a theme 
in the list.

4 Press OK .

TIP You can also set the background for your 
Today screen (see Selecting your Today 
screen background).
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Changing screen orientation

Landscape orientations are determined by 
which hand you would hold the stylus in.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 Select the General tab. 

4 Select an orientation:

• Portrait

• Landscape (right-handed)

• Landscape (left-handed)

5 Press OK .

Application settings

Arranging the Start menu

You can change the seven applications 
listed on the Start menu. You can still 
access the remaining applications by 
selecting Programs from the Start menu, 
and then selecting the application’s icon.

1 Press Start  and select Settings.

2 On the Personal tab, select Menus .

3 Check the boxes next to the 
applications you want to see in the Start 
menu.

4 Press OK .

Reassigning buttons

You can use Buttons Settings to select 
which applications to associate with many 
of the buttons and key combinations on 
your smartphone.

TIP Don’t forget the six icons across the top of 
the Start menu. They’re the apps you opened 
most recently, and it’s easy to get back to 
them: just use the 5-way to select one of the 
icons.
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1 Press Start  and select Settings.

2 On the Personal tab, select 
Buttons .

3 On the Program Buttons tab, highlight 
the button or key combination you want 
to change in the Button list. The 
hardware buttons are mapped to the 
following items:

• Start  = Start menu

• OK  = OK/Close

• Option  + Phone/Send  = 
Internet Explorer

• Option  + Start  = Calendar

• Option  + OK  = Task Manager

• Hold Side = Windows Media Player

4 Select the Assign a program list, and 
then select the application you want to 
assign to the button or key combination 
you selected in step 3.

5 Select the Up/Down Control tab and 
adjust the settings for the Up  and 
Down  buttons on the 5-way.

6 Press OK .

Setting up voice commands

IMPORTANT The Voice Command 
application is available only for English, 
French, and German.

Voice commands enable you to use speech 
to execute some commands on the Start 
menu and the Programs screen.

1 Assign the Hold Side button to Voice 
Command. See Reassigning buttons for 
details.

2 Press Start  and select Settings.



Y O U R  P E R S O N A L  S E T T I N G S

A P P L I C A T I O N  S E T T I N G S 253

13

C
H

A
P

T
E

R

3 On the Personal tab, select Voice 

Command .

4 Check the Enabled box.

5 Select the items you want to enable. If 
an item is highlighted and the Options 
button is active, select Options to 
choose the features you want enabled 
for the highlighted item.

6 Select Notifications, and then select 
the options for how you want to receive 
voice command notifications.

Using voice commands

IMPORTANT Do not use voice commands 
in your car until you read the End user 
notice about this kind of usage; see page ii 

of Quick Reference, included in your 
smartphone package, for information.

1 Set the Ringer switch at the top of your 
smartphone to Sound On .

2 Hold your smartphone about nine 
inches (230mm) away from your mouth, 
and then press and release the 
assigned Voice Command button (see 
Setting up voice commands). A tone 
plays and a microphone icon appears at 
the top of your screen.

3 In a clear voice say the command. For 
example:

• To access Help, say “Help.” After 
Voice Command finishes speaking, a 
microphone icon appears at the top of 
your screen. Say your answer. For 
example, say “General” to access 
general Help topics.

• To access your Calendar, say “Start 
Calendar.”

• To access your music, say “Start 
Windows Media.” After Voice 
Command finishes speaking, a 
microphone icon appears at the top of 
your screen. Say your answer.
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Setting input options

1 Press Start  and select Settings.

2 On the Personal tab, select Input .

3 On the Input Method tab, set any of the 
following options:

NOTE The Input Method options you 
specify apply only to entering info using the 
screen. You can still enter info using your 

smartphone’s keyboard regardless of the 
onscreen input method you choose.

Input method: Specifies which 
onscreen input method you want to 
use:

• Block Recognizer: Use a single 
stroke to write letters, numbers, 
symbols, and punctuation, which are 
then converted into typed text. Use 
gestures to enter Return and 
Backspace.

• Keyboard: Tap keys on the onscreen 
keyboard to enter text.

• Letter Recognizer: Write individual 
letters, numbers, and punctuation, 
which are converted into typed text.

Large/Small keys: If you selected 
Keyboard, select whether to use large 
or small onscreen keys. If you select 
Large keys, check the box if you want to 
use gestures for the space, backspace, 
shift, and enter keys.

Options: If you selected Letter 
Recognizer, select Options and select 
the options you want.

TIP You can move quickly through voice 
commands by stopping the voice command 
response before it finishes. When Voice 
Command responds, you can press the Voice 

Command button before it completes the 
question. After the microphone icon is visible, 
you may say your answer.
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4 Select the Word Completion tab and 
set any of the following options:

Suggest words when entering text: 
Indicates whether word suggestions 
appear as you enter text. You can also 
specify how many letters you want to 
enter before a suggestion appears, how 
many suggestions you want to see, and 
whether a space appears after you 
insert a suggested word.

Clear Stored Entries: Deletes the 
database of word suggestions.

Enable Auto Correct: Indicates 
whether common misspellings such as 
“teh” are corrected automatically.

5 Select the Options tab and set any of 
the following options:

Voice recording format: Specifies the 
format in which you save voice notes.

Default zoom level for writing: 
Specifies the initial size of text entered 
from onscreen writing methods.

Default zoom level for typing: 
Specifies the initial size of text entered 
using the onscreen keyboard.

TIP To enter a suggested word, press Down 
to highlight the suggestion, and then press 
Center to accept it. 
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Capitalize first letter of sentence: 
Specifies whether the first letter of a 
sentence automatically appears in 
uppercase, without requiring you to 
press a Shift key.

Scroll upon reaching the last line: 
Specifies whether the display 
automatically scrolls when you select 
the last line of visible info.

6 Press OK .

Locking your 
smartphone and info

Your smartphone includes several features 
that help you protect it from inadvertent 
use and keep your information private. The 
built-in security software lets you use your 
smartphone for emergency calls, such as 
dialing 911, even if it is locked.

Keyguard: Manually disables all buttons 
and the screen’s touch-sensitive feature 
to prevent accidental presses in your 
briefcase or pocket.

Auto-Keyguard and touchscreen 

lockout: Automatically enables Keyguard 
after a period of inactivity and lets you 
disable the screen’s touch-sensitive feature 
during an active call.

Phone Lock: Requires a Lock Code to turn 
on your phone so you can make and 
answer calls.

System password lock: Requires a 
password to see any information on your 
smartphone.

Locking your keyboard (Keyguard)

By default, your keyboard locks when you 
turn off the screen so that you don’t 
accidentally press buttons or activate 
screen items while your smartphone is in a 
pocket or bag.

TIP To avoid accidentally pressing onscreen 
buttons while you’re holding your smartphone 
up to your ear to speak, you can disable the 
screen’s touch-sensitive feature during active 
calls. When the screen’s touch-sensitive 
feature is disabled, you must use the 5-way 
navigator to access items on the screen.
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• To dismiss Keyguard when you turn on 
the screen, press Center .

• To manually turn on Keyguard when 
your smartphone screen is on, press 
Option  + Power/End .

Turning on Auto-Keyguard

Auto-Keyguard enables you to configure 
the Keyguard feature.

1 Press Start  and select Settings.

2 On the Personal tab, select 
Keyguard .

3 Select the Auto-Keyguard list, and then 
disable the Auto-Keyguard feature or set 
the period of inactivity that passes 
before the keyboard automatically locks.

4 Press OK .

Locking your screen

1 Press Start  and select Settings.

2 On the Personal tab, select 
Keyguard .

3 Check or uncheck the While on call in 

Today screen box to determine 
whether the screen’s touch-sensitive 
feature is enabled during a call.

4 Press OK .

Locking your phone

You can lock the phone feature of your 
smartphone to prevent unauthorized use of 
your mobile account. When your phone is 
locked, you must enter the lock code to 

TIP If you’re using a headset or hands-free 
device and your smartphone is in a pocket or 
bag, you can manually turn on Keyguard 
during a call to prevent accidental key 
presses.
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turn on your phone and to make or receive 
calls, except for emergency numbers.

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 Select the Security tab.

4 Select the Auto-lock list, and select 
either When phone turned off or 
Immediately.

5 Enter your current lock code or the 
default lock code and then select OK.

6 Select Change Lock Code.

7 Enter your current lock code or the 
default lock code, and then enter your 
new lock code twice to confirm it.

8 Select OK to return to Phone Settings.

9 Press OK .

Your phone locks when you turn it off and 
turn it back on or immediately, depending 
on the option you selected in step 4. If you 
try to make a call when your phone is 
locked, a dial pad appears for you to enter 
your lock code to unlock the phone. You do 
not need to enter your lock code to answer 
a call.

Locking your smartphone

To protect your personal information, you 
can lock the system so that you need to 
enter your password to access any of your 
information or use other features of 
your smartphone.

IMPORTANT If you lock your system, you 
must enter the exact password to unlock it. 

TIP The default lock code is the last four digits 
of your wireless phone number, or try 0000. If 
none of these work, call Verizon Wireless for 
assistance.
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If you enter an incorrect password, you are 
given another chance. Each time an 
incorrect password is entered, you are 
given progressively longer time periods 
between your chances to enter the 
password. If you forget the password, you 
need to perform a hard reset to resume 
using your smartphone. Performing a hard 
reset deletes all the entries in your 
smartphone. However, you can restore all 
previously synchronized info the next time 
you sync (see Synchronizing information).

1 Press Start  and select Settings.

2 On the Personal tab, select Lock .

3 On the Password tab, check the 
Prompt if device unused for box to 
turn on the password feature.

4 Select the first list, and then select how 
long a period of inactivity must pass 
before you are prompted to enter a 
password to unlock the system.

5 Select the Password type list, and then 
select a format for your password:

Strong alphanumeric: A strong 
alphanumeric password must contain at 
least 7 characters and must contain a 
combination of letters, numerals, and 

punctuation. You must press Option or 
Alt before entering numerals or 
punctuation.

Simple PIN: A simple PIN must contain 
at least 4 characters and includes 
numerals only. You do not need to press 
Option before entering the PIN 
numerals.

6 Select Password and enter your 
password.

7 Select Confirm and enter the password 
again.

8 (Optional) Select the Hint tab and enter 
a hint to help you recall your password.

9 Press OK .

TIP If you lock your smartphone and use a 
Simple PIN as the password, you can dial an 
emergency number by entering the number in 
the password field and pressing Phone/Send. 
You do not need to press Option before 
entering the number. However, if you select 
Strong alphanumeric as the password type, 
you must first press Option twice before 
entering an emergency number in the 
password field.
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Entering owner information

You can enter personal information that you 
want to associate with your smartphone, 
such as your name, company name, and 
phone number. You can also set whether 
you want this information to appear when 
you turn on your smartphone. If you lose 
your smartphone, this feature can help the 
person who finds it return it to you.

1 Press Start  and select Settings.

2 On the Personal tab, select Owner 

Information .

3 On the Identification tab, enter any of 
the information you want to include.

4 Select the Notes tab and enter any 
additional text you want to include.

5 Select the Options tab and check the 
boxes to indicate which info (if any) you 
want to appear on the screen when you 
turn on your smartphone.

6 Press OK .

System settings

Setting the date and time

Use Clock & Alarms Settings to set the 
time zone, time, and date for your home 
location and a location that you visit.

To set the display format for the date and 
time, see Setting display formats.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 On the Time tab, select Home.

TIP You can also display your Owner 
Information on your Today screen. See 
Selecting which items appear on your 
Today screen for details.
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4 Select the first list, and then select the 
time zone for your home location.

5 Select the hour, and then press Up  
or Down  to increase or decrease the 
hour setting. Repeat this process for the 
minute, seconds, and AM/PM settings.

6 Select the month, and then press Up  
or Down  to increase or decrease the 
month setting. Repeat this process for 
the date and year settings.

7 (Optional) Select Visiting and set the 
info for a location that you visit often.

8 Press OK .

9 If prompted, select Yes to accept your 
changes.

Synchronizing the date, time, and time 

zone with the network

You can set your smartphone to 
synchronize the date, time, and time zone 
with the Verizon Wireless network 
whenever your phone is on and you are 
inside a coverage area.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the More tab.

4 To keep the time on your smartphone 
synchronized with the time on the 
network at your current location, check 
the Enable local network time box. 
Uncheck the box for your smartphone to 
use its internal time setting regardless 
of the network at your current location.

5 To keep the date and time on your 
smartphone synchronized with the date 
and time in the time zone of your 
current location, check the Use 

network time zone box. Uncheck the 
box for your smartphone to use the 
internal location setting regardless of 
the network at your current location.
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Setting system alarms

System alarms let you set alarms that are 
not associated with a task or appointment. 
For example, you can use your smartphone 
as an alarm clock when you travel, or set 
alarms to remind you when it’s time to take 
medication or pick up the kids.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the Alarms tab.

4 Check a box to turn on that alarm.

5 Select the description next to the box 
you checked and enter a description for 
the alarm.

6 Tap the days of the week you want the 
alarm to go off. You can select multiple 
days for each alarm.

7 Tap the displayed time, select the time 
you want the alarm to go off, and then 
press OK .

8 Select the alarm  icon, and then 
check the boxes to select how you want 
the alarm to go off. You can choose a 
flashing light, a single sound, a 
repeating sound, or vibration.

9 Press OK  twice.

10 If prompted, select Yes to accept your 
changes.

Managing identity certificates

Your smartphone may include preinstalled 
certificates. Certificates are digital 
documents that are used to authenticate 

TIP To change the alarm sound, select the 
alarm sound icon, select the Play Sound list, 
and then select the alarm sound you want to 
use.
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and exchange information on networks. 
Certificates can be issued for a user, a 
device, or a service.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Certificates .

3 Select any of the following tabs:

Personal: Displays certificates that 
establish your identity when you log in 
to a secured network, such as a 
corporate network.

Intermediate: Displays certificates 
issued by the root whose purpose is to 
then issue personal certificates.

Root: Displays certificates that identify 
the computers, such as servers, to 
which you connect. These certificates 
help prevent unauthorized users from 
accessing your smartphone and 
information.

4 Press OK .

Enabling error reporting

Error Reporting sends info that helps 
diagnose application errors for devices 
running Windows Mobile® software. When 
an error is detected, a text file is created. 
You can review the file and choose 
whether you want it delivered to Microsoft 
technical support. The information is used 
by programming groups at Microsoft for 
quality control and is not used for tracking 
individual users or installations for any 
marketing purpose. The info that is 
collected is technical info about the state of 
your system when the error occurred. No 
documents (or any info contained in them) 
are intentionally sent with the report. To 
ensure further security, the report is 
transmitted via a secure connection and is 
kept confidential and anonymous in a 
limited-access database.

TIP To view detailed certificate information, 
highlight the certificate, press and hold 
Center on the 5-way, and then select View. To 
delete a certificate, highlight the certificate, 
press and hold Center on the 5-way, and then 
select Delete.
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Your smartphone must be connected to 
your computer when you send the error 
report—provided your computer is 
connected to the Internet.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Error Reporting .

3 Select whether you want to enable or 
disable error reporting.

4 Press OK .

How much storage space do I have left?

1 Press and hold OK .

2 Select any of the following tabs:

Main: Displays the amount of memory 
assigned to your applications and info, 
as well as the amount of memory in use 
versus the available memory.

Storage Card: Displays the amount of 
memory available on an expansion card 
that is inserted in the expansion slot on 
your smartphone.

Running Programs: Lists the 
applications that are in use on your 
smartphone. To switch to an application, 
highlight it and select Activate. To close 
an application, highlight it and select 
Stop. To close all open applications, 
select Stop All.

DID YOU KNOW? This error reporting method 
meets the privacy regulations of the European 
Union (EU) as well as the Fair Information 
Practice Principles of the Federal Trade 
Commission in the United States. To view the 
Fair Information Practice Principles, visit the 
Federal Trade Commission website at 
ftc.gov/reports/privacy3/fairinfo.htm.

TIP If storage memory is low, consider using 
an expansion card to store files (see Using 
expansion cards). If program memory is low, 
close some applications to avoid slow 
smartphone performance (see Closing 
applications).

http://www.ftc.gov/reports/privacy3/fairinfo.htm
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3 Press OK .

Optimizing power settings

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Power .

3 On the Battery tab, view the power 
remaining in your battery.

4 Select the Advanced tab and set 
whether your smartphone screen turns 
off automatically after a specified period 
of inactivity. You can assign different 
intervals for battery power and external 
power.

5 Press OK .

TIP An easy way to check the battery level is 
by tapping the Battery icon in the title bar.
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Turning wireless services on/off 

1 At the top of any screen, tap the 
signal-strength  icon and select 
Wireless Manager.

2 Select Bluetooth or Phone to turn that 
feature on or off. Select All to turn all 
wireless features on or off.

3 Press OK .

Connection settings

Managing ISP settings

Your smartphone is already set up to 
connect to the Internet using a high-speed 
data connection on the Verizon Wireless 
network. To connect to the Internet, simply 
start Internet Explorer Mobile.

For special situations, such as connecting 
to your internet service provider (ISP) or to 
a remote access server (RAS), you can set 
up another connection.

BEFORE YOU BEGIN Obtain the following 
information from your ISP or system 
administrator:

• ISP server phone number or access 
point

• Username

TIP To conserve additional battery power, 
adjust the display backlight setting. Press 
Start and select Settings. Select the System 
tab, and then select Backlight. On the Battery 
Power tab, set whether the display backlight 
turns off automatically after a period of 
inactivity. You can also select the External 
Power tab to turn off the backlight when your 
smartphone is connected to an external 
charging source.

TIP To change the settings for one of the 
displayed wireless features, press Menu (right 
softkey) and select the wireless feature you 
want to change.
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• Password

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections .

3 On the Tasks tab, select Manage 

existing connections.

4 Select the Modem tab. 

5 Highlight the connection you want to 
view or change, and then select Edit, or 
to create a new connection, select 
New.

6 Follow the onscreen instructions to edit 
or create the connection.

Connecting to a VPN

If you want to use your smartphone to 
access your corporate email account or 
other files on your corporate server, you 
may need to set up a VPN (virtual private 
network). A VPN enables you to log in to 
your corporate server through the 
company’s firewall (security layer).

BEFORE YOU BEGIN Check with your 
company’s system administrator to see if a 
VPN is required to access the corporate 
network. If you need a VPN, you 

must purchase and install a third-party VPN 
client to use this feature.

Ask your corporate system administrator 
for the following information:

• Your username and password

• Your server’s domain name

• Your server’s TCP/IP settings 

• Your server’s host name or IP address

1 Install your third-party VPN client (see 
Installing applications).

2 Press Start  and select Settings.

3 Select the Connections tab, and then 
select Connections .

4 On the Tasks tab, select Add a new 

VPN server connection.

5 Follow the onscreen instructions to 
enter the settings provided by your 
corporate system administrator.
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Setting up a proxy server

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections .

3 On the Tasks tab, select Set up my 

proxy server.

4 Check both boxes near the top of the 
screen.

5 Select Proxy server and enter the proxy 
server name.

6 Press OK .

Ending a data connection

If your service plan includes 
minutes-of-use fees for data connections, 
you can reduce costs by ending the data 
connection when you’ve finished browsing 
the web.

1 Use the stylus to tap one of the data 
connection icons (  or ) on the 
title bar.

2 Select Disconnect from the shortcut 
menu.

Submitting usage 
information to 
Microsoft

You can choose to anonymously send 
information about your smartphone usage 
to Microsoft. This information helps the 
company improve its Windows Mobile 
software. No personal information is 
submitted, you do not incur data charges, 
and participation is voluntary.

TIP To manually start a data connection on 
Verizon Wireless’s network or another 
network, go to Connections Settings, and on 
the Tasks tab, select Manage existing 

connections. Highlight the connection you 
want to start, press and hold Center on the 
5-way, and then select Connect from the 
shortcut menu.

TIP To change settings such as the port 
number, proxy server type, or credentials, 
select Advanced.
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1 Press Start  and select Settings.

2 Select the System tab, and then select 
Customer Feedback .

3 Select Send Feedback.
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CHAPTER

14

Troubleshooting
Although we can’t anticipate all the questions you might have, 
this chapter provides answers to some of the most commonly 
asked questions. For additional information and answers to 
other common questions, visit palm.com/us/support/treo/
treo700wxverizon/.

http://palm.com/us/support/treo/treo700wxverizon/
http://palm.com/us/support/treo/treo700wxverizon/
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Transferring info from 
another device

For information on transferring your info 
from a previous Windows Mobile® device 
or from a Palm OS® by ACCESS device to 
your new Palm® Treo™ 700wx smartphone, 
visit palm.com/us/support/treo/
treo700wxverizon/.

IMPORTANT Do not use a backup utility to 
transfer your info from another device to 
your new smartphone. This can cause your 
smartphone to malfunction.

Reinstalling the 
desktop software

If you have problems synchronizing using 
your desktop sync software, you may need 
to reinstall the software.

BEFORE YOU BEGIN Make sure your 
computer profile includes administrator 
rights to install software. In large 
organizations, these are usually granted 
by the system administrator.

1 Shut down your computer and turn it on 
again.

2 On your computer, click Start > Control 

Panel > Add or Remove Programs.

3 Remove your desktop software. For 
computers running Windows XP, the 
software is called Microsoft ActiveSync. 
For computers running Windows Vista, 
the software is called Windows Mobile 
Device Center.

DID YOU KNOW? You can purchase a third-party 
application that lets you run Palm OS® 
applications on your smartphone.

DID YOU KNOW? If you have questions about 
Windows Mobile, you can go to 
windowsmobile.com. Search for Palm devices 
for information.

http://www.windowsmobile.com
http://palm.com/us/support/treo/treo700wxverizon/
http://palm.com/us/support/treo/treo700wxverizon/
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4 Quit any active applications, including 
virus scanners and Internet security 
applications.

5 To reinstall the software, see Installing 
ActiveSync desktop software: 
Windows XP or Installing Windows 
Mobile Device Center: Windows Vista 
for detailed instructions.

Resetting your 
smartphone

Performing a soft reset

Performing a soft reset is similar to 
restarting a computer. If your smartphone 
is not responding or you have trouble 
synchronizing with your computer, a soft 
reset may help.

1 Disconnect your smartphone from the 
AC charger if it is connected.

2 If your smartphone responds to key 
presses, press and hold Power/

End  to turn off your phone.

3 If the screen display is on, press 
Power/End  to turn off the screen.

4 Use one hand to press the battery 

door release and use the other hand to 
slide the battery door downward to 
remove it from your smartphone.

5 Use the stylus tip to gently press the 
reset button on the back of your 
smartphone.

6 Wait for the progress bar on the Treo 
logo screen to fill before continuing to 
use your smartphone.

DID YOU KNOW? The Windows Mobile Getting 
Started CD installs the software and drivers 
that let you synchronize with Microsoft Office 
Outlook®. If you want to synchronize with a 
different personal information manager (PIM), 
you must install a third-party solution. Contact 
the PIM’s vendor to learn if software 
is available for your smartphone.
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Performing a hard reset

A hard reset erases all personal 
information, such as appointments, 
contacts, and tasks, as well as programs 
you have added, such as third-party 
software on your smartphone. Never do a 

hard reset without first trying a soft reset. 
You can restore previously synchronized 
information the next time you sync.

IMPORTANT Synchronize to restore your 
Outlook data, such as Outlook email, 
Calendar, Contacts, Notes, and Tasks. You 
can use a backup and restore solution. 
Make sure it’s an application that’s 
approved by Palm, such as the one 
included on the Windows Mobile Getting 
Started CD.

A hard reset can tell you whether a 
problem stems from your smartphone or 
from an application installed on it. If you do 

TIP You can also do a soft reset by removing 
the battery and reinserting it.

DID YOU KNOW? If the phone or the Bluetooth® 
wireless technology feature was on before a 
reset, these automatically turn on after the 
reset.

TIP Some third-party applications do not 
create a backup on your computer when you 
synchronize. If you do a hard reset, you may 
lose info in these applications and you need to 
reinstall the application on your smartphone 
after the hard reset. Please contact the 
application vendor to find out if your info is 
backed up during synchronization.

DID YOU KNOW? When you synchronize after a 
hard reset, the source folder in My 
Documents changes from Treo My 
Documents to WM_your name.
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not experience the problem after you 
perform a hard reset, the problem may be 
related to software you installed. See 
Third-party applications for suggestions on 
diagnosing third-party software issues.

1 Synchronize your smartphone with your 
computer so that your smartphone 
applications and info can be restored by 
synchronizing again after you perform 
the hard rest.

2 Use one hand to press the battery 

door release and use the other hand to 
slide the battery door downward to 
remove it from your smartphone.

3 If the screen is off, press Power/

End  to wake up the screen.

4 While pressing and holding Power/

End , use the tip of the stylus to 
gently press and hold the reset button 
on the back of your smartphone.

5 Continue pressing and holding both 
buttons until the “Erase all data?” 
prompt appears. 

6 Press Up  to confirm the hard reset.

7 Wait for the progress bar on the Treo 
logo screen to fill before continuing to 
use your smartphone.

8 (Optional) Synchronize to restore your 
previously synchronized info. If you use 
a backup utility, you may also need to 
restore a backup to recover additional 
info and settings.

Replacing the battery

Your smartphone comes with a replaceable 
battery. Be sure to use a replacement 
battery from Palm that is compatible with 
Treo 700wx models. Do not use a battery 
from any earlier model of smartphone.

1 Press Power/End  to turn off the 
screen.

2 Use one hand to press the battery 

door release and use the other hand to 
slide the battery door downward to 
remove it from your smartphone.

TIP Be sure to dispose of your old battery in an 
environmentally responsible and legal way. In 
some areas, disposal in household or 
business trash is prohibited. Visit palm.com/
environment for more information.

DID YOU KNOW? Your smartphone stores all 
your info even when you remove the battery.

http://www.palm.com/environment
http://www.palm.com/environment
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3 Place a finger in the notch between the 
stylus and the battery, and lift the 
battery at a 45-degree angle.

4 Align the new battery contacts with the 
phone contacts inside the battery 
compartment.

5 Insert the new battery into the 
compartment at a 45-degree angle, 
pressing it into place. Slide the battery 
door onto the back of the smartphone 
until it clicks into place.

6 Wait for the screen to turn on.

Performance

The applications are running slower than 

usual

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Memory .

3 Select the Running Programs tab. 

4 Select Stop All to close all your open 
applications.

5 Press OK .

Battery door 
release

Notch

Smartphone 
contacts

Battery 
contacts
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If the previous steps don’t fix the problem, 
try doing a soft reset (see Performing a soft 
reset). If the problem persists, follow these 
steps to turn off the Voice Command 
setting, if it is enabled:

1 Press Start  and select Settings.

2 On the Personal tab, select Voice 

Command .

3 Uncheck the Enabled box.

4 Press OK .

My battery seems to drain quickly

If you have a push email solution or if you 
have set up a schedule for wireless 
synchronization, check with your email 
provider or system administrator to make 
sure that the server is set up properly to 
work with your smartphone. Incorrect 

server setup can cause excessive drain on 
your battery.

For more tips on conversing battery life, 
see Maximizing battery life.

Screen

The screen appears blank

1 If you’re on a call, when the time period 
specified in Backlight Settings expires, 
the screen dims; one minute later, the 
screen automatically turns off. 
Press any key except Power/End to 
wake up the screen. Pressing Power/
End hangs up the call.

2 Look closely at the screen. If you can 
see a dim image, try adjusting the 
screen brightness (see Adjusting the 
brightness).

3 If that doesn’t work, perform a soft 
reset (see Performing a soft reset).

4 If that doesn’t work, connect your 
smartphone to the AC charger (see 
Charging the battery) and perform a soft 
reset again.

TIP Be sure that third-party applications are 
designed for Windows Mobile 6 Professional. 
Applications written for Windows Mobile 6 
Standard or earlier versions of Windows 
Mobile software do not work with your 
smartphone.

If you can try a free version of the software 
before purchasing it, you can test it first to 
make sure it works properly.
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5 If that doesn’t work, perform a hard 
reset (see Performing a hard reset).

The screen doesn’t respond accurately to 

taps or activates wrong features

1 Make sure there is no debris trapped 
under the edges of the screen.

2 Press Start  and select Settings.

3 Select the System tab, and then select 
Screen .

4 On the General tab, select Align 

Screen.

5 Tap the screen where indicated.

6 Press OK .

Network connection

Signal strength is weak

1 If you’re standing, move about 10 feet 
(3 meters) in any direction.

2 If you’re in a building, move near a 
window. Open any metal blinds.

3 If you’re in a building, move outdoors or 
to a more open area.

4 If you’re outdoors, move away from 
large buildings, trees, or electrical wires.

5 If you’re in a vehicle, move your 
smartphone so that it’s level 
with a window.

My smartphone won’t connect to the 

mobile network

1 Try the suggestions above for weak 
signals.

2 Turn off your phone and turn it on again 
(see Turning your smartphone on/off).

3 Perform a soft reset (see Performing a 
soft reset).

My phone seems to turn off by itself

If a system error and reset occur, the 
phone automatically turns on if it was on 

TIP If you are using a third-party application, 
make sure that the application supports 
240x240 screen resolution. 

TIP Become familiar with low coverage areas 
where you live, commute, work, and play so 
you know when to expect signal-strength 
issues.
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before the reset. However, if your 
smartphone can’t determine if your phone 
was on before the reset, it does not 
automatically turn on the phone (see 
Turning your phone on).

I can’t tell if data services are available 

The following icons appear in the title bar 
to indicate whether data services are 
available:

My smartphone won’t connect to the 

Internet

Your smartphone supports NationalAccess 
(1xRTT) or BroadbandAccess (EVDO) 
wireless data networks. To connect to the 
Internet, you must subscribe to data 
services with Verizon Wireless.

• Contact Verizon Wireless to verify that 
your subscription plan includes data 
services and that these services have 

You are in an area that supports 
NationalAccess (1xRTT) data 
services.

You are in an area that supports 
BroadbandAccess (EVDO) data 
services.

A NationalAccess data call is in 
progress. You can make calls, but 
you cannot receive calls; any 
incoming calls go to voicemail. 
When you make a call, the data 
transmission is automatically 
interrupted.

A BroadbandAccess data call is 
in progress. You can still make or 
receive calls. When you make or 
receive a call, the data 
transmission is automatically 
interrupted.

Your phone is connected to a 
NationalAccess network, but you 
are not actively transmitting data. 
You can still make or receive 
calls.

Your phone is connected to a 
BroadbandAccess network, but 
you are not actively transmitting 
data. You can still make or 
receive calls.
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been correctly activated. Verizon 
Wireless should also be able to tell you 
if there are any outages in your location.

• Press and hold Power/End  to turn 
off your phone, then press and hold the 
same button to turn it back on.

• Perform a soft reset (see Performing a 
soft reset).

• Confirm that data services are correctly 
configured on your smartphone by 
doing the following:

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections .

3 On the Tasks tab, select Manage 

existing connections.

4 If Verizon Wireless, National Access, or 
Broadband Access appears in the list, 
press OK . If not, contact Verizon 
Wireless for assistance.

I can’t send or receive text or multimedia 

messages

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

• Contact Verizon Wireless to verify that 
your plan includes messaging services, 
that these services have been correctly 
activated, and that they are available at 
your location. Verizon Wireless should 
be able to tell you if messaging services 
have been experiencing transmission 
delays.

• If possible, contact the recipient or 
sender of the message, and make sure 
the receiving device can handle the type 
of message you’re sending.

• If a text message arrives but does not 
display a notification, perform a soft 
reset (see Performing a soft reset).

I can’t make or receive calls using a 

hands-free device with Bluetooth® 

wireless technology

Verify all of the following:

• The Turn on Bluetooth box is checked 
in Bluetooth Settings (see Entering 
basic Bluetooth settings).

• Your Bluetooth device is charged and 
turned on.

• Your smartphone is within range of the 
hands-free device. Bluetooth range is 
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up to 30 feet (10 meters) in optimum 
environmental conditions, which include 
the absence of the following: obstacles, 
radio interference from nearby 
electronic equipment, and other factors.

• The Bluetooth Settings screen is closed.

• You are away from other devices using 
the 2.4 GHz radio frequency, such as 
cordless phones, microwaves, and 
Wi-Fi equipment. If this is impossible, 
move the phone closer to the 
hands-free device.

• The device specifications are 
compatible with your smartphone.

I lost the connection between my 

smartphone and my Bluetooth headset

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Bluetooth .

3 Select the Devices tab.

4 Select your headset name from the list.

5 In Partnership Settings, make sure the 
Hands Free option box is checked.

6 Select Save.

7 Highlight the headset name.

8 Press and hold Center  to open the 
shortcut menu, and then select Set as 

Hands-Free.

9 Test your headset by making or 
receiving a call.

If the headset still doesn’t work, delete the 
existing partnership and create a new one.

To delete the partnership:

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Bluetooth .

3 Highlight the headset device name.

4 Press and hold Center  to open the 
shortcut menu, and then select Delete.

5 Create a new partnership (see 
Connecting to devices with Bluetooth® 
wireless technology.

Synchronization: 
Overview

Synchronization enables you to back up the 
information on your smartphone onto your 
computer or your server. If you ever need 
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to perform a hard reset or otherwise erase 
all your information on your smartphone, 
you can synchronize your smartphone with 
your computer to restore the info. To make 
sure you always have an up-to-date backup 
of your info, synchronize frequently.

You can synchronize email and other 
information directly with Microsoft 
Exchange Server 2007, or Exchange Server 
2003 with Service Pack 2, using Microsoft 
Exchange ActiveSync®, or you can 
synchronize your smartphone with your 
computer, using desktop sync software.

Synchronization: 
Desktop sync 
software

This section covers issues with 
synchronizing using the desktop sync 
software that came with your smartphone. 
If you have a Windows XP computer, the 
desktop sync software is called 
ActiveSync® desktop software. If you have 
a Windows Vista computer, the desktop 
sync software is called Windows Mobile 
Device Center.

NOTE See Synchronization: Exchange 
ActiveSync (wireless synchronization) for 
help with direct wireless synchronization 
with an Exchange server.

The desktop sync software does not 

respond to sync attempt

As you complete the following steps, 
synchronize after each step. If the 

DID YOU KNOW? You can go to the Windows 
Mobile website for more information at 
windowsmobile.com.

DID YOU KNOW? A common cause of sync 
problems is the presence of protective 
software, such as VPNs or firewalls, on your 
computer or network.

http://www.windowsmobile.com
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synchronization is successful, you do not 
need to complete the remaining steps.

1 Verify that the USB sync cable is 
securely connected at all points (see 
Setting up your computer for 
synchronization).

2 Make sure that all of the files you’re 
trying to sync are closed on both your 
computer and your smartphone.

3 On a Windows XP computer, look for 
the ActiveSync  icon at the top of 
your smartphone screen and the 
ActiveSync  icon in the taskbar on 
your computer to make sure ActiveSync 
desktop software is running on your 
computer. On a Windows Vista 
computer, look for the connection  
icon at the top of your smartphone 
screen.

If the correct icons are not displayed, do 
the following:

Smartphone:

• Press Start , select Programs. 
and select ActiveSync .

• Press Menu  (right softkey) and 
select Connections.

• Make sure the Synchronize all PCs 

using this connection box is 
checked, and that USB is selected 
from the list.

Windows XP computer:

• Click Start.
• Navigate to Programs, and then 

select Microsoft ActiveSync.
Windows Vista computer:

• Click Start.

• Select All Programs, and then select 
Windows Mobile Device Center.

4 Do one of the following:

Windows XP computer: 

• Double-click the ActiveSync  icon 
in your taskbar. 

• From the File menu, select 
Connection Settings.

• Make sure the Allow USB 

connections box is checked, and then 
click Connect.

Windows Vista computer: 

• Click Start, select All Programs, and 
then select Windows Mobile Device 

Center.
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• Select Connect without setting up 

your device, and then select 
Connection settings.

• Make sure the Allow USB 

connections box is checked, and click 
Connect.

5 Perform a soft reset (see Performing a 
soft reset).

6 Restart your computer and make sure 
the desktop sync software is running.

7 If problems persist and you’re 
synchronizing through a USB hub, try 
connecting the sync cable to a different 
USB port or directly to your computer’s 
built-in USB port.

8 If you’re already synchronizing through a 
built-in USB port on the front of your 
computer, move the sync cable to a 
USB port on the back of your computer 
if your computer has one.

9 Uninstall the desktop software that 
came with your smartphone, and then 
repeat the installation process (see 
Reinstalling the desktop software).

10 For a Windows XP computer only, 
delete the existing partnership between 
your smartphone and your computer 

and create a new one by doing the 
following steps in turn:

• Disconnect your smartphone and your 
computer from the sync cable.

• Double-click the gray ActiveSync  
icon in the taskbar in the lower-right 
corner of your computer screen.

• Click File, and then click Delete 

Mobile Device. When asked to 
confirm, click Yes.

• Connect your smartphone and your 
computer to the sync cable.

• When the Synchronization Setup 
Wizard appears, follow the steps to 
establish a sync relationship between 
your smartphone and your computer.

11 If your organization uses a firewall or a 
VPN connection, synchronizing with 
ActiveSync may not work. For a 
Windows XP computer only, go to 
microsoft.com and search for the 
following topics to help with specific 
firewall setup situations:

• ActiveSync USB Connection 
Troubleshooting Guide

• ActiveSync with Sygate Personal 
Firewall

http://www.microsoft.com
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• ActiveSync with TrendMicro PC-cillin 
Internet Security

• ActiveSync with Norton Personal 
Firewall

• ActiveSync with Zone Alarm Security 
Suite

• ActiveSync with McAfee Personal 
Firewall

• ActiveSync with Windows Firewall

12 Verify with your computer hardware 
vendor that your operating system 
supports your internal USB controller.

Synchronization finishes but info doesn’t 

appear where it should

• With the included desktop sync 
software, your smartphone can 
synchronize with the root folders of 
Microsoft Office Outlook Contacts, 
Calendar, Tasks, and Notes (Outlook 
sold separately; a free trial version is 
available for download from the 
Windows Mobile Getting Started CD). If 
you want to synchronize with a global 
Exchange Address Book, you must copy 
the addresses to your local Contacts list 
in Microsoft Office Outlook (right-click 

the addresses and select Add to 

Personal Address Book).

• Microsoft Office Outlook subfolders and 
public folders are not accessible with 
the included software. You may want to 
use a third-party solution instead.

• If you’re trying to sync offline, be sure 
to set your Microsoft Office Outlook 
Calendar, Contacts, Notes, and Tasks to 
be available offline.

• If you’re still having problems, try the 
following:

1 Make sure you’re synchronizing with 
the intended desktop personal 
information manager (PIM). The 
Windows Mobile Getting Started CD 
lets you synchronize with Microsoft 
Office Outlook for Windows. If you use 
a different PIM, you need to install 
third-party software to synchronize. For 
more information, consult the company 
that makes the PIM.

2 Open the desktop sync software on 
your computer, and make sure the Files 
synchronization option is selected (see 
Changing which applications sync).
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3 Uninstall the desktop sync software, 
reboot your computer, and then repeat 
the installation process (see Reinstalling 
the desktop software).

Synchronization starts but doesn’t finish

Make sure that you installed the desktop 
software that came with your smartphone. 
If you’re not sure whether this software is 
installed, reinstall it (see Reinstalling the 
desktop software).

My video and music files won’t sync

1 Make sure you have Windows Media 
Player 10 or later installed on your 
computer.

2 Reinstall the desktop sync software 
(see Reinstalling the desktop software). 
Media file synchronization fails if you 
installed the desktop sync software 
before you installed Windows Media 
Player.

My appointments show up in the wrong 

time slot after I sync

1 Make sure that you installed the 
desktop sync software that came with 
your smartphone. If you’re not sure 

whether this software is installed, 
reinstall it (see Reinstalling the desktop 
software).

2 Open Microsoft Office Outlook and 
correct the wrong entries.

3 Manually enter any information you 
added to your smartphone since the last 
time you synchronized.

4 Synchronize your phone and your 
computer.

My scheduled sync doesn’t work

By default, a scheduled sync does not work 
while you are roaming. This is to prevent 
roaming charges on your account. If 
roaming charges are not a concern, follow 
these steps to continue your sync schedule 
while roaming:

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right softkey) and 
select Schedule.

4 Check the Use above setting when 

roaming box.

5 Press OK .
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An alert tells me that ActiveSync 

encountered a problem on the server

There is a temporary problem with the 
server or the server may be temporarily 
overloaded. Try again later, and if the 
problem persists, contact your system 
administrator.

An alert tells me that there is not enough 

free memory to sync my info

The ActiveSync application on your 
smartphone ran out of storage space. Try 
the following:

1 Go to Memory Settings and close all 
running programs (see Closing 
applications).

2 If the problem persists, see Making 
room on your smartphone for 
suggestions on other ways to free up 
space on your smartphone.

An alert tells me that ActiveSync 

encountered a problem with [item type] 

[item name]

An error occurred during the sync of a 
single item. This error can usually be 
corrected only by removing the item that 

caused the error. If you sync again to see if 
the error persists, be aware that items 
causing this type of error are skipped and 
do not show up again.

My Today screen settings are not restored 

after a hard reset

Settings such as the background image and 
plug-in choices are not backed up during 
synchronization, so they can’t be restored 
after a hard reset. If you use a backup 
utility, you may be able to restore a backup 
to recover your Today screen setting and 
other additional info.

Synchronization: 
Exchange ActiveSync 
(wireless 
synchronization)

This section covers issues with direct 
wireless synchronization with an Exchange 
server. See Synchronization: Desktop sync 
software for help with synchronizing using 
your desktop sync software.
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An alert tells me that the server could not 

be reached

Your smartphone had to wait too long to 
connect to the Exchange server. The 
connection may have been lost, the server 
may be temporarily overloaded, or the 
server may have encountered an internal 
error. Check your Exchange server name 
and proxy server settings (see Setting up 
wireless synchronization), and try 
again later.

An alert tells me that my account 

information could not be detected

When you set up the Exchange server sync 
options, the credentials page was left 
blank. Correct the credentials (see Setting 
up wireless synchronization), or set up your 
smartphone to sync only with a computer, 
and try to sync again.

An alert tells me the device timed out 

while waiting for credentials

The Exchange server credentials screen 
was left open too long. Reenter the 
Exchange server credentials, and try to 
sync again.

Email

I have problems using my account

Occasionally you may experience problems 
using an email account after you set it up. If 
you followed the account setup procedure 
(see Setting up email) and are experiencing 
problems in using the account, verify that 
the account complies with your email 
provider’s requirements by following 
these steps:

• Verify both your password and your 
username for your email account.

• Some email service providers require 
you to be on their network to use your 
email account. If this is the case, be 
sure to use your provider’s network as 
the connection type for the account.

TIP If you are synchronizing with an Exchange 
server and you’re unable to change your lock 
settings, check with your system 
administrator to find out if a systemwide 
locking policy is in place.
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• Some email service providers have 
other requirements specific to their 
service. For example, Yahoo! requires 
you to set up POP mail forwarding for 
your Yahoo! account to download email 
messages to your smartphone. Check 
with your service provider to see if any 
provider-specific requirements exist.

• Service provider settings frequently 
change. If your email account was 
working but you are currently 
experiencing problems, check with your 
service provider to see if any of the 
account settings have changed.

I have problems sending and receiving 

email

Short periods of time when email is 
unavailable are common due to server 
problems or poor wireless coverage. If you 
have problems sending or receiving mail 
for an extended period of time, check with 
your ISP or email service provider to verify 
that the service is working properly.

Scheduled email synchronization is not 

working

If email synchronization is occurring and 
you turn your smartphone off or the 
connection to your email service provider is 
disconnected, the synchronization fails.

• Check the synchronization schedule to 
make sure that email sync is set to 
occur at the expected day and time. See 
Setting the synchronization schedule for 
details.

• Press Start , select Programs, and 
then select ActiveSync .

• Press Menu  (right softkey) and 
select Configure Server. 

• Make sure the Save password box is 
checked. This is required for over-the-air 
synchronization.

I have problems sending email

If you are able to receive email messages 
but cannot send them, try the following 
steps, in turn:

• Make sure your ISP or email provider 
allows you to access email on a 
smartphone. Some providers do not 
offer this option at all; other providers 
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require an upgrade for accessing email 
on a smartphone.

• Press Start , select Programs, and 
then select ActiveSync . Press 
Menu  (right softkey) and select 
Configure Server. Make sure the This 

server requires an encrypted (SSL) 

connection box is checked.

• Enter the name of a different outgoing 
mail server for sending mail. Many ISPs, 
such as cable companies, require that 
you have an Internet connection to their 
network to send email through their 
servers. In this case, you can almost 
always receive email from these 
accounts, but if you want to send email, 
you must send it through another server 
(see Setting up a POP/IMAP account in 
the Messaging application: Other email 
providers).

My vCard or vCal email attachment isn’t 

forwarding correctly

Microsoft Office Outlook provides several 
features including vCard and vCal that work 
with email client software on a Windows 
computer. For these features to work 
correctly, the email client software must be 

properly set up. Follow these steps to 
check the settings:

1 On your computer, click Start and 
select Settings.

2 Select Control Panel.

3 Select Internet Options, and then click 
the Programs tab.

4 Make sure that the email field is set to 
the correct email client software. 

5 Click OK.

6 Start the email client software and 
make sure it is configured as the default 
MAPI client. Consult the documentation 
for your desktop email application for 
more information.

When I sync with my Exchange server my 

info is not downloading to my 

smartphone

Check with your system administrator to 
obtain the name of the mail server that 
offers you wireless access to the corporate 
mail system. If you cannot obtain the name 
of this server (some companies do not give 
it out, because they do not want wireless 
access to their servers), you cannot use 
Exchange ActiveSync to synchronize with 
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the Exchange server. You can also check 
the following setting:

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right softkey) and 
select Configure Server.

4 Make sure the This server requires an 

encrypted (SSL) connection box is 
checked.

Web

I can’t access a web page

First, make sure you have Internet access:

1 Open Internet Explorer Mobile and try 
to view a web page you’ve loaded 
before. To ensure that you’re viewing 
the page directly from the Internet, 
press Menu  (right softkey) and 
select Refresh.

2 After confirming your Internet 
connection, try to view the page in 
question again. If it comes up blank, 
press Menu  (right softkey) and 
select Refresh.

If you’re still having trouble, the page may 
contain elements that are not supported by 
Internet Explorer Mobile, such as Flash, 
Shockwave, VBScript, WML script, and 
other plug-ins.

Some websites use a redirector to their 
true home page. For example, if you enter 
the address palm.com/support, it may 
resolve to palm.com/intl/support/select.epl. 
If Internet Explorer Mobile can’t follow the 
redirect, try using a desktop browser to 
see the landing page of the redirector, and 
enter that address in Internet Explorer 
Mobile.

An image or map is too small on my 

smartphone screen

Internet Explorer Mobile has several 
viewing modes: One Column, Default, 
Desktop, and Full Screen. Switch to 
Desktop to see the full-size image (see 
Viewing a web page).

TIP Your smartphone can open your email 
application when you select an email address 
on a web page. If nothing happens when you 
select the link, try setting up your email 
application first (see Setting up email).

http://palm.com/support/
http://palm.com/intl/support/select.epl/
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A secure site refuses to permit a 

transaction

Some websites don’t support certain 
browsers for transactions. Please contact 
the site’s webmaster to make sure the site 
allows transactions using Internet Explorer 
Mobile.

Camera

Here are some tips for taking good pictures 
with the built-in camera:

• Clean the camera’s lens with a soft, 
lint-free cloth.

• Take pictures in bright lighting 
conditions. Low-light images may be 

grainy, due to the sensitivity of the 
camera.

• Hold the camera as still as possible. Try 
supporting your picture-taking arm 
against your body or a stationary object 
(such as a wall).

• Keep the subject of the pictures still. 
Exposure time is longer with lower light 
levels, so you may see a blur.

• For best results, verify that you have the 
brightest light source coming from 
behind you, lighting the subject’s face. 
Avoid taking indoor pictures with the 
subject in front of a window or light.

• Make sure the subject is at least 
18 inches (0.5 meters) away from the 
camera to ensure good focus.

Remember that when you synchronize 
with a Windows computer, your Camera 
images are stored in the C:\Documents 
and Settings\<Username>\My 
Documents\Treo My Documents folder on 
your hard drive (see Camera).

The Camera preview image looks strange

Some third-party applications overwrite the 
color settings on your smartphone with 

DID YOU KNOW? Pictures are 16-bit color. 
Resolution settings range from the low end of 
VGA (160 x 120 pixels) to a high end of 
1.3 megapixels (1280 x 1024). Video resolution 
settings range from a low end of 176 x 144 
pixels to a high end of 352 x 288 pixels. You 
can change the resolution setting by pressing 
Menu (right softkey) and selecting Resolution 
(still images) or Quality (video).
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their own 8-bit color settings. This can 
affect the Camera Preview Mode. Delete 
third-party applications one by one until the 
preview image improves (see Removing 
applications).

Third-party 
applications

Sometimes third-party applications can 
cause conflicts on your smartphone. 
Third-party applications that modify 
wireless features may affect the 
performance of your smartphone and may 
require extra troubleshooting. Use caution 
when installing the following types of 
applications:

• Ringtone managers

• Caller ID applications

• Instant messaging

• Applications that modify when your 
phone or data connections turn on or off 
and how your phone behaves

If you recently installed an application and 
your smartphone seems to be stuck, try 
the following:

1 Perform a soft reset (see Performing a 
soft reset).

2 Make sure the third-party application is 
compatible with the Windows Mobile 6 
Professional operating system on your 
smartphone.

3 Delete the most recently installed 
application from your smartphone (see 
Removing applications).

4 If the problem persists, perform another 
soft reset.

5 If possible, synchronize or use a backup 
utility to back up your most recent info.

6 Perform a hard reset (see Performing a 
hard reset).

7 Synchronize or restore your backup to 
restore the info in your built-in 
applications.

8 If the problem is resolved, begin 
reinstalling your third-party applications 
one at a time.
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9 If the problem recurs, delete the last 
application you installed and report the 
problem to its developer.

Getting more help

Contact the vendor of any third-party 
software if you require further assistance.

Making room on your 
smartphone

If you store a large amount of information, 
or install many third-party applications, the 
internal memory on your smartphone may 
fill up. Here are some common ways to 
clear space on your smartphone:

• Camera: Large images or videos take 
up a lot of memory. Move images to an 
expansion card (sold separately) or 

delete images from your smartphone 
(see Pictures & Videos).

• Messaging: Multimedia content and 
email attachments can consume 
excessive memory. Move multimedia 
content and attachments to an 
expansion card, or delete large files 
from your smartphone (see Deleting 
messages and Deleting a single 
message). You may also want to empty 
the deleted items folder.

• Internet: If you save links to pages 
you’ve visited in Internet Explorer 
Mobile, you may want to clear all recent 
pages (see Customizing your Internet 
Explorer Mobile settings).

• Third-party applications: You can 
delete infrequently used applications or 
move them to an expansion card (see 
Moving info between your smartphone 
and an expansion card using File 
Explorer).

Also, remember that your smartphone 
includes an expansion card slot, and that 
you can store applications and 
information on expansion cards. However, 
you still need free memory on the 

TIP Remember that not all third-party 
applications were written with the Treo 700wx 
smartphone keyboard and 5-way navigator in 
mind. You may encounter strange behavior or 
errors in these applications if you use the 
keyboard and the 5-way navigator.
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smartphone itself to run applications from 
an expansion card.

Voice quality

Is the other person hearing an echo?

• Try decreasing the volume on your 
smartphone to avoid coupling 
or feedback on the other person’s end. 
This applies to both the speakerphone 
and to the handset earpiece.

• Position the smartphone closer to your 
ear to prevent sound leaking back to the 
microphone. Keep your hand away from 
the microphone hole, which is on the 
lower-right side of your smartphone.

• If you’re using Speakerphone mode 
with your smartphone lying on a flat 
surface, try turning the smartphone 
“face down” (screen facing the 
surface).

Are you hearing your own voice echo?

Ask the other person to turn down their 
volume or to hold the phone closer to 
their ear.

Is your voice too quiet on the other end?

Be sure to hold the bottom of the 
smartphone, or the hands-free 
microphone, close to your mouth.

Check the signal-strength indicator. If the 
signal is weak, try to find an area with 
better coverage.
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Terms

1xRTT (Single carrier [1x] radio 

transmission technology)

A wireless technology that can provide fast 
data transfer and Internet access with 
average speeds of 60–80Kbps and bursts 
of up to 144Kbps. Also called 
NationalAccess.

A2DP (Advanced Audio Distribution 

Profile)

A technology that defines how high-quality 
audio (stereo or mono) is streamed from 
one device to another over a Bluetooth® 
wireless technology connection, such as 
music streamed from a mobile phone to a 
wireless headset.

ActiveSync®

The software on your Palm® Treo™ 700wx 
smartphone that exchanges and updates 
the information on your smartphone with 
the information on your computer. 

ActiveSync desktop software

The software on your Windows XP 
computer that exchanges and updates the 

information on your computer with the 
information on your smartphone. To open 
ActiveSync on your computer, double-click 
the ActiveSync icon in the taskbar in the 
lower-right corner of your screen. If the 
icon does not appear, click Start, click All 

Programs (or navigate to the Programs 
group), and then select Microsoft 

ActiveSync. See Installing ActiveSync 
desktop software: Windows XP.

auto-off interval

The time of inactivity that passes before 
the screen on your smartphone turns off. 
The wireless features on your smartphone 
are unaffected by this setting. See 
Optimizing power settings.

beam

The process of sending or receiving an 
entry or application using the infrared port 
on your smartphone or using Bluetooth® 
wireless technology. See Beaming 
information.

Bluetooth® wireless technology

Technology that enables devices such as 
smartphones, mobile phones, and 
computers to connect wirelessly to each 
other so that they can exchange 
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information over short distances. For more 
info, visit bluetooth.com. See Connecting 
to devices with Bluetooth® 
wireless technology.

BroadbandAccess

A wireless broadband technology that is 
designed for very high speed data transfer, 
with average download speeds of 400 to 
600Kbps, and is capable of reaching 
speeds up to 1.8Mbps and upload speeds 
up to 156Kbps. Also called EVDO.

desktop software

A Personal Information Manager (PIM) 
application for computers, such as 
Microsoft Outlook®, that helps you manage 
your personal information and keep it 
synchronized with your smartphone. See 
Installing ActiveSync desktop software: 
Windows XP or Installing Windows Mobile 
Device Center: Windows Vista.

dialog box

A set of options and command buttons that 
is enclosed by a border and that enables 
you to carry out a specific task.

EVDO (Evolution Data Optimized)

A wireless broadband-like technology that 
is designed for very high speed data 
transfer, with average download speeds of 
400 to 600Kbps. Verizon Wireless refers to 
this service as BroadbandAccess.

infrared (IR)

A way of transmitting information using 
light waves. You use the IR port on 
your smartphone to transfer information 
between other IR devices within a 
short radius. See Beaming information.

lithium-ion (li-ion)

The rechargeable battery technology used 
in your smartphone. See Charging the 
battery.

Microsoft Exchange ActiveSync®

Technology that allows your smartphone to 
synchronize email, contacts, calendar 
events, and tasks wirelessly with Microsoft 
Exchange Server 2003 or 2007. See Setting 
up wireless synchronization.

MMS (Multimedia Messaging System)

An enhanced messaging system that 
enables you to send pictures, animations, 
and ringtones almost instantly. See 

http://www.bluetooth.com
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Creating and sending a multimedia 
message.

Mobile Device

The component on your Windows XP 
computer that enables you to install 
applications and other information on your 
smartphone. To access it, open Windows 
Explorer or My Computer and look for the 
icon that represents your smartphone. See 
Installing applications from your computer.

NationalAccess

A wireless technology that can provide fast 
data transfer and Internet access with 
average speeds of 60–80Kbps and bursts 
of up to 144Kbps. Also called 1xRTT.

partnership

The connection that you make between 
two devices by means of Bluetooth 
wireless technology. The devices recognize 
each other because each device finds the 
same passkey on the other device. After 
you create a partnership between the 
devices, you no longer need to enter the 
passkey. Partnership is also known as 
paired relationship, pairing, trusted device, 
and trusted pair on some devices. See 

Connecting to devices with Bluetooth® 
wireless technology.

Phone Off

Appearing on the Today screen, this 
indicates that your smartphone is not 
connected to any network, and you cannot 
make calls except those to emergency 
numbers. You can still use the organizer 
features, however. See Turning your 
phone on.

piconet

An ad-hoc network of devices that uses 
Bluetooth wireless technology to connect 
one master device with up to seven active 
slave devices. The network can include up 
to 255 inactive, or parked, slave devices, 
which the master device can bring into 
active status at any time.

PIM (personal information manager)

A genre of software that includes 
applications such as Microsoft Outlook, 
Palm® Desktop software, Lotus Notes, and 
ACT!. PIMs generally store contacts, 
schedules, tasks, and memos. 
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PIN (personal identification number)

A password you can use to secure your 
smartphone.

Secure Sockets Layer (SSL)

A security protocol that enables you to 
send personal information in a more secure 
manner over the Internet.

SMS (Short Messaging Service)

The service that exchanges short text 
messages almost instantly between 
mobile devices. Your smartphone can send 
and receive text messages while you are 
on a call. See Creating and sending a text 
message.

streaming

Technology that enables you to access 
media content—for example, watch video 
or listen to an audio program—directly 
from the Internet on your smartphone 
without needing to download and a save a 
file on your smartphone. See Viewing a 
video.

synchronization

The process in which information that is 
entered or updated on your smartphone, 
your computer, or a server is automatically 

updated in one of the other locations either 
wirelessly or by means of a cable 
connection. See Synchronizing information.

username

The name associated with your 
smartphone that distinguishes it from 
other Windows Mobile® devices. If you 
install the desktop software, you are asked 
to give your smartphone a username. If 
you only synchronize wirelessly using 
Microsoft Exchange ActiveSync, you do not 
need to give your smartphone a username. 
See Installing ActiveSync desktop 
software: Windows XP or Installing 
Windows Mobile Device Center: Windows 
Vista.

Windows Mobile

The operating system of your Treo 700wx 
smartphone. Your smartphone uses 
Windows Mobile® 6 Professional edition. 
When installing third-party applications to 
your smartphone, be sure to install only 
apps that are written for Microsoft 
Windows Mobile 6 Professional. Apps 
designed for Microsoft Windows Mobile 6 
Standard or any edition of Windows Mobile 
5.0 software are not compatible with your 
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Treo 700wx smartphone. See Installing 
third-party applications.

Windows Mobile Device Center

The software on your Windows Vista 
computer that enables you to synchronize 
content and manage music, pictures, and 
videos between your smartphone and your 
computer. To open Windows Mobile 
Device Center on your computer, click 
Start, click All Programs, and select 
Windows Mobile Device Center. See 
Installing Windows Mobile Device Center: 
Windows Vista.
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Important safety and 
legal information
FCC Statement 

This equipment has been tested and found to comply with the limits 
for a Class B computer peripheral, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different 
from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

This device complies with part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) This device may not cause 
harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

RF Safety Exposure 

Radio Frequency Energy (SAR): Radio transmitting devices radiate 
Radio Frequency (RF) energy during their operation. RF energy can be 
absorbed into the human body and potentially can cause adverse 
health effects if excessive levels are absorbed. The unit of 
measurement for human exposure to RF energy is “Specific 
Absorption Rate” (SAR).

The Federal Communications Commission (FCC), Industrie Canada 
(IC), and other agencies around the world have established limits that 
incorporate a substantial safety margin designed to assure the safety 
of all persons using this equipment.

In order to certify this unit for sale in the US, Canada and Europe this 
unit has been tested for RF exposure compliance at a qualified test 
laboratory and found to comply with the regulations regarding 
exposure to RF Energy.

SAR was measured with the unit transmitting at its maximum 
certified RF power. Often, however, during normal operation the unit 
will transmit much less than maximum power. Transmit power is 
controlled automatically and, in general is reduced as you get closer 
to a cellular base station. This reduction in transmit power will result 
in a lower RF energy exposure and resulting SAR value.

FCC RF Safety Statement 

In order to comply with FCC RF exposure safety guidelines, users 
MUST use one of the following types of bodyworn accessories:

• A Palm® brand body-worn accessory that has been tested for 
SAR compliance and is intended for use with this product.

• An accessory that contains NO metal (snaps, clips, etc) and 
provides AT LEAST 1.5 cm of separation between the users body 
and the unit.

Do NOT use the device in a manner such that it is in direct 
contact with the body (i.e. on the lap or in a breast pocket). Such use 
will likely exceed FCC RF safety exposure limits. See 
fcc.gov/oet/rfsafety/ for more information on RF exposure safety.

The Palm® Treo™ 700wx smartphone may be used with a Wi-Fi® SDIO 
card; however, the user must ensure that the SDIO Wi-Fi card has 
been approved by the FCC for use with the Treo 700wx smartphone. 
For a list of SDIO Wi-Fi cards approved by the FCC for use with the 
Treo 700wx smartphone, please go to 
palm.com/us/support/treo/treo700wxverizon/.

If using a SDIO Wi-Fi card not approved for use with the Treo 700wx 
smartphone by the FCC, the user must turn off the phone (CDMA 
radio) on the Treo 700wx smartphone. 

http://www.fcc.gov/oet/rfsafety/
http://palm.com/us/support/treo/treo700wxverizon/
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Use of an SDIO wireless transmitter that is not approved in 
conjunction with the phone (CDMA radio) is not authorized by the 
FCC and may exceed FCC RF exposure guidelines.

Responsible party

(North America) (Europe)
Palm, Inc. Roy Bedlow
950 W. Maude Ave. Buckhurst Court 
Sunnyvale, CA 94085 London Road
USA Wokingham, Berkshire RG40 1PA,
palm com UK

Declaration of Conformity

We, Palm, Inc., declare under sole responsibility that the product:

Model name: Treo 700wx

Description: PDA phone

Palm declares that the above model of Treo 700wx smartphone is 
compliant with the regulations below. The declaration applies to the 
smartphone and its associated accessories (power supply, headset, 
and USB cable) where applicable.

For SAR values when used with a SDIO Wi-Fi card go to: 
palm.com/us/support/treo/treo700wxverizon/.

FCC OET Bulletin 65 Supplement C

FCC ID: O8FJIMI

IC ID: 3905A-JIMI 

Is in conformity with the following standards and/or other normative 
document:

• ETSI EN 301 511

• ETSI EN 301 908-1

• ETSI EN 301 908-2

• ETSI EN 300 328

• ETSI EN 301 489-1/-7/-17/-24

• EN60950-1

• EN 50360

We hereby declare that the above named product is in conformance 
to all essential requirements of the RTTE Directive 1999/5/EC.

The conformity assessment procedure referred to Article 10 and 
detailed in Annex IV of directive 1999/5/EC has been related to 
Articles:

• R&TTE Article 3.1 (a) Health and Safety

• R&TTE Article 3.1 (b) EMC

• R&TTE Article 3.2 Spectrum Usage

Identification mark 0984 (notified body) CE.

This identification mark is permanently provided on the device label.

The technical documentation relevant to the above equipment will be 
held at:

Palm, Inc. 
950 W Maude Avenue
Sunnyvale, CA. 94085
U.S.A.

Maximum Scaled SAR Values (W/kg)

Band  CDMA Cellular  CDMA PCS

Head SAR
(Held to Ear)

(W/Kg)
1.26

(W/Kg)
1.26

Body SAR
(Worn)

(W/Kg)
1.01

(W/Kg)
.55

http://www.palm.com
http://palm.com/us/support/treo/treo700wxverizon/
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Person responsible for making this declaration:

David Woo/Sr Compliance Engineer
Sunnyvale/August 31, 2006

Antenna Care/Unauthorized Modifications 

Use only the supplied integral antenna. Unauthorized antenna 
modifications or attachments could damage the unit and may violate 
FCC regulations. Any changes or modifications not expressly 
approved by the party responsible for compliance could void the 
user’s authority to operate the equipment.

Potentially Unsafe Areas 

Potentially explosive atmospheres: Turn off your smartphone when 
you are in any areas with a potentially explosive atmosphere, such as 
fueling areas (gas or petrol stations) or storage facilities for fuel or 
chemicals.

Declaration of Conformity

Treo 700wx

Palm declares that the above model of Treo 700wx smartphone is 
compliant with the regulations below. The declaration applies to the 
smartphone and its associated accessories (power supply, headset, 
and USB cable) where applicable. 

Bluetooth® Qualification Program

Information about this listing can be found at: 
https://programs.bluetooth.org/tpg/listings.cfm.

Bluetooth® QD ID B012406

Maximum Scaled SAR Values (W/kg) FCC

Band GSM
850

 GSM
1900 

WCDMA
850

WCDMA
1900 

Head SAR
(Held to Ear)

(W/Kg)
0.866

(W/Kg)
0.588

(W/Kg)
0.569

(W/Kg)
1.16

Body SAR
(Worn)

(W/Kg)
0.532

(W/Kg)
0.155

(W/Kg)
0.231

(W/Kg)
0.164

Maximum SAR Values (W/kg) CE

Band GSM 900 PCS 1800 WCDMA 2100

Head SAR 0.741 0.244 0.447

Using TTY 

A TTY (also known as TDD or text telephone) is a 
telecommunications device that allows people who are deaf or 
hard of hearing, or who have speech or language disabilities, to 
communicate by telephone.

Your Palm Treo 700wx smartphone is compatible with select TTY 
devices. You can connect a TTY/TDD machine to your smartphone 
through the headset jack, but you cannot use your headset jack 
with a headset or hands-free kit while this mode is enabled. 
Please check with the manufacturer of your TTY device for 
connectivity information and to ensure that the TTY device 
supports digital wireless transmission.

To use TTY, you may need to make additional arrangements with 
Verizon Wireless. Please contact Verizon Wireless’s customer 
service department for more information.

1 Press Start and select Settings.

2 Select Personal, and then select Phone.

3 Select Phone.

4 Select the TTY/TDD list, and then select either On or Off.

5 Press OK. A keyboard icon appears at the top of your Today 
screen whenever TTY is enabled.

To disable TTY, repeat the steps above.

https://programs.bluetooth.org/tpg/listings.cfm
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Operational Warnings

IMPORTANT INFORMATION ON SAFE AND EFFICIENT 
OPERATION. Read this information before using your integrated 
multi-service portable radio. 

For the safe and efficient operation of your radio, observe these 
guidelines:

Potentially Unsafe Areas/Potentially explosive 

atmospheres Obey all signs and instructions regarding turning off 
your smartphone. In particular, turn off your smartphone when you 
are in any areas with a potentially explosive atmosphere, such as 
fueling areas (gas or petrol stations, below deck on boats), storage 
facilities for fuel or chemicals, blasting areas and areas near electrical 
blasting caps, and areas where there are chemicals or particles (such 
as metal powders, grains, and dust) in the air.

Interference to Medical and Personal Electronic Devices Most 
but not all electronic equipment is shielded from RF signals and 
certain electronic equipment may not be shielded against the RF 
signals from your smartphone.

Pacemakers The Health Industry Manufacturers Association 
recommends that a minimum separation of six inches (6") be 
maintained between a smartphone and a pacemaker to avoid 
potential interference with the pacemaker. These recommendations 
are consistent with the independent research by the 
recommendations of Wireless Technology Research.

Persons with pacemakers should:

• ALWAYS keep the smartphone more than six inches from their 
pacemaker when the smartphone is turned ON. 

• Not carry the smartphone in a breast pocket.

• Use the ear opposite the pacemaker to minimize the potential for 
interference.

• Turn the smartphone OFF immediately if you have any reason to 
suspect that interference is taking place.

Audio Safety Some hearing aids may be affected by some digital 
smartphone models. You may want to consult your doctor in the 
event of you experience interference with your hearing aid while 
using your smartphone. When using the speakerphone feature, it is 

recommended that you place your smartphone at a safe distance 
from your ear. 

Other Medical Devices If you use any other personal medical 
device, consult the manufacturer of your device to determine if it is 
adequately shielded from external RF energy. Your physician may be 
able to assist you in obtaining this information.

Turn your smartphone OFF in health care facilities when any 
regulations posted in these areas instruct you to do so. Hospitals or 
health care facilities may be using equipment that could be sensitive 
to external RF energy.

Interference to Other Electronic Devices RF energy may affect 
improperly installed or inadequately shielded electronic operating and 
entertainment systems in motor vehicles. Check with the 
manufacturer or representative to determine if these systems are 
adequately shielded from external RF energy. Also check with the 
manufacturer of any equipment that has been added to the vehicle.

Repetitive Motion Injuries When using the keyboard or playing 
games on your smartphone, you may experience discomfort in your 
neck, shoulders, hands, arms, of other parts of the body. To avoid any 
injury, such as tendonitis, carpal tunnel syndrome, or other 
musculoskeletal disorder, make sure to take necessary breaks from 
use, take longer rests (such as several hours) if discomfort or tiring 
begins, and see a doctor if discomfort persists.

Blackouts and Seizures Blinking lights, such as those experienced 
with television or playing video games, may cause some people to 
experience blackout or seizure, even if never experienced before. In 
the event a smartphone user should experience any disorientation, 
loss of awareness, convulsion, eye or muscle twitching or other 
involuntary movements, stop use immediately and consult a doctor. 
Individuals with personal or family history of such events should 
consult a doctor before using the device. To limit the possibility of 
such symptoms, wherever possible every hour take a minimum of 
15 minutes, use in a well lighted area, view the screen from the 
farthest distance and avoid exposure to blinking lights if you are tired. 

Aircraft While in aircraft, follow all instructions regarding the 
operation of your smartphone. Use of your smartphone while on 
board on aircraft must be done in accordance in compliance with 
airline instructions and regulations.
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Vehicles with Air Bags Your smartphone should not be placed in a 
position that would affect the operation of air bag deployment or in a 
position that, should the air bag inflate, could propel the smartphone. 
Air bags will inflate with great force and care should be taken to 
protect within a vehicle that has air bags.

Battery Your smartphone includes an internal lithium ion battery. 
Please note that use of certain data applications can result in heavy 
battery use and may require frequent battery charging. Any disposal 
of the smartphone must comply with laws and regulations pertaining 
to lithium ion batteries.

CTIA Battery Handling Guidelines 

• Only use and/or replace the battery and charging system with the 
battery or charging system specified for this phone. Use of an 
unqualified battery or charger or improper battery use may 
present a risk of fire, explosion, leakage, or other hazard.

• Do not disassemble or open; crush, bend, or deform; puncture or 
shred the battery.

• Do not short circuit a battery or allow metallic conductive objects 
to contact battery terminals.

• Do not modify or remanufacture, attempt to insert foreign objects 
into the battery, immerse or expose to water or other liquids, 
expose to fire, explosion or other hazard.

• Battery usage by children should be supervised.

• Avoid dropping the phone or battery. If the phone or battery is 
dropped, especially on a hard surface, and the user suspects 
damage, take it to a service center for inspection.

• Promptly dispose of used batteries in accordance with local 
regulations.

Driving Safety Tips Overview

Always obey all laws and regulations on the use of the smartphone in 
your driving area.

Safety — Your most important call. The Wireless Industry reminds 
you to use your smartphone safely when driving.

1 Get to know your smartphone and its features, such as speed-dial 
and redial.

2 When available, use a hands-free device.

3 Position your smartphone within easy reach.

4 Let the person you are speaking to know you are driving; if 
necessary, suspend the call in heavy traffic or hazardous weather 
conditions.

5 Do not take notes or look up phone numbers while driving.

6 Dial sensibly and assess the traffic; if possible, place calls when 
you are not moving or before pulling into traffic.

7 Do not engage in stressful or emotional conversations that may 
divert your attention from the road.

8 Dial 911 to report serious emergencies. This is a free call from 
your smartphone.

9 Use your smartphone to help others in emergencies.

10 Call roadside assistance or a special non-emergency wireless 
number when necessary.

Driving Safety Tips Details

1 Get to know your smartphone and its features such as speed-dial 
and redial. Carefully read your instruction manual and learn to 
take advantage of valuable features most smartphone models 
offer including, automatic redial and memory dial—most 
smartphone models can store up to 99 numbers in memory dial. 
Also, work to memorize the smartphone keyboard so you can use 
the speed-dial function without taking your attention off the road.

2 When available, use a hands-free device. A number of hands-free 
smartphone accessories are readily available today. Whether you 
choose an installed mounted device for your smartphone or a 
speaker phone accessory, take advantage of these devices if 
available to you.

3 Make sure you place your smartphone within easy reach and 
where you can grab it without removing your eyes from the road. 
If you get an incoming call at an inconvenient time, let your 
voicemail answer it for you.



I M P O R T A N T  S A F E T Y  A N D  L E G A L  I N F O R M A T I O N308

4 Suspend conversations during hazardous driving conditions or 
situations. Let the person you are speaking to know you are 
driving; if necessary, suspend the call in heavy traffic or 
hazardous weather conditions. Rain, sleet, snow, and ice can be 
hazardous, but so is heavy traffic. As a driver, your first 
responsibility is to pay attention to the road.

5 Do not take notes or look up phone numbers while driving. If you 
are reading an address book or business card while driving a car, 
or writing a to-do list, then you are not watching where you are 
going. It’s common sense. Don’t get caught in a dangerous 
situation because you are reading or writing and not paying 
attention to the road or nearby vehicles.

6 Dial sensibly and assess the traffic; if possible, place calls when 
you are not moving or before pulling into traffic. Try to plan your 
calls before you begin your trip, or attempt to coincide your calls 
with times you may be stopped at a stop sign, red light or 
otherwise stationary. But if you need to dial while driving, follow 
this simple tip: Dial only a few numbers, check the road and your 
mirrors, then continue.

7 Do not engage in stressful or emotional conversations that may 
be distracting. Stressful or emotional conversations and driving 
do not mix-they are distracting and even dangerous when you are 
behind the wheel. Make people you are talking with aware you 
are driving and if necessary, suspend phone conversations which 
have the potential to divert your attention from the road.

8 Use your smartphone to call for help. Your smartphone is one of 
the greatest tools you can own to protect yourself and your 
family in dangerous situations-with your smartphone at your side, 
help is only three numbers away. Dial 911 in the case of fire, 
traffic accident, road hazard, or medical emergencies. 
Remember, 911 is a free call on your smartphone.

9 Use your smartphone to help others in emergencies. If you see 
an auto accident, crime in progress, or other serious emergency 
where lives are in danger, call 911, as you would want others to 
do for you.

10 Call roadside assistance or a special wireless non-emergency 
assistance number when necessary. Certain situations you 
encounter while driving may require attention, but are not urgent 
enough to merit a call to 911. But you can still use your 

smartphone to lend a hand. If you see a broken-down vehicle 
posing no serious hazard, a broken traffic signal, a minor traffic 
accident where no one appears injured, or a vehicle you know to 
be stolen, call roadside assistance or other special 
non-emergency wireless number.

NOTICE FOR CONSUMERS WITH HEARING 

DISABILITIES

Digital Wireless Phones to be Compatible with Hearing 

Aids On July 10, 2003, the Federal Communications Commission 
(FCC) modified the exemption for wireless phones under the Hearing 
Aid Compatibility Act of 1988. This means that wireless phone 
manufacturers and service providers must make digital wireless 
phones accessible to individuals who use hearing aids.

For more information, please go to the FCC’s Consumer Alert on 
accessibility of digital wireless phones at 
fcc.gov/cgb/consumerfacts/hac wireless.html.

Wireless telephones are hand-held phones with built-in antennas, 
often called cell, mobile, or PCS phones. These phones are popular 
with callers because they can be carried easily from place to place.

Wireless telephones are two-way radios. When you talk into a 
wireless telephone, it picks up your voice and converts the sound to 
radio frequency energy (or radio waves). The radio waves travel 
through the air until they reach a receiver at a nearby base station. 
The base station then sends your call through the telephone network 
until it reaches the person you are calling.

When you receive a call on your wireless telephone, the message 
travels through the telephone network until it reaches a base station 

http://www.fcc.gov/cgb/consumerfacts/hac_wireless.html
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close to your wireless phone. Then the base station sends out radio 
waves that are detected by a receiver in your telephone, where the 
signals are changed back into the sound of a voice.

The Federal Communications Commission (FCC) and the Food and 
Drug Administration (FDA) each regulate wireless telephones. FCC 
ensures that all wireless phones sold in the United States follow 
safety guidelines that limit radio frequency (RF) energy. FDA monitors 
the health effects of wireless telephones. Each agency has the 
authority to take action if a wireless phone produces hazardous levels 
of RF energy.

FDA derives its authority to regulate wireless telephones from the 
Radiation Control provisions of the Federal Food, Drug, and Cosmetic 
Act (originally enacted as the Radiation Control for Health and Safety 
Act of 1968). [fda.gov/cdrh/radhealth/].

FCC derives its authority to regulate wireless telephones from the 
National Environmental Policy Act of 1969 (NEPA) and the 
Telecommunications Act of 1996 
fcc.gov/telecom.html. Updated 7/16/2003

Hands-Free Capability All CTIA Certified portable products provide 
the consumer with a toll-free number for the purchase of a 
compatible hands-free device. 1-800-881-7256

STATIC ELECTRICITY, ESD, AND YOUR PALM DEVICE

Electrostatic discharge (ESD) can cause damage to electronic devices 
if discharged into the device, so you should take steps to avoid such 
an occurrence.

Description of ESD Static electricity is an electrical charge caused 
by the buildup of excess electrons on the surface of a material. To 
most people, static electricity and ESD are nothing more than 
annoyances. For example, after walking over a carpet while scuffing 
your feet, building up electrons on your body, you may get a shock—
the discharge event—when you touch a metal doorknob. This little 
shock discharges the built-up static electricity.

ESD-susceptible equipment Even a small amount of ESD can 
harm circuitry, so when working with electronic devices, take 
measures to help protect your electronic devices, including your 
Palm® device, from ESD harm. While Palm has built protections 
against ESD into its products, ESD unfortunately exists and, unless 

neutralized, could build up to levels that could harm your equipment. 
Any electronic device that contains an external entry point for 
plugging in anything from cables to docking stations is susceptible to 
entry of ESD. Devices that you carry with you, such as your Palm 
device, build up ESD in a unique way because the static electricity 
that may have built up on your body is automatically passed to the 
device. Then, when the device is connected to another device such 
as a docking station, a discharge event can occur.

Precautions against ESD Make sure to discharge any built-up 

static electricity from yourself and your electronic devices before 
touching an electronic device or connecting one device to another. 
The recommendation from Palm is that you take this precaution 
before connecting your Palm device to your computer, placing the 
device in a cradle, or connecting it to any other device. You can do 
this in many ways, including the following:

• Ground yourself when you’re holding your device by 
simultaneously touching a metal surface that is at earth ground. 
For example, if your computer has a metal case and is plugged 
into a standard three-prong grounded outlet, touching the case 
should discharge the ESD on your body.

• Increase the relative humidity of your environment.

• Install ESD-specific prevention items, such as grounding mats.

Conditions that enhance ESD occurrences Conditions that can 
contribute to the buildup of static electricity in the environment 
include the following:

• Low relative humidity.

• Material type (The type of material gathering the charge. For 
example, synthetics are more prone to static buildup than natural 
fibers like cotton.)

• The rapidity with which you touch, connect, or disconnect 
electronic devices.

While you should always take appropriate precautions to discharge 
0ectricity, if you are in an environment where you notice ESD events, 
you may want to take extra precautions to protect your electronic 
equipment against ESD.

http://www.fda.gov/cdrh/radhealth/
http://www.fcc.gov/telecom.html


I M P O R T A N T  S A F E T Y  A N D  L E G A L  I N F O R M A T I O N310

Precaution against hearing loss Protect your hearing. Listening to this 
device at full volume for a long period of time can damage your 
hearing.

A pleine puissance, l’écoute prolongée du baladeur peut 
endommager l’oreille de l’utilisateur. Consultez notre site web 
palm.com/fr pour plus d’informations.

http://www.palm.com/fr
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Specifications

Radio • CDMA 800 (Digital Cellular), 1900 (PCS), and 1400 (GPS)

• EVDO and 1XRTT

Phone features • Personal speakerphone

• Hands-free headset jack (2.5 mm, 3-barrel connector)

• Microphone mute option

• TTY compatible

• 3-way calling

Processor technology • Intel XScale™ processor, 312MHz

Expansion • SD/MultiMediaCard/SDIO card slot

Battery • Rechargeable lithium-ion

• Removable for replacement

• Up to 4.7 hours talk time

• Up to 15 days standby 

• 3.5 hours full charge time

Operating system • Windows Mobile® 6 Professional

Camera • Still image capture resolution:1280 x 1024, 1.3 megapixel

• Automatic light balance

Size • 5.08 in x 2.28 in x 0.89 in (129 mm x 58 mm x 22.5 mm) 
with antenna

Weight • 6.4 ounces (180 grams)
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Connectivity • Infrared (1.2 compliant)

• Bluetooth® wireless technology (1.2 compliant)

Display • Touch-sensitive LCD screen (includes stylus)

• 65,536 colors (16-bit color)

• Resolution: 240 x 240

• User-adjustable brightness

Keyboard • Built-in QWERTY keyboard plus 5-way navigator

• Backlight for low lighting conditions

Included software • Today/Phone (includes 
Speed Dial and Dial Pad)

• Messaging (text, 
multimedia, and email)

• Internet Explorer Mobile 
(web browser)

• Camera

• Pictures & Videos

• Windows Media Player 
Mobile

• File Explorer

• Contacts

• Calendar

• Tasks

• Notes

• Calculator

• ActiveSync®

• Excel Mobile

• Word Mobile

• PowerPoint Mobile

• Voice Command

• Quick Tour

• Search

• Terminal Services

• Picsel PDF Viewer

• Bluetooth Plug-in
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System requirements • Windows 2000 Service Pack 4, XP, or Vista (later versions 
may also be supported)

• 32MB of available memory (RAM)

• 170MB of free hard disk space

• Available USB port

Operating and storage 
temperature range

• 32°F to 104°F (0°C to 40°C)

• 5% to 90% RH 
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Index

SYMBOLS

! on battery icon 20
* character in phone 

numbers 45, 58
# character in phone 

numbers 45, 58

NUMERICS

1st day of week option 191
1st letter capitalization 256
1xRTT data services 73
1xRTT technology 297
411 phone calls 45
5-way navigator 27, 30, 295
911 calls 74
911 phone calls 45, 71, 256

A

A2DP technology 297
abbreviated dialing 68–69
accented characters 36
accessing

alternate characters 36
applications 251
calculator 240
menu items 31, 32

on-device help 11
online address books 120
online support 11
Outlook folders 286
remote files 267
the Internet 145, 266
voicemail systems 51

accessories 15
accounts

accessing Internet and 
280

enabling phone as modem 
and 158

enabling TTY/TDD devices 
and 305

getting device phone 
number and 23

getting help with 12
getting started and 11
getting voicemail and 51, 

52
making phone calls and 

52, 54, 56, 57
preventing unauthorized 

use of 256, 257, 263
removing email 108
sending email and 101, 

290

sending messages and 
281

action keys. See softkeys
actions 248
activating smartphone 22
active call info 52, 53, 55

See also phone calls
ActiveSync

defined 297
downloading 84
installing 84–86
opening 86, 87
receiving email and 116
reinstalling 273
troubleshooting 283–288

ActiveSync desktop software 
10, 80, 84, 297

ActiveSync icon 86, 87, 89, 
201

Add Contact prompt 54
Add new device option 62, 

156
Add Picture/Video command 

138
Add Recipient command 

120, 136, 138
Add Server Source command 

91
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Add to Favorites command 
150

Add to Personal Address 
Book command 286

adding
a second call 55
appointments 187, 188
attachments 115, 131
Bluetooth devices 62
contacts 118, 183
expansion cards 236
files to playlists 178
notes 184, 193, 195, 196
passkeys 63
Quick Keys 58
speed-dial buttons 57–59
tasks 192–193
untimed events 187
web favorites 149–150

address books 119–120, 
125, 185, 286

addresses
copying 286
entering email 114, 115, 

125, 183
entering multiple 115, 136
entering web 147
getting 120, 125, 185
highlighting 30

searching for web 40
selecting 292
sending text messages 

and 135, 136, 138
synchronizing 286
verifying 119

adjusting brightness 248
Adobe Flash Player 83, 84
advancing slides 141, 171, 

209, 210
After calls from numbers… 

option 70
Agenda View (calendar) 186
alarm clock 262
alarm icon 262
alarm sounds 262
alarms

adding 187, 192, 193
setting 248, 262
turning on and off 247

albums 170
alerts 70, 75, 107

See also alarms; 
notifications

aligning the screen 250
alignment settings 207, 211
Allow cookies option 153
Alt key 36
alternate characters 36, 37

alternate phone numbers 46
analog clock 249
animated connection icon 89
animation 174, 209, 210
anniversaries 188
answering phone calls 50, 55
antenna 305
application icons 38, 251
applications

See also third-party 
applications

assigning to buttons 251
choosing menu items in 

30, 31, 32
closing 38–39, 264
copying 239
customizing 251–256
deleting 232–233
displaying 264
downloading 229, 231
enabling error reporting for 

263–264
highlighting 38
included with device 312
installing 229–232, 294
opening 38, 237, 251
running from expansion 

cards 237
running multiple 38
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scrolling in 28
searching in 228
selecting 38
switching between 53, 54
synchronizing info in 80, 

81, 96
troubleshooting 275, 277, 

294
turning sounds on or off 

for 247
viewing memory usage for 

264
appointment settings 191
appointments

adding 187
creating reminders for 

187, 192
deleting 191
marking as private 189
scheduling repeating 188
troubleshooting 287
viewing 186, 187

area codes 68, 185
arrow icons 27
arrow keys 28
attachments

adding 115, 131
downloading 117–118
embedding objects in 118

opening 117
setting maximum size 127
storing 117, 125, 295
troubleshooting 291

attendees 189
audio 50, 174, 306
authentication 119
Auto Correct option 255
auto-completion options 255
AutoCorrect command 173
Autofill option 215
AutoFilter options 211, 218
AutoFit option 217
Auto-Keyguard 256, 257
Auto-lock list 258
Automatic Send/Receive 

option 128
Automatically Collect 

Messages option 143
auto-off interval 265, 297

B

backgrounds 164, 172, 180, 
245

backing up info 275, 283
backlight (keyboard) 34, 266
Backlight Settings screen 34, 

266
backlight shut-off interval 35

Backspace key 30, 36, 47
backup and restore app 89
backup utilities 273, 276
backups, restoring 276, 283
banners (calendar) 188
battery

charging 19–20, 88
checking status of 19, 20, 

74, 265
connecting to Bluetooth 

devices and 154
conserving 20–21, 38, 

266
disposing of 276, 307
draining 278
inserting 18
replacing 18, 276–277
resetting device and 275

battery handling guidelines 
307

battery icon 19, 74
battery specifications 311
beaming 21, 233–235, 297
birthdays 188
blank screens 278
Block Recognizer option 254
Bluetooth connections

synchronizing over 94
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Bluetooth devices
See also hands-free 

devices
adding 62
beaming over 234
connecting to 154–157
conserving battery and 20, 

21
enabling phone as modem 

and 159
entering passkeys for 156, 

157
resetting device and 275
selecting 156
synchronizing over 94–95
transferring calls to 64
troubleshooting 281

Bluetooth feature, turning on 
or off 62, 95, 155, 266

Bluetooth icon 62, 74, 95, 
155

Bluetooth Qualification 
Program 305

Bluetooth range 154
Bluetooth status indicator 74
Bluetooth technology 297
bonus software 230, 312
bookmarks 149

See also favorites

border highlight 29
Brightness command 167
brightness, adjusting 248
broadband technology 298
BroadbandAccess data 

services 73, 298
browsing files and folders 

228, 239
browsing the web. See web 

browsing
built-in applications 232, 233
built-in camera. See camera
burst mode (camera) 166
button settings (Media 

Player) 180
buttons

assigning to apps 251
assigning voice 

commands to 252
creating speed-dial 57–59
customizing voicemail 59
disabling 256
reassigning 251–252
selecting 28, 29
turning sounds on or off 

for 247
Buttons icon 252
Buttons Settings screen 251, 

252

C

CAB files 231
calculations 214, 240
Calculator application 240–

241
Calculator icon 240
calendar

adding items to 187, 188, 
189, 192

displaying 186
hiding items on 189
moving through 186
removing items 191, 194
setting alarms for 187, 

192, 193
sorting tasks on 194
synchronizing 81, 85
troubleshooting 287
unavailable slots on 190

Calendar application
adding contacts and 183
customizing 191–192
managing schedules with 

187–191
opening 186
sending meeting requests 

and 130
Calendar icon 186
calendar settings 191–192
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calendar views 186, 191
call forwarding 57
call forwarding icon 57
Call in Progress entry 53
Call Log 48, 49
Call Sender command 140
call waiting 55
caller ID applications 294
caller ID blocking 54
caller IDs 66, 164, 183
camcorder icon 165
camera

capturing videos 166–167
conserving battery 20
conserving memory 295
overview 164
taking pictures 165–166
troubleshooting 293

Camera application 164–169
Camera icon 165
camera settings 166, 167–

169
camera specifications 311
Cancel Bluetooth command 

64
cancelling selections 33
capitalization 35, 256
Caps Lock icon 35
Caps Lock mode 35

captions 138
car kit 61
car kits 60, 61, 64
carrying cases 15
cascading menus 32
case-sensitive searching 

205, 220
cell phones. See wireless 

phones
cells (spreadsheets) 216, 

217, 221
certificates 127, 147, 230, 

262, 263
Certificates icon 263
changing

alarm sounds 262
calendar views 186
color themes 245, 250
connections 267
contacts 184
date and time settings 260
email accounts 108, 114
lock codes 258
picture or video resolution 

166, 167
speed-dial buttons 59

character sets 152
characters

See also text

capitalizing 35, 256
entering 34, 35, 214, 254
highlighting 30
moving to specific 28
typing alternate 36

charge indicator light 19
charging smartphone battery 

19–20, 88
charging status 19, 20
charts 211, 219
check boxes 29
Check name against this 

server option 120
chronological list of calls 48
Clear “MMS” command 141
Clear “Text Messages" 

command 141
Clear Cookies button 153
Clear Now Playing command 

179
clearing History list 153
clock 249
Clock & Alarms icon 249, 

260
Clock & Alarms Settings 

screen 260, 261
closing

applications 38–39, 264
drop-down lists 33
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Media Player Mobile 177
menus 32
notification screens 139
screens 29

color settings 293
color themes 245, 250
columns (spreadsheets) 216, 

217
commands. See menu 

items; voice commands
Company Directory 

command 120, 136, 138, 
185

company names 49, 184
completed tasks 193
compliancy statement 305
compressed files 229
computers

charging device and 20
connecting to 79, 87–88, 

263
downloading ringtones 

from 64
enabling phone as modem 

and 160
installing apps and 231, 

232
installing sync software on 

85

reinstalling desktop 
software on 273

synchronizing with 83–87, 
96, 97, 163, 201

transferring media files 
and 175

conference calls 56
confidential events 190
configurations, 

troubleshooting 281
Configure Server command 

91
configuring

data services 281
trusted devices 154, 155
TTY/TDD devices 67, 71

confirmation messages 125, 
143

conformity statement 305
Connect Bluetooth 

command 64
Connect command 268
Connect via Bluetooth 

command 95
Connect via IR command 96
connecting smartphone to 

PCs 79, 87–88
connection settings 266–268
connection status icons 72

connections
accessing corporate 

servers and 267
browsing websites and 

145, 147, 159, 180
changing 267
communicating over 

Bluetooth 94, 154, 155, 
157

creating 267
disabling data 70
enabling phone as modem 

and 158, 159
enabling TTY/TDD 67, 71
ending 268
losing 282
making phone calls and 54
manually starting 268
selecting 267
setting network 70
synchronizing over 

wireless 80, 90, 94, 95
timing out 289
troubleshooting 279–282, 

292
Connections icon 267
Connections screen 267
connectivity specs 312
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conserving smartphone 
battery 20–21, 38, 266

contact categories 184
contact lookup feature 45, 

46, 184
contact names, dialing by 

46–47
contacts

adding 118, 183
assigning ringtones 66, 

171, 184
assigning speed-dial 

buttons to 57, 58
calling 46, 54, 67, 69, 183
editing 184
getting from address 

books 120, 185
removing 185
searching for 47, 184
selecting 184
sending mail to 136, 138
setting communication 

method for 47
synchronizing 81, 85
transferring to car kits 64
viewing info about 47, 185

Contacts app 183–185
Contacts list 136, 138, 185
context-sensitive menus 32

continuous playback 210
cookies 147, 153
copying

addresses 286
applications 239
phone numbers 48, 49, 

152
pictures or videos 172
text 151–152, 206

copyrighted items 171
corporate mail 102, 111, 

112, 267
corporate passwords 92
corporate servers 85, 263, 

267, 291
coupling 296
coverage areas 21, 43, 73
creating

appointments 188
connections 267
contacts 118, 183
documents 204, 205
email messages 114–115
folders 208
lists 207
meeting requests 130, 

189
multimedia messages 

137–139

notes 184, 193, 195, 196
passkeys 63, 156
playlists 178
Quick Keys 58
reminders 187, 192, 193, 

194
speed-dial buttons 57–59
tasks 192–193
text messages 135–136
untimed events 187
video ringtones 171
web favorites 149–150
workbooks 212

cropping pictures 173
currency formats 250
currency symbols 250
customer assistance 11
Customer Feedback icon 269
customer service 12
customizing

applications 251–256
Calendar 191–192
contacts 185
device screen 248–251
Excel Mobile 221
Internet Explorer Mobile 

152–153
Media Player Mobile 179
multimedia messages 142
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Notes application 197
PDF Viewer 223
phone settings 64–72
system info 260
system sounds 246–248
Tasks application 194
text messages 142
Today screen 245
voicemail buttons 59
Word Mobile 209

cutting. See deleting

D

data. See information
data connections. See 

connections
data service icons 280
data service plans 11

See also accounts
data services 280, 281

See also service providers
date formats 250
dates 215, 250, 260, 261

See also calendar
Day View 186, 191
day-planner formats 186
decimals 250
decompression utility 229
delays 281

Deleted folder 126
deleting

applications 232–233
certificates 263
contacts 185
cookies 153
directory services 120
documents 208
email 121–122, 126, 129
email accounts 108
events 191
files 229
items from libraries 177
items in playlists 178, 179
messages 141
notes 197
partnerships 157, 282
pictures or videos 173
speed-dial buttons 59
tasks 194
text 30, 47
web favorites 150
web files 153
workbooks 221

desktop software 298
See also applications; 

software
device. See smartphone
device components 15–17

device conflicts 294
device names 300
devices

See also Bluetooth 
devices; smartphone

beaming to 234
conserving battery and 20
discovering trusted 154, 

155, 157
setting up TTY/TDD 67, 71
transferring info from 273

diagnostic information 263
Dial Lookup field 40, 44, 47
Dial Lookup list 22
Dial Pad 47–48, 49, 67
Dial Pad command 48
dialing 44–48, 49, 57, 68
dialing instructions 45
dialing preferences 68–69
dialog boxes 298
Dialpad tone setting 67
digital cameras 170

See also camera
digital certificates 127, 147, 

230, 262, 263
digital clock 249
digital signatures 127
dimmed images 278
Direct Push Technology 90
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directory services 119, 120, 
125, 185

Disconnect Bluetooth 
command 95

Disconnect command 268
discovering trusted devices 

154, 155, 157
disk space 313
display. See screen
display formats 249–250
display names 104, 106
display options (web) 148
display settings (screen) 

248–251
displaying

alternate characters 36
animated images 174
application menus 31, 32
appointments 186, 187
calendar 186
contact info 47, 185
events 188, 190
memory usage 264
on-device help 11
PDF files 203, 222, 223
pictures 170
running applications 264
space on device 264

space on expansion cards 
264

speed-dial buttons 46
tasks 194
text messages 139, 140
voicemail messages 51
web favorites 150
web pages 147, 148

document file types 203, 209
documentation 10, 12, 43
documents

See also Word Mobile
creating 204, 205
deleting 208
formatting in 206–207
moving text in 206
opening 204
renaming 208
saving 203, 204, 206, 209
searching 205
setting margins for 207
spell-checking 207–208

documents list 209
Download messages option 

128
Download size limit list 92, 

127
downloading

ActiveSync 84

Adobe Flash Player 84
applications 229, 231
attachments 117–118
email 92, 115–117, 126, 

128
files 151
images 174
multimedia messages 

139, 143
Outlook 81
Palm info and updates 11
pictures 151
ringtones 64
videos 174

Downloads favorite 151
downloads page (Verizon) 

151
down-pointing arrows 33
drained battery 20
drawing 195
drivers 274
driving safety tips 307–308
Drop and Answer command 

55
drop-down lists

cancelling selection in 33
closing 33
highlighting in 28, 30, 33
scrolling through 28
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selecting items in 33
drop-down menus 32
dummy expansion card 236

E

earpiece 296
echoes 296
Edit sender’s message 

option 121
Edit Server Settings screen 

91
Edit Speed Dial command 59
email

See also email accounts; 
email messages

adding contacts and 118, 
183

conserving battery and 21
conserving memory and 

115, 128
downloading 92, 115–

117, 126, 128
getting from corporate 

servers 267, 291
overview 99
saving passwords for 104
sending 115, 116, 121, 

129, 131, 149

setting security options for 
127

synchronizing 80, 81, 85, 
116

troubleshooting 290–292
email accounts

changing 114
deleting 108
editing 108
entering display names for 

104, 106
selecting 113–114, 118, 

124
setting up 101–113
troubleshooting 289

email applications 292
email client software 291
email messages

See also email
adding attachments 115, 

131
adding signatures 122–

123
addressing 114, 115, 119, 

125
checking for 72
creating 114–115
deleting 121–122, 126, 

129

dialing from 49
downloading attachments 

with 117–118
finding 121
forwarding 121
opening attachments in 

117
receiving 115–117, 126, 

128
replying to 121, 124
saving 115
setting maximum size 130
setting priority 115
storing copies of 124

email service providers 103, 
105, 289, 290

email settings 123–130
email shortcuts 122
emergency calls 45, 71, 74, 

256, 259
emptying Deleted folder 126
Enable Clear Type option 249
encoding 152
encryption 127, 147, 240
End User License 

Agreement 10
ending data connections 268
entry fields

deleting text in 30
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highlighting text in 30
moving to 28
opening lists in 33
scrolling through 28

Erase all data? prompt 276
erasing. See deleting
error messages 247

See also errors
error reporting 263–264
Error Reporting icon 264
errors 263, 279, 288
EVDO data services 73
EVDO technology 298
event categories 190
event icons 192
Event option 248

See also actions
events

adding reminders 187, 
192

creating 187
deleting 191
displaying 190
filtering 190
marking as sensitive 189
synchronizing 85

Excel files 199
See also Excel Mobile; 

spreadsheets

Excel Mobile 210, 212, 221
Excel Mobile icon 212
Exchange ActiveSync 80, 90, 

291, 298
Exchange Address Book 286
Exchange servers

changing lock settings 289
conserving battery and 93
finding contacts and 185
getting email from 115, 

116
sending email over 101, 

102, 106, 119
sending meeting requests 

and 189
setting up 90–92
synchronizing with 21, 80, 

85, 90, 92, 93
troubleshooting 288–289, 

291
expansion card slot 236, 311
expansion cards

browsing 228, 229, 239
conserving memory and 

295
encrypting 240
formatting 236
inserting 236–237
installing to 232

moving information to 
208, 220, 238

opening items on 237
organizing pictures and 

videos on 172
purchasing 236
renaming 239
searching on 227
storing info and 151, 235
transferring files to 174, 

177, 237
viewing space on 239, 

264
extensions (phone) 58, 68
external power sources 265
Extra Digits option 58

F

factory defaults 180
favorites 81, 149–150

See also web pages
Favorites application 81
features (smartphone) 9
feedback 296
fields. See entry fields
File Explorer 228–229, 238, 

239
File Explorer icon 228
file names 169, 206, 227
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file servers 116
file types

documents 203, 209
media 174
multimedia 137
pictures 170
ringtones 64
videos 170

files
accessing from corporate 

accounts 267
attaching to messages 

127, 131, 138
browsing 228
decompressing 229
deleting 229
downloading 151
renaming 208
saving 237, 238
searching for 227
transferring to expansion 

cards 174, 177, 237
viewing info about 179

filtering
events 190
information 184, 218
tasks 194

finding
company names 49, 120

contacts 47, 184
email messages 121
information 220
text 205

firewalls 283, 285
1st letter capitalization 256
First Synchronization dialog 

112, 113
Fit to page option 223
Fit To Screen option 148
Fit to width option 223
5-way navigator 27, 30, 295
Flash Player 83, 84
folder names 208
folders

accessing Outlook 286
browsing 228, 239
creating 150, 208
moving items to 208, 220
organizing pictures and 

videos in 172
organizing web favorites in 

149, 150
receiving mail and 116
searching 227
sorting contents 229
synchronizing info and 87

font options 207, 211
fonts 207, 211, 249

forgetting passwords 259
formats

capturing videos and 166
opening workbooks and 

212
saving voice notes and 

255
saving Word documents 

and 203, 206
saving workbooks and 

210, 212
sending email and 126, 

129
setting region-specific 

249–250
taking pictures and 165
viewing slide shows and 

168
formatting

dates 250
expansion cards 236
numbers 211, 250
spreadsheets 211, 217
text 206

Formatting toolbar 207
forms (web pages) 149
formulas (spreadsheets) 211, 

214, 221
forwarded calls icon 73
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forwarding
messages 121
phone calls 57

forwarding codes (phone) 57
freeing memory 232, 288, 

295
Freeze Panes option 213
full charge (battery) 19
full screen mode 148
functions (spreadsheets) 

211, 215

G

games 20
gestures 254
Getting Started CD 10, 84, 

230
Global Address Lists 90, 119, 

120, 125, 185
Global Input Options setting 

197
graphics programs 172

H

hands-free car kits 60, 61, 64
hands-free devices

See also Bluetooth 
devices

connecting to 61–63

enabling Keyguard for 257
entering passkeys for 63
making phone calls and 

60, 64
purchasing 309
troubleshooting 281

hanging indents 207
hanging up phone 53, 55
hard resets 275–276
hardware 9
headphones 174
headset button 61
headsets

configuring as trusted 
devices 154, 155

connecting 60–61
enabling Keyguard for 257
listening to music and 61
making calls and 64
troubleshooting 282

hearing aids 308
help 11, 38, 271
hiding

calendar items 189
images 148
speed-dial buttons 46

highlight 29
highlighting

applications 38

email addresses 30
items on Today screen 53
menu items 31, 32
options in lists 28, 33
phone numbers 45, 49
text 30, 151, 207
web links 29, 149

hints (passwords) 259
History list 152, 153
holding phone calls 53
home locations 260
home page (browser) 152
Hotmail 102
HTML formats 117, 121
hypertext links. See links

I

icons. See specific
idle setting 44
Ignore command 55
Ignore with text message 

command 55
ignoring phone calls 55
image files 137, 170, 295
images

See also pictures
downloading 174
embedding 118
hiding web page 148
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incorrect color settings 
and 293

resizing 292
setting background 172, 

245
IMAP email accounts 102, 

103–110, 118
Inbox 116, 139, 140, 141
Include file attachments 

option 117
indentation 207
indicator light 19, 43
information

backing up 275, 283
displaying 39
entering 34, 35–36, 79, 

183, 212, 215
filtering 184, 218
finding and replacing 220
losing 203, 210, 275, 276
moving 208, 220, 238
organizing 225
protecting 256–260
restoring 89, 275, 276
searching for 227–228
sharing 233
sorting 218
storing 235, 295
transferring 273

updating 79
infrared port. See IR port
infrared transmissions 95–

96, 234, 298
Input icon 254
Input Method options 254
input options 34
inserting device battery 18
inserting expansion cards 

236–237
installation, troubleshooting 

275, 294
installing

applications 229–232, 294
bonus software 230
Media Player 81
Outlook 81
sync software 79, 84–86
VPN clients 267
Windows drivers 274

instant messaging 
applications 294

interference 306
internal memory 295

See also memory
International Dialing Prefix 

options 68
Internet 145, 159, 231, 266

See also web browsing

Internet Connection Speed 
option 180

Internet connections, 
troubleshooting 280–281, 
292

Internet email accounts 102, 
106, 111

Internet Explorer Mobile
browsing with 147–152
closing 149
customizing 152–153
getting mail and 102
installing from 231
scrolling in 28
starting 147
troubleshooting 292

Internet service providers. 
See ISPs

IP-based push updating 90
IR port 95, 233, 298
ISPs 102, 105, 266, 290

K

Keep copies of sent items in 
Sent folder option 115

key presses 34, 251
keyboard

accessing alternate 
characters on 36
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dialing from 45, 47, 48, 49
entering info 34, 35–36, 

255
locking 256
scrolling with 28
selecting menu items 32
troubleshooting 295

keyboard backlight 34, 266
keyboard icon 34
keyboard specifications 312
Keyguard 256, 257
Keyguard icon 257
keys (keyboard) 34, 251, 254
Known Caller option 65

L

laptop computers 158
LCD. See screen
LED light 19, 43
Letter Recognizer option 254
libraries 175, 176, 177
Library screen 176, 180
License Agreement 10
lightning bolt 19
li-ion battery 298

See also battery
links

clearing 153, 295
highlighting 29

selecting 124, 149
sending 149
troubleshooting 292

lists
cancelling selection in 33
closing 33
creating 207
formatting 207
highlighting in 28, 30, 33
indenting text in 207
scrolling through 28, 149
selecting items in 33

lithium ion battery 298
See also battery

locating
company names 49, 120
contacts 47, 184
email messages 121

Location Privacy icon 71, 74
Location Privacy setting 71
lock codes 256, 257, 258
Lock icon 148, 171, 259
lock settings 289
locking

device keyboard 256
device screen 257
device system 258–259
phone feature 256, 257

spreadsheet rows and 
columns 213

logging in to
corporate servers 267
networks 263

looking up company names 
49

looking up contacts 47, 184
losing

connections 282
information 203, 210, 

275, 276
passwords 259
smartphone 89, 260

low coverage areas 279
low light conditions 34
lowercase letters 35

M

magnification. See zoom 
settings

mail. See email
Manage existing connections 

option 267, 268
Manage Folders command 

116
management tools 225
maps 292
margins 207
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Match case option 205, 220
Match entire cells option 220
Match whole words only 

option 205
measurement units 250
media features 161
media file types 170, 174
media files

adding to playlists 178
playing 175–177
selecting 176, 177
streaming 177
synchronizing 81, 163–

164, 174
transferring 174–175, 177
troubleshooting 287
viewing info about 179

media libraries 175, 176, 177
Media Player 81, 163, 174, 

287
Media Player Mobile 174–

180
media players 20
Media sync option 175
meeting invitations. See 

meeting requests
meeting requests 120, 130–

131, 188–189, 192

memory
browsing web and 153
freeing 232, 288, 295
running apps and 38, 237
sending mail and 115, 128
storing numbers in 241
viewing usage 264

memory buttons 241
memory dial 307
Memory icon 239
Memory Settings screen 39
memos. See messages; 

notes
menu items 30, 31, 32
Menu key 31, 32
menus 30, 31, 32
Menus icon 251
Menus screen 251
Message format option 126
Message Overview 

command 140
message preferences 142–

143
message templates 140
messages

See also email; specific 
type

addressing to multiple 
recipients 115, 136

dialing from 49
playing voicemail 51, 52, 

59
recording 138
synchronizing 81
viewing voicemail 51

Messaging application
adding contacts and 183
downloading attachments 

and 118
opening 114
receiving meeting 

requests and 130
receiving messages and 

140
sending email from 113, 

114, 119, 123
sending messages and 

135, 142
setting up email accounts 

and 103, 105
messaging applications 294
messaging services 281, 

298, 300
Messaging softkey 114
microphone 53, 169, 296
microphone icon 253
Microsoft ActiveSync. See 

ActiveSync desktop 
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software; Exchange 
ActiveSync

Microsoft Media Player. See 
Media Player

Microsoft Office. See 
specific app

Microsoft Windows Mobile 
software 230, 231

mirror 165, 167
Missed call option 65
MMS messaging 135, 298

See also multimedia 
messages

mobile accounts. See 
accounts

Mobile Device 299
Mobile Device Center. See 

Windows Mobile Device 
Center

mobile devices 234, 273
Mobile Favorites folder 81
mobile networks 279
mobile phone numbers 183
mobile phones. See wireless 

phones
Mobile to Market certificates 

230
Modem Link icon 158
modems 154, 158–160

Month View 186
most recently dialed 

numbers list 48
moving

documents 208
files to expansion cards 

174, 177, 237
information 208, 220, 238
pictures or videos 172
speed-dial buttons 59
text 206
workbooks 220

moving around the screen 
27–29

MP3 player 246
multi-line fields 28
multimedia file types 137
multimedia files 295
multimedia messages

checking for 73
creating 137–139
customizing 142
deleting 141
dialing from 49
downloading 139, 143
opening 140
previewing 139
replying to 139, 140
sending 139

sorting 141
storing 295
troubleshooting 281

Multimedia Messaging 
System. See MMS 
messaging

MultiMediaCard cards 236
multiple recipients 115, 136
music 50, 161, 174, 246

See also media files; 
playlists

music files 61, 163, 287
Mute icon 53
My Device folder 228
My Device library 177
My Documents folder 163, 

227, 275
My Pictures folder 165, 166
My Playlists category 178
My Storage Card library 177
My Text phrases 115, 136, 

139

N

names
See also device names; 

usernames
dialing by company 49
dialing by contact 46–47
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finding company 120, 184
finding contact 47, 184
grouping pictures and 169

naming
document files 206
expansion cards 239
folders 208
speed-dial buttons 57
templates 205, 213
workbooks 212, 220
worksheets 217

NationalAccess data services 
73

NationalAccess technology 
299

navigation features 27
navigator buttons 27, 30, 

295
network features 12
network icons 73
network protocols 179
network services 43

See also accounts
network settings 70–71, 179
networks

connecting to 70
logging in to 263
troubleshooting 279–282

New Speed Dial command 
57

note settings 197
notes

adding 184, 193
creating 195, 196
deleting 197
saving 197

Notes application 195–197
Notes icon 195
Notes list 196, 197
notification options 248
notification screens. See 

notifications
notifications

browsing websites and 
153

receiving Bluetooth 
transmissions and 157

receiving messages and 
139, 142

receiving phone calls and 
55, 66, 70

receiving voice commands 
and 253

receiving voicemail 52
setting ringtones for 65–

66
silencing sounds for 246

troubleshooting 281
turning on or off 248

Now Playing playlist 176, 
178, 179

number sign symbol 250
numbers

See also phone numbers
entering 34, 35, 215, 241
formatting 211, 250
pasting into Calculator 241

O

Office files 199, 201
See also specific app

offline synchronization 286
online address books 119–

120, 125, 185
online support (Palm) 11
Open URL command 177
opening

alternate characters list 36
application menus 30, 31, 

32
applications 38, 237, 251
calculator 240
Call Log 49
device keyboard 34
Dial Pad 48, 49
documents 204
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email applications 292
email attachments 117
File Explorer 228
multimedia messages 140
on-device help 11
PDF files 222, 223
PDF Viewer 203
Quick Tour 11
sync applications 86, 87
sync software window 86
Today screen 39
web pages 147, 149, 152, 

292
Wireless Manager 43
workbooks 213

operating system (device) 
300, 311

operating systems (PCs) 83
operational warnings 275, 

306–307
Option key 28, 35, 38, 45
Option Lock icon 35
Option Lock key 241
Option Lock mode 35
options

displaying 190
highlighting 28, 29, 33
selecting 33

Options screen (Internet 
Explorer) 152, 153

organizer features 44, 181
orientation (screen) 251
orientation (slides) 210
outgoing mail server alert 

107
outgoing server settings 

108–109
Outlook

accessing folders for 286
copying addresses from 

286
downloading 81
getting mail from 101, 

116, 117, 126, 291
installing 81
synchronizing with 80, 90, 

120, 274
overdue tasks 194
owner information 260
Owner Information icon 260

P

paired relationships. See 
partnerships

pairing. See partnerships
Palm online support 11
Palm OS devices 273

Palm OS software 273
paragraphs 30, 207
partial battery icon 20
partial envelope icon 117
partnerships 154, 157, 282, 

299
passkeys 63, 156, 157
password types 45, 259
passwords

entering 36, 91, 259
forgetting 259
locking device and 256, 

258, 259
making phone calls and 58
opening spreadsheets and 

211
saving 104, 107
setting up email accounts 

and 104, 107, 111
storing on smartphone 92

Pause playback option 179
PCS phones. See wireless 

phones
PCs. See computers
PDF files 117, 199, 203, 

222–223
PDF Viewer 199, 203, 222–

223
PDF Viewer icon 222
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performance 277, 294
Personal Address Book 286
personal computers. See 

computers
personal events 189
personal identification 

numbers (PINs) 300
personal information 258, 

260, 275
personal information 

managers. See PIM 
software; PIMs

phone
See also phone calls; 

phone numbers; 
smartphone

activating 22
answering 50, 55
connecting to headsets 

60–61
conserving battery and 21
dialing 44–48, 49, 57, 68
disabling touch-sensitivity 

for 256
driving and 60, 307
getting forwarding codes 

for 57
getting started with 22–

23, 41, 52

hanging up 53, 55
locking 256, 257
playing music and 50
redialing 48
resetting device and 275
running apps and 53, 54
setting network 

preferences for 70–71
setting privacy options 71
setting ringtones 65–66
silencing ringer for 50
troubleshooting 281, 296
turning on or off 43, 266
waking up screen for 53

phone as modem feature 
154, 158–160

phone calls
See also phone; phone 

numbers
adding a second 55
adjusting volume for 66
customizing sounds for 66
ending 53, 55
forwarding 57
ignoring 50, 55
making 22, 44–48, 49, 52, 

53, 140
placing on hold 53
receiving 50, 52, 53

sending to voicemail 50, 
55

setting up conference 56
switching between 56
transferring 64
viewing info about 52, 53, 

55, 72
Phone dialog box 49
phone features 311
phone headsets. See 

headsets
phone numbers

See also phone calls
adding prefixes to 68
adding to contacts 67, 69
assigning to speed-dial 

buttons 57
copying and pasting 48, 

49, 152
dialing extra digits with 58, 

69
entering 44–48, 49, 68
getting device 23
getting from address 

books 120
highlighting 30, 45, 49
inserting pauses in 58
saving 54–55
selecting 47, 48, 49
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phone off indicators 73
Phone Off message 43, 299
phone on indicators 73
phone settings 64–72
Phone Settings screen 67
phone status icons 72
Phone/Send button 22, 39
phone-off icon 21, 43
photo albums 170
photos. See pictures
pick lists. See drop-down lists
piconets 299
Picsel PDF Viewer. See PDF 

Viewer
picture backgrounds 172, 

245
picture captions 138
picture file types 137, 170
picture formats 165
picture resolution 166, 173, 

293
picture settings 168, 169
picture speed-dial 57, 58
pictures

accessing 163
cropping 173
deleting 173
downloading 151
editing 172

hiding on web pages 148
naming groups of 169
organizing 172
previewing 167
renaming 173
rotating 168, 173
saving changes to 173
sending 138, 171
storing 165, 169, 295
synchronizing 81, 163, 

164
taking 165–166, 293
troubleshooting 293
viewing 170

Pictures & Videos app 167, 
170–173

PIM software 274, 298, 299
PIMs 299
PINs 300
Play softkey 176
Play Sound option 66
playback controls 59, 176, 

180
playback options 176, 179, 

210
Playback screen 179, 180
playing

media files 175–177
multimedia messages 140

presentations 209, 210
ringtones 65
slide shows 168, 171
video clips 170, 174
voice notes 196
voicemail 51, 52, 59

playlists 174, 175, 176, 178
plug-ins 147, 246
POP email accounts 102, 

103–110
pop-up menus 32
portable radio. See radio
Power icon 265
Power screen 265
power settings 265
Power/End button 23, 43, 44
PowerPoint files 199
PowerPoint Mobile 209–210
PowerPoint Mobile icon 209
predefined passkeys 62, 63, 

156
preferences 243
presentations 209, 210

See also PowerPoint 
Mobile

previewing
multimedia messages 139
pictures 167
ringtones 65
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sounds 248
videos 167

priority options 115, 193
privacy mode 139
privacy settings 71
private events 190
processor 311
Program Files folder 239
Programs screen 38
programs. See applications; 

software
protecting

expansion card slot 236
information 256–260
spreadsheets 211

proxy servers 268
punctuation marks 35
push technology 90

Q

Quality command 167
Quick Keys 46, 58
Quick Tour 11
Quick Tour icon 11
QuickTime Player 174

R

radio 306, 311

radio frequency emissions 
303, 308

RAS connections 266
Receiving Data message 235
rechargeable battery. See 

battery
recipients, sending to 

multiple 115, 136
Record button action option 

197
recording

sounds 247
videos 166–167, 169
voice captions 138
voice notes 195, 197, 255

recording toolbar 195
recurring appointments. See 

repeating appointments
redialing phone 48
redirector (websites) 292
refreshing web pages 148, 

292
Regional Settings icon 249
Regional Settings screen 249
reminders

adding 187, 192, 193, 194
checking for 75
system alarms and 262
turning on and off 247

remote access servers 266
remote files 267
Remove Programs icon 232
Remove Programs screen 

232
removing device battery 18, 

276
renaming

documents 208
expansion cards 239
pictures or videos 173
workbooks 220
worksheets 218

repeat media playback 176
repeating appointments 188
repeating sounds 66, 248
repeating tasks 193
replacing

battery 18, 276–277
information 220
text 205

Request delivery 
notifications option 142

reset button 274
resets 274–276, 279
resizing

images 292
text 149, 248
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resolution (camera) 166, 167, 
293

resolution (screen) 279, 312
Resolution command 166
restarting device. See resets
restoring

backups 276, 283
device settings 89
factory defaults 180
information 89, 275, 276
sound settings 246

Resume playback option 179
reverse type 30
RF emissions 303, 308
right-click menus. See 

shortcut menus
Ring tone command 67
ringer 50, 66
Ringer switch 17, 50, 246
ringtone files 137
ringtone managers 294
ringtones

assigning to caller IDs 66
assigning to contacts 66, 

171, 184
creating video 171
downloading 64
previewing 65
selecting 65–66

sending 64, 138
roaming 70, 73, 94, 129, 287
Roaming option 65
rotating pictures 168, 173
rows (spreadsheets) 216, 

217
Running Programs screen 

39, 264

S

safety statements 303
Save as Template command 

140
Save password check box 

92, 104, 107
Save to Contact Ring Tone 

command 171
Save to Contacts command 

55
Save to list 238
Saved folder 115
saving

documents 203, 204, 
206, 209

email messages 115
files 237, 238
notes 197
passwords 104, 107
phone numbers 54–55

pictures or videos 165, 
166, 169, 173

voice notes 255
workbooks 210, 212, 221

Schedule command 93
Schedule screen 93
scheduled syncs 93–94, 287
schedules. See calendar
scheduling conflicts 186
screen

activating items on 30
adjusting brightness 248
adjusting idle setting 44
aligning 250
caring for 15
changing color themes for 

245, 250
conserving battery and 21
disabling touch-sensitivity 

for 256
fitting videos to 179
fitting web pages to 148
highlighting items on 28, 

29–30, 53
locking 257
scrolling in 28–29, 256
selecting items on 28, 30
setting backgrounds for 

172, 245
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troubleshooting 278, 279
turning on or off 43, 44, 

265
viewing PDF files and 223
viewing workbooks and 

213
waking up 44, 53

screen fonts 249
screen orientation 251
screen resolution 279, 312
screen specifications 312
screens, returning to 

previous 29
screensavers 168
scrolling

device screen 28–29, 256
spreadsheets 213
web pages 148, 149

SD cards 236
SDHC cards 236
SDIO cards 236, 303, 304
SDIO transmitters 304
Search dialog box 227–228
search features 227–228
Search for list 228
Search icon 227
searching

company names 49
contacts 47, 184

documents 205
email messages 121
My Documents folder 227
online address books 120
web addresses 40
web pages 147
workbooks 220

searching for signal 21
secure sockets layer 300
secure websites 147, 148, 

153, 293
secured networks 263
security

browsing web and 147, 
153

communicating with 
Bluetooth devices and 
156

connecting to computers 
and 263

creating passkeys and 63
protecting info and 256–

260
sending email and 124, 

127
security certificates 262, 263
self-portrait mirror 165, 167
sending

copyrighted items 171

email 115, 116, 121, 129, 
131, 149

error reports 263
information 233
meeting requests 120, 

188, 189, 192
multimedia messages 139
sounds 247
text messages 55, 135, 

136
usage information 268
web links 149

sensitivity settings 189, 193
Sent folder 124
servers, troubleshooting 

288, 289, 291
service plans 11

See also accounts
service providers 266, 290
Set as Hands-Free command 

282
Set as Today Background 

command 172
Set up show command 210
settings. See options
sharing information 233
sheet list 213
Shift key 35
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Short Messaging Service. 
See SMS messaging

shortcut menus 32
Show alphabetical index 

option 185
Show contact names only 

option 185
Show half hour slots option 

191
Show list 237
Show start and due dates 

option 194
Show Tasks entry bar option 

194
Show time as option 179
Show week numbers option 

191
Shuffle command 176
Side button 15, 197
signal, searching for 21
signal strength 73, 279
signal-strength icon 43
signatures 122–123
Signatures screen 123
silencing all sounds 50, 246
silencing the ringer 50
silent alarm 246, 248
Simple PIN password type 

45, 259

sketching 195
skins 180
slide show options 168
slide show toolbar 171
slide shows 171, 209, 210
slide timing option 210
slider 29
slides 138, 141, 171, 209, 

210
smartphone

activating 22
charging 19–20, 88
displaying space on 264
disposing of 307
freeing space on 232, 288, 

295
getting help with 11, 38, 

271
getting phone number for 

23
getting started with 11, 31
inserting batteries and 18
locking 258–259
losing 89, 260
low light conditions and 34
moving around on 25
personalizing 243
resetting 274–276
setting up 13

storing 15, 16
turning on and off 305
unlocking 258
unpacking 9

smartphone features 9, 15–
17

smartphone specs 311
SMS messaging 135, 300

See text messages
soft resets 274, 275
softkeys 30
software

See also applications
included with device 10, 

312
installing bonus 230
installing sync 79, 84–86
purchasing 278
reinstalling sync 273
resetting device and 275

songs. See music; playlists
sort order 218
sorting

folder items 229
History list items 152
information 218
messages 141
PDF files 222
pictures or videos 172
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tasks 194
sound clips 137
sound files 138, 247
sound settings 66
sounds

See also specific types
customizing 246–248
previewing 248
recording 138, 247
repeating 66
restoring 246
sending 247
silencing all 50, 246
turning on or off 248

Sounds & Notifications icon 
61, 65

Sounds & Notifications 
screen 61, 65, 247

Sounds tab 247
speaker 174
speakerphone 53, 296, 306
Speakerphone icon 53
special characters. See 

alternate characters; 
symbols

Speed Dial Options 
command 59

speed-dial buttons
creating 57–59

deleting 59
dialing with 45–46
editing 59
selecting 40, 46

spell-checking 115, 136, 207
spreadsheet status bar 213
spreadsheet templates 210, 

212, 213, 221
spreadsheet toolbars 213
spreadsheets

See also Excel Mobile; 
workbooks

adding charts 219
adding defined names 217
calculating in 214–215
entering info in 212, 215
filtering data in 218–219
formatting 211, 217
protecting 211
replacing info in 220
scrolling 213
sorting in 218
splitting 213

SSL security protocol 300
standby mode (camera) 167
Start button 38
Start menu 38, 251
starting

data connections 268

Internet Explorer Mobile 
147

Quick Tour 11
synchronization 80, 86, 89

static 309
stereo headphones 174
stereo headsets 61
Still image compression level 

169
still mode (camera) 165
stopping media playback 176
stopping synchronization 97
Storage card option 151
storage card symbol 229
storage space 235, 264, 295
storing

attachments 117, 125
documents 206
information 235, 295
smartphone 15, 16
workbooks 220

streaming 177, 300
Strong alphanumeric 

password type 45, 259
stylus 27
submenus 32
support 11, 12
symbols 35, 36, 214
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sync applications 80, 86, 87, 
273

sync cable 86, 87, 88, 89
sync conflicts 92
Sync feature 174
sync icons 74
sync methods 81
sync options 79, 96–97
sync settings (Exchange 

servers) 92
Sync softkey 94
sync software 10, 79, 81, 84, 

286
sync software window 86
synchronization

conserving battery and 21
defined 300
downloading email and 

115, 116
enabling wireless 80, 90, 

94, 95
getting started with 24
initiating manual 94
initiating over Bluetooth 

devices 94–95
installing apps and 231
overview 77, 79, 282
resetting device and 275, 

276

scheduling 93–94, 287
sending meeting requests 

and 189
setting up PCs for 83–87, 

96
starting 80, 86, 89
stopping 97
transferring media files 

and 163–164, 174
transferring Office files 

and 201–203
troubleshooting 273, 274, 

283–289, 290, 291
upgrades and 10

synchronizing
over Bluetooth 

connections 94
wirelessly 94

system alarms 262
system errors 279
system locks 256, 258–259
system requirements 83, 

313
system settings 260–266
system sounds 50, 246–248
system warnings 247

T

tabs 28

taking pictures 165–166, 293
tapping 27, 30, 250, 279
tapping sounds 247
task categories 193, 194
tasks

adding reminders to 193
completing 193
creating 192–193
customizing 194
deleting 194
displaying 194
filtering and sorting 194
marking as sensitive 193
setting due dates for 193
setting reminders for 194
synchronizing 81, 85

Tasks application 192–194
Tasks entry bar 193, 194
Tasks icon 192
Tasks list 194
Tasks Over The Air (OTA) 90
TDD devices 67, 71, 305
technical support 11, 12
telecommunications devices 

305
templates

documents 205, 209
messages 140
notes 196, 197
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spreadsheets 210, 212, 
213, 221

Templates folder 205, 212
tentative appointments 187
text

aligning 207
copying 151–152, 206
deleting 30, 47
entering 34, 35, 254, 255
finding and replacing 205
formatting 206
highlighting 30, 151, 207
indenting 207
moving 206
resizing 149, 248
selecting 151
spell-checking 115, 136, 

207
word processing 203

text captions 138
text files 263
text messages

checking for 73
creating 135–136
customizing 142
deleting 141
making calls and 49, 53
receiving 135, 139
replying to 139, 140

sending 55, 135, 136
sorting 141
troubleshooting 281
viewing 139, 140

text phrases 115, 136, 139
text speed-dial 57, 58
text styles 207
text telephone devices. See 

TTY/TDD devices
text-entry fields. See entry 

fields
THB car kit 61
themes 245, 250
third-party applications

5-way navigator and 27
compatibility with 279
installing 229, 230, 294
losing information in 275
resetting device and 275
saving memory and 295
synchronizing with 81
troubleshooting 230, 278, 

294–295
viewing pictures and 293

third-party hands-free 
devices 61

Thumbnails softkey 166, 167
time 250, 260, 261

See also clock

Time limit for videos option 
169

time units 187
time zones 260, 261
timed slide shows 209
timer (camera) 166
tips 9
Today icon 245
Today screen

customizing 172, 245
dialing from 44–45, 48, 58
looking up contacts on 47
monitoring phone calls and 

52, 53, 72
moving around on 53
opening 39
recovering 288
starting web searches 

from 147
viewing info on 39–40
viewing voicemail 

messages on 51
Today Settings screen 245
tones. See ringtones; sounds
touchscreen. See screen
touchscreen lockout 256, 

257
touch-sensitive feature 256
transactions 293
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transition effects (slides) 210
transmission delays 281
transparency levels 172
troubleshooting 11, 271
trusted device list 154, 155
trusted devices 154, 155, 

157
See also partnerships

trusted pairs. See 
partnerships

TTY/TDD devices 67, 71, 305
TTY/TDD icon 73
Turn on Bluetooth option 62
Typing mode 197

U

UDP ports 179
unauthorized users 256, 257, 

263
unavailable time slots 190
Unfreeze Panes option 213
Unknown Caller option 65
unlocking

smartphone 258
spreadsheet rows and 

columns 213
unretrieved voicemail 51
unsafe areas 305
untimed events 187

updating
information 79
media libraries 177

upgrades 10, 84
uppercase letters 35, 256
URLs 124, 177, 209

See also web links
usage information 268
USB controllers 286
USB hubs 87, 285
USB ports 87, 285
USB sync cable 87
usernames 300

V

vCal attachments 291
vCard attachments 291
Verizon Wireless accounts. 

See accounts
Verizon Wireless downloads 

page 151
Verizon Wireless message 

43
Vibrate when… check boxes 

66, 248
vibrating alarm 246, 248
video albums 170
Video command 167
video files 137, 170, 287

video formats 166
video resolution 167, 293
video ringtones 164, 171
video settings 169, 179
videos

accessing 163
deleting 173
downloading 174
organizing 172
playing 170, 174
previewing 167
recording 166–167, 169
renaming 173
sending 138, 171
storing 166, 169, 295
synchronizing 81, 163, 

164
transferring to expansion 

cards 174
viewing

alternate characters 36
animated images 174
application menus 31, 32
appointments 186, 187
calendar 186
contact info 47, 185
events 188, 190
memory usage 264
on-device help 11
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PDF files 203, 222, 223
pictures 170
running applications 264
space on device 264
space on expansion cards 

264
speed-dial buttons 46
tasks 194
text messages 139, 140
voicemail messages 51
web favorites 150
web pages 147, 148

virtual private networks. See 
VPN connections

Vista operating systems. See 
Windows Vista computers

voice call icon 73
voice captions 138
Voice Command application 

252
Voice Command icon 253
voice commands 21, 252–

254, 278
Voice mail option 65
voice notes 195–196, 197, 

255
voice privacy icon 74
Voice Privacy setting 71

voicemail
checking for 51, 72
retrieving 51–52
sending calls to 50, 55
setting up 51, 52
troubleshooting 67

voicemail buttons 59
Voicemail icon 51, 52
voicemail notifications 52
voicemail systems 51
volume

phone 50, 66
ringer 66
system sounds 247

Volume button 66
VP icon 74
VPN clients 267, 283
VPN connections 105, 118, 

267, 285
VZAccess application 159

W

waking up screen 44, 53
wallpaper 164
warnings 247, 275, 306–307
warranty 10
weak signals 279
web addresses 40, 147, 292

See also web links

web browsers 147
See also Internet Explorer 

Mobile
web browsing

getting started with 147, 
148

overview 145
phone as modem feature 

and 159
secure sites and 147, 148, 

153, 293
troubleshooting 292–293
wireless connections and 

145
web favorites. See favorites
web files 153
web forms 149
web links

clearing 153, 295
highlighting 29
selecting 124, 149
sending 149
troubleshooting 292

web navigation features 27
web page properties 149
web pages

adding to favorites 149–
150

arranging on screen 148
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copying from 151–152
dialing from 49, 152
downloading from 151, 

231
hiding images on 148
moving around in 148
opening 147, 149, 152, 

292
playing media files from 

177
refreshing 148, 292
resizing images on 292
resizing text on 149
returning to recently 

viewed 152
scrolling 148, 149
searching 147
selecting email addresses 

on 292
sending email from 149
setting as home 152
synchronizing favorites for 

81
viewing 147, 148

web-based email 102
websites

See also web browsing
accessing 145, 266
connecting to 147, 180

ending connections to 268
installing from 231
redirectors and 292
searching over 147
streaming from 177
transactions and 293

Week View 186, 191
Wi-Fi cards 303, 304
Windows Media icon 175
Windows Media Player. See 

Media Player
Windows Mobile Device 

Center
defined 301
installing 85
opening 87
receiving email and 116
reinstalling 273
synchronizing with 80
troubleshooting 283–288

Windows Mobile devices 
234, 273

Windows Mobile Getting 
Started CD 10, 84, 230

Windows Mobile operating 
system 300

Windows Mobile software 
230, 231

Windows Vista computers

enabling Bluetooth 
connections for 95

installing to 85, 230
playing media files and 

175
synchronizing with 80, 87, 

89, 163, 202
transferring media files 

and 175
troubleshooting sync 

problems 284
Windows XP computers

enabling Bluetooth 
connections for 94

enabling phone as modem 
and 160

installing to 84, 230
synchronizing with 10, 80, 

86, 89, 91, 163, 201
transferring media files 

and 174
troubleshooting sync 

problems 284, 285
WinZip utility 229
wired car kit 61
wired headsets 60, 64
wireless accounts. See 

accounts
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wireless connections
browsing websites and 

145, 158
synchronizing over 80, 90, 

94, 95
troubleshooting 288–289

wireless coverage. See 
coverage areas

wireless features 20, 266, 
294

Wireless Manager 21, 43, 
266

Wireless Manager command 
21

wireless modem 158
wireless phones 308, 309
wireless services 21, 43, 266

See also accounts
Wireless Sync 110
Wireless Sync email 

accounts 110–113
Wireless Sync icon 111
wireless synchronization 94
wireless transmitters 304
Word Completion tab 255

Word files 199
See also documents

word highlight feature 30
Word Mobile 28, 203–209
Word Mobile icon 204
word processing 203
word search options 205, 

227, 228
workbook list 221
workbooks

See also Excel Mobile; 
spreadsheets

adding worksheets 217
creating 212
deleting 221
hiding data in 217
inserting rows or columns 

in 215–217
moving around in 213, 214
naming cells 217
naming sheets 218
opening 213
removing elements in 221
renaming 220
reordering sheets 217

resizing columns or rows 
218

saving 210, 212, 221
searching in 220
selecting sheets in 213

worksheet names 211, 217, 
218

worksheets. See 
spreadsheets; workbooks

writing methods 255
Writing mode 197

Y

Year View 186

Z

ZIP files 229
zoom settings

camera 166
documents 204
PDF files 222
presentations 209
spreadsheets 211, 213
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